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Easy Data Transform data wrangling software for Windows and Mac.



Getting started

1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: Windows 11, 10, 8 or 7 (64 bit versions only).
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above, check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
recent operating systems, but we can't guarantee it. If in doubt, try running an unlicensed
trial version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a few
minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I got this! (or you will just end up back on this page).
You should now see the main window.
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E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBBE v ARG FH ®  ~Howbol?
bt Input
FromFile (@

From Clipboard (%)

SEmail us questions/feedback

Make sure that Auto Run tool bar button is checked (pressed in), so that any changes you
make are processed automatically after a short delay.

€ Easy Data Transform v1.33

_Eile Edit Run View Licens

DERE®f

Drag a data file you want to transform onto Easy Data Transform. For example a CSV file or
an Excel .xIsx/.xls file. XML, JSON, fixed width, plain text and vCard formats are also
supported.
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€

DBE8E o~ A aH @  *HowDor?

¥ Input = vaccination.csv @ o ?c =
From File (@ File: ndy\Desktopivaccination.csv ...
From Clipboard (3 Type: Delimited text -
~ Transform Delimiter: Automatic -
All tramsforms = Quoting:  Automatic s
Case @ Encoding: Automatic “
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cols (3) v trim whitespace
ConcatCals () v simplify whitespace
Concat Rows. 1(2) v ignore emply rows
CopyCols (@ watch file
Count @ Meta info: Mot added hé
e & Alias: vaccination
Date Format () Data  Warnings  Info  Com 4 *
Decode @ 3 cols x 5,780 rows
Dedupe @) C [ 7 @ showfistiorows ~
= ® country time bog vacc
i ® 1 afg 1982 10
Filter ® 2 afg 1983 10
Gather @ 3 afg 1984 1M
Header (@ 4 afg 1985 17
if @ S afg 1986 1B _

SEmail us questions/feedback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header. For some input formats, such as JSON and XML, the
header is added automatically.
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vaccination.csv @ E i
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic h.4
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) .

v has header |
rim whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination
Data Warnings Info Conm ¢ » |

3 cols x 5,780 rows
C E% f © Show first 10 rows ¥

Guntry time bcg_vacD

Transforms are shown in the Left pane. Hover over the transforms to see tooltips explaining
what they do. Click on the ? next to a transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.

Easy Data Transform © 2023 Oryx Digital Ltd



Getting started

E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBERE v ARG H @  rHowbDol?

*  Input = vaccination.csv @ o ?C =
FromFile @ File: ndy\Desktop\vaccination.csv ...
From Clipboard (3 Type: Delimited text -
~ Transform Delimiter: Automatic -
All transforms Quoting:  Automatic v
Case Encoding: Automatic “
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cols (3) v trim whitespace
ConcatCols (& v simplify whitespace
Concat Rows (7 v ignore empty rows
CopyCols (@ watch file
Count @ Meta info: Not added -
Cross @ Alias: vaccination
) s
Date Format () Data  Warnings  Info  Con
3 cols x 5,780 rows
Decode @
. C B & © showfistidrows ~
Dedupe (@
- country time bog_vacc
Extract @
1 afg 1982 10
Fill @
af 1983 10
Filter @ z g
Gather @ 3 afg 1984 1M
Header (@ 4 afg 1985 17
e
i @ 5 afg 1986 18 _

SEmail us questions/feedback

A Case transform item will now be added.
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E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBERE v ARG H @  rHowbDol?

~  Input = Case (@) dtd =
FromFile () E @ Filter columne
From Clipboard (3 [ country
~ Transform time
beg_vacc
All tramsforms =
Case @ 0 of 3 columns selected
Chop @ Change case to: Lower case bt
Clone @ Change the case in the selected column(s).

Is
Compare Cols (& Data = Wamnings Info  Com * *

-
Concat Cols (&) 3 cols x 5,780 rows
Concat Rows (2 (BB & @ showfisti0rows ~
CopyCols (@ Jvaccmatmn.csv [E— Case country time becg vace
Count @ 3 cols x 5.8k rows 3 cols x 5.8k rows 1 afg 1982 10
ross G
Cross @ 2 afg 1983 10
Date Format (2
ate Forma ._) 3 afg 1384 11
Decode @
S 4 af 1985 17
Dedupe @ 2
Extract @ 5 afg 1986 18
Fill @ 6 afg 1987 27
Filter @ 7 afg 1988 40
h @
Gather (@ 8 afg 1989 38
Header (@
) 9 afg 1990 20
If @
b 1N afn 1991 M =

SEmail us questions/feedback

In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case once you have stopped making
changes in the Right pane. You don't have to click a 'run’ button.
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KA
Case ® KN
E Q Filter columns
{ v country

ime
bcg_vacc

1 of 3 columns sele

Change case td; Upper case

Change the case in the selected column(s).

Data  Warnings Info  Com ¢ *

3 cols x 5,780 rows
EE."_;; E% f © Show first 10rows ~

ountry time beg vacc

1 1982 10

2 1983 10

You can create a sequence of transforms to easily perform complex manipulations.

Jvaccination.CSv g Case v Filter v Sort

3 wls x 5.8k ows 3 cols x 5.8k rows 3 cols x 4.5k rows 3 cols x 4.5k rows

Some transforms require more than one input dataset. For example, to stack two datasets,

one on top of the other:

e Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using Ctr1 +click).

e Click the Stack transform button (you may need to scroll the Left pane to see the
button).
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E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBERE v ARG H @  rHowbDol?

- . - EAla
Insert G vaccination.csv @ ‘o o[ WEe
Interpolate File: ndy\Desktop\waccination.csv ...
T Type: Delimited text
. Delimiter: Automatic v
_ Quoting:  Automatic -
Join
Encoding: Automatic b
Lookup ~
) Ignare: First 0 row(s) v
NEW LO
) v has header
A For .|
v trim whitespace
Pad . . .
: v simplify whitespace
Aol v ignore emply rows
Remave Cals watch file
R e Co Meta info: Not added =
Reorder Co Alias: vaccination
Replace

Data  Warnings  Info  Com 4 *

accination2.csv 3 cols x 5,780 rows

C [ 7 @ showfistiorows ~
country time bog vacc

1 afg 1982 10

3 cols x 4.5k rows

2 afg 1983 10

3 afg 1984 N1

—_— 4 afg
(_ Stack @
1986 18

Stamg @~ 5 afg —

1985 17

SEmail us questions/feedback

The tables are now stacked one on top of the other in a new dataset item. You can choose
to match the columns by Header name or Column number.
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E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBERE v ARG H @  rHowbDol?

e— :_?,)‘ Stack ____@ o [l
@ Align columns tig. Header name > ¥
Merge inp ta pof another.
@ |Dlde e vertical positions of the input
©) o ts
Joir @ Data  Warnings Info  Comm 4 *
Lookup (@ /3 cols x 10,258 rows
Hewco (2 vaccination.csv I8 @ i B
Num Format (@) country time beg vace
pad ® 3 ools x 5.8k rows 1 afg 1982 10
Pivot @ 2 afg 1983 10
Remove Cols () Stack 3 afg 1384 M
Rename Cols () v PR 4 afg 1985 17
Reorder Cols (3 5 afg 1386 18
Replace (@
6 afg 1387 27
Row Mum (@ vaccination2.csv
Sample ® e e 7 afg 1988 40
Slice ® g afg 1989 38
Sort @ 9 afg 1990 20
splitCol (@ 10 afg 1391 21
Split Rows (@
Spread @ Last 10,248 rows not shown
Stack @
Stamp (D~

SEmail us questions/feedback

Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input options will cause the input file to be automatically re-read. Any
changes to input datasets or transform options will be automatically propagated
‘downstream’.

To export your transformed dataset to a file or the clipboard, view it in a local editor or see it
with whitespace displayed, click on the appropriate button in the Right pane.
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Stack @ E Z

Align columns by: Header name v

Merge input datasets one on top of another.
Orders by the vertical positions of the input
datasets.

Data = Warnings Info Comm * »

Show first 10 rows ~

You can also add an output item to automatically write a dataset to file whenever it
changes.

& Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - m] =
File Edit View Licensing Help
DBERE v ARG H @  *HowDol?

a R A
Rename Cols (%) stack (@) - [+
Reorder Cols () Align columns by: Header name -
= Merge input datasets one on top of another.
Repl / .
pace O rders by the vertical positions of the input
Row Mum (@) datasets
Sample (@ Data  Warnings Info  Comm ¢ *
slice @ 3 cols x 10,258 rows
sot (@ BEF @ showfisti0rows -
vaccination.csv ;
splitCol (@ country time beg_vace
Spiit Rows (@) 3 cols x 5.8k rows 1 afg 1282 10
spread (@) 2 afg 1983 10
Stack @ Stack 3 afg 1384 1
Stamp @ 4
P— 3 colls x 103k rows e
i 5 afg 1386 18
Substitute ()
= 6 afg 1987 27
@ vaccination2.csv
Summary (@ 7 afg 1388 40
3 bs x 4.5k rows
Total @ 8 afg 1989 38
Transpose () 9 afg 1990 30
Unique @
e 0afg 1991 21
Units @
‘Whitespace (3 Last 10,248 rows not shown
*  Qutput

(: To File }D,

=IEmail us questions/feedback

You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, Plain text, TSV, vCard, XML and YAML file formats. Select CSV file.
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File name: | output.csv

Save as type: |(CSV file (*.csv)

Excel file (*

Your dataset will then be written to this file every time it changes.

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - m| *
Eile Edit View Licensing Help

DBEBE v ARG H @  r~HowDol?

- output.csv @ ? C =
File: wndDesktop\output.csy ..
Type: Delirited text v
Delimiter: Comma () s
Quoating: As needed v
Line endings: Automatic ¥
Encoding:  UTF-8 v
o v Byte Order Mark

Split Col vaccination.csv . .
Write mode: Overwrite v

piit Row 3 cols x 5.8% rows .
Alias: autput

Sp

Data  Warnings Info  Com 4 *
3 cols x 10,258 rows
& L%. f & Show first 10 rows ¥

country time beg vace

.,/ Stack

3 cols x 10.3k rows

output.csv
3 cols x 10.3% rows

1 afg 1982 10
J\taccinationz_csv

2 afg 1383 10

3 cols x 4.5k rows

3 afg 1984 M

4 afg 1985 17

5 afg 1986 18

6 afg 1387 27

7 afg 1388 40

g afg 1989 38

.,
@
4
4

SEmail us questions/Teedback

You can also specify the Delimiter, Quoting, Encoding, Line endings etc for your CSV files
in the Right pane.
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Getting started

output.csv @ Eﬂ
File: \andy\Desktop\output.csv
Type: Delimited text v
Delimiter: Comma (,) v
Quoting: As needed v
Line endings: Automatic v
Encoding:  UTF-8 v
v Byte Order Mark

Write mode: Overwrite v
Alias: output

You can save your transforms to a .transform document to use again with File>Save.
Have a play!

Tips:

e You can also watch a short introductory video.

e Check the show advanced check box in the Left pane to see all the available transforms.

¢ You can paste in data from the clipboard (for example, a table from a web page or Word
document) using the From Clipboard button in the Left pane.

¢ Transforms such as Compare Cols, Filter, If and Sort take account of dates, numbers and
text. You can define what date formats to recognize in the Preferences window.

e New columns are always added to the right of a dataset.

e Comparisons of text are sensitive to case, unless stated otherwise. E.g. "CASE", "case" and
"Case" are treated differently.

e Comparisons of text are sensitive to whitespace (e.g. spaces and tabs), unless stated
otherwise. You can use the Whitespace transform to remove unnecessary whitespace.

e The contents of input and output data files are not saved in an Easy Data Transform
.transform file, only their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key") column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

e To be more productive with Easy Data Transform see expert tips.
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Getting started

We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.
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2.1 User Interface

2.1.1 Main window

The Main window comprises:

e Main menu
e Tool bar

e Left pane
e Center pane
¢ Right pane

e Log pane
e Status bar

Main menu
Tool bar Left pane Center pane Note Right pane
COVID-latggt with notes transf#fm - Easy Data Transform v1.34.0 (Ifensed to Oryx Digital Ltd) - [m X
Efle Edit Ru g Help
DEEE 87 o~ 0AQAHE ® frowoor
hd Input output.xisx % el
From File @ By date @ Qutput to file.
» " 3 -
From Clipboard  (7) = ¢ Output to:  Single file
Y Transform File: ta\EDT COVID19 exampletoutput.xlsx ...
All transforms = n gt ol g el g P gt ) Q00 Excel XLSX =
V' show advanced Formatting: Automatic v
Q Tramsform \ e = Write mode: Overwrite ~ |File b
Calculate v write header
Cage Alias: output
- | e [ e
Chop ‘ - Data | Characters  Warnings  Info g
Clone Per 10k By ceuntry 6 cols x 155 rows @ written
Cluster F®BS/O0HIBE YK « 2T bl
countrieshA. Grand Sum dateRej*
Compare Cols X | Processed Output ‘output.xlsk’ (6 dpls x 155 rows) in 0.119econd(s) A ) )
. 1 Belgium 1765 2020-0
Concat Cols [E] | Mritten], Up to date
. Ended run at: Thu Sep 15 13:24:44 222 2 Spain 25100 2020-0
Concat Rows @ 9015 item(s) processed in 2177 secunis]
Copy Cols @ Up to date: 19, Needs updating: 0, Bror: 0 3 Italy 28710 2020-0
e @ - 1 itemi(s) with warnings =[5 = =
914 D1 Memory sage: 0.6% of 10GB = lr:l_] . =Email us questions,/feedback

Input

Log pane

Transform  Output

Status bar

You can split the Right pane onto a separate monitor (if available) by selecting View>Two

Screen Mode.

Easy Data Transform
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2.1.2 Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what
is selected in the Center pane.

2.13 Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.

2.14  Right pane

The Right pane shows details of an input, transform or output item you have selected in the
Center pane.
2.15 Log pane

The Log pane shows a text representation of processing on the current .transform file. It
shows a maximum of 5000 rows.

e Click the X button to clear all text in the pane.

e Click the =l button to select all text in the pane.

e Click the B button to copy selected text in the pane to the clipboard.

¢ Select View>Log (or the corresponding status bar button) to hide/show the pane.

2.1.6 Preferences window

General tab

Check give option to disable outputs when opening a .transform file if you want the
option to disable any outputs with write mode set to overwrite or append. This prevents
accidentally writing over existing files. Note that this check is never made when you open
.transform files with Run>Auto Run checked or using the -cli command line argument.

Check use native file windows to use the native Windows file open/save windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set At start-up depending on what you want to happen when Easy Data Transform starts.
Set User interface theme to Automatic to follow the theme of the operating system or
override it by setting Light or Dark. This is only available if your operating system supports

a dark theme. Changing User interface theme does not update the Center pane colors. You
can also toggle between themes using a keyboard shortcut.
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Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Copy data to clipboard text/plain as according to how you want data to be formatted,

when it is copied to the clipboard with MIME type text/plain.

e Comma Separated Value uses comma as a column delimiter and quotes carriage returns,
commas and quotes within data.

e Tab Separated Value uses tab as a column delimiter and converts carriage returns and
tabs to spaces within data.

¢ Plain text outputs without any column delimiter.

Data is also copied to the clipboard with MIME type text/csvin Comma Separated Value

format and to MIME type text/html as an HTML fragment.

Set Optimize processing for to:

¢ Minimum memory use to use memory compression to reduce the memory used. This is
usually recommended. It works best when columns contain repeated values.

¢ Maximum speed to turn off memory compression. This might be faster, but uses a lot
more memory. It might also be slower if the memory required is more than your RAM. It
might also cause Maximum memory usage to be exceeded.

Set Maximum memory usage to the maximum amount of memory that you want Easy
Data Transform to be allowed to use. If this limit is exceeded the program will try to exit
cleanly.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing, when Run>Auto Run is checked. Setting the
value to 0 is generally not recommended, as this means that every single click in the Right
pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the Ctr1 key while moving the mouse wheel to switch between
zoom and scroll. Hold down the A1t key while moving the mouse wheel to switch between
up/down and left/right scroll.

User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to

choose a new font. You might prefer a monospaced (fixed width) font such as Consolas,
Lucida Console or Courier New. Click Default to set it back to the operating system default.
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The Locale language and country setting affects how some numbers and dates are
displayed. Consequently it may have an affect on some transforms. It does not change the
language of the user interface, which is English only.

Dates tab

Set Supported date formats to the date formats you wish to recognize. List the date
formats in order of preference, with the most likely to be used first.

Input Extensions tab
Set the default file types corresponding to input file extensions.

Click in the Extension column and type to change an input file extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an input file extension.

Click Add to add a new input file extension.
Click Remove to remove the selected input file extension(s).
Click Default to set the input file extensions back to the default setting.

The order in which input file extensions are shown is not significant.

Output Extensions tab
Set the default file types corresponding to output file extensions.

Click in the Extension column and type to change an output extension. The text will be
trimmed of whitespace, converted to lower case and any "." characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an output file extension.

Click Add to add a new output file extension.

Click Remove to remove the selected output file extension(s).
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Click Default to set the output file extensions back to the default setting.

The order in which output file extensions are shown is not significant.

Colors tab

Select a Color scheme for the Center pane. A Preview is shown in the Preferences
window. Choose Custom to choose your own color scheme.

2.2 Input
2.2.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters

e Excel .xlsx or xls

e fixed width

e Plain text

* JSON

e vCard

e XML

You can select the input item in the Center pane and change any related options in the
Right pane.
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vaccination.csv (f: E ;
@ Input from file.
File: \Desktop\EDT data\CSV\vaccination.csv ...
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore: First O row(s) -
V' has header
V' trim whitespace
v simplify whitespace
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination
Data Warnings Inffo  Comment >
3 cols x 5,780 rows @) Read

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Input Extensions tab of the Preferences window.

For text files Easy Data Transform will treat CRLF, LF or CR control characters as line
endings.

Easy Data Transform will make an intelligent guess at the:

e column delimiter and quoting for delimited text files (e.g. comma)
e column widths for fixed width text files

¢ text encoding for text files (e.g. UTF-8)

e presence of a header row in the data
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But you can also do this manually by selecting the input item and changing the Delimiter,
Columns, Encoding and has header fields in the Right pane.

Set Ignore to the number of rows you want to skip before you start inputting. Note that
this takes place before any empty rows are removed by Ignore empty rows.

For delimited text you can:

¢ Set Delimiter to the delimiter character.

e Check ignore repeated delimiters if you want to treat 2 or more consecutive delimiters
as a single delimiter.

¢ Set Quoting according to whether " quoting is used so that the delimiter can appear
within values.

See delimited text for more details.

For fixed width set Columns to Manual to set column widths. See fixed width for more
details.

For JSON or XML set Format to Long (more rows) or Wide (more columns) depending on
how you want to treat arrays/repeat values. See JSON or XML for more details.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to:

e Replace any tabs or line feeds within data values with spaces.

e Replace non-standard spaces (such as non-breaking space, thin space etc) within data
values with spaces.

e Remove carriage returns within data values.

Check ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check ignore empty columns to remove any columns that have only empty values
(whitespace is not considered empty). Header values are ignored when deciding if a column
is empty.

Check ignore hidden rows and columns to remove any hidden rows or columns (Excel files
only).

Check watch file if you want :

¢ Run>Auto Run selected: the input to automatically reload the file every time that Easy
Data Transform detects that it has been changed.
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¢ Run>Auto Run not selected: the input to be marked as 'Needs update' every time that
Easy Data Transform detects that it has been changed.

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

Check the show advanced checkbox in the Left pane to see all available transforms.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform ‘upstream’ of it
changes.

2.3.2  Calculate

Description
Performs a calculation on 1 or 2 columns and creates a new column.
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Examples
Round a column of numbers to the nearest integer:

date elol

1 1920-09-26 1503.947
2 1920-10-03 1503.42

3 1920-10-03 1503.42

y

Calculate Qq E g
@ Perform calculations on 1 or 2 columns to creat...
Operation: Round v
Value 1:  elol v

date elo1 Round(elo1)

1 1920-09-26 1503.947 1504
2 1920-10-03 1503.42 1503

3 1920-10-03 1503.42 1503

Divide a column of numbers by 100:
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Percentage

1 100.0

2 95.2

3 45.3

4 15.6

Calculate (f} B8 Eﬂ

@ Perform calculations on 1 or 2 columns to creat...
Operation:  / Divide v
Value 1: Percentage v
Value 2 type: Constant v

Value 2: 100.0

'

Percentage Percentage/100.0
1 100.0 1
2 95.2 0.952
3 45.3 0.453
4 15.6 0.156

Multiply 2 columns of numeric values:
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ItemID Quantity Cost
1 HG89397834 1 99.00
2 LK02384030 4 9.95
i
i 3 HG99200444 2 7.95
Calculate C‘P Ei
@ Perform calculations on 1 or 2 columns to creat...
Operation:  * Multiply v
Value 1: Quantity v
Value 2 type: Column v
Value 2: Cost v

'

ItemID Quantity Cost Quantity*Cost
1 HG89397834 1 99.00 99
2 LK02384030 4 995 398
3 HG99200444 2 795 159

Add a days column to a date column:
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Start Duration
1 31/12/2019 7

2 01/01/2021 14

3 07/01/2021 1

v

Calculate CP e E;
@ Perform calculations on 1 or 2 columns to creat...
Operation:  + Add v
Value 1: Start v
Value 2 type: Column v
Value 2: Duration v

Start Duration Start+Duration
1 31/12/2019 7 1/1/2020
2 01/01/2021 14 15/1/2021
3 07/01/2021 1 8/1/2021

Calculate the difference in days between 2 date columns:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

'

Calculate r\‘}c' 5 Q
@ Perform calculations on 1 or 2 columns to creat...
Operation: - Subtract v
Value 1: End v
Value 2 type: Column v
Value 2: Start ‘ b

Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

Inputs
One.

Options

e Set Operation to the operation you wish to perform.

¢ Set Value 1 to the first column of values you wish to operate on.

e Set Value 2 type depending on whether you wish to use a single value or a column of
values for the second value (binary operations only).
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e Set Value 2 to the second column of values or constant value you wish to operate on
(binary operations only).

Notes
¢ The following operations are supported.
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Operation Value 1 Value 2
+ Add Number Number
Date Integer
number
- Subtract Number Number
Date Integer
number
Date Date
* Multiply Number Number
/ Divide Number Number
A Power Number Number
% Modulus Integer Integer
number number
Abs Number N/A
And Boolean Boolean
Ceiling Number N/A
DateTimeT ISO Integer
oMSecs datetime number

Easy e --_ 5092 " D’g’tal .

Notes
Numerical addition.

Adds days to the
date.

Numerical
subtraction.

Subtracts days from
the date.

Days the date in
Value 1 is after the
date in Value 2
(negative if before).

Numerical
multiplication.

Numerical division.

Value 1 to the power
Value 2 (Value 1Value
2

).

Remainder after
Value 1 is divided by
Value 2.

The absolute value.

Logical AND.

The smallest integer
that is not less than
the value.

Convert an ISO
datetime to the
number of
milliseconds since
1970-01-
01:00:00:00.000 UTC

Examples

1.2 + 3 =4.2

31/01/2021 + 7
07/02/2021

1.2 - 3 =-1.8

31/01/2021 - 7 =
24/01/2021

31/01/2021 -
24/01/2021 = 7
24/01/2021 -
31/01/2021 = -7

= 0.4
Error

o~
I w

1.728
0.125

NS
> N ~ N

~J

o° oo

o N
Il

i

Error

Abs (
Abs (

1.2 ) = 1.2
-1.2 ) =1.2

And (
false
And( 1, 1 ) =
And( 0, FALSE
false

true, false ) =
true

) =

Ceiling( 1 ) =1
Ceiling( 1.2 ) =

Ceiling( -1.2 ) = -1

DateTimeToMSecs ( 1970
-01-01 ) =0
DateTimeToMSecs ( 2022
-09-15T21:06:10 ) =
1663272370000
DateTimeToMSecs (

_12_

1969


https://en.wikipedia.org/wiki/Levenshtein_distance
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e Each row is calculated separately.

e Whether values are interpreted as number, dates or text depends on Supported date
formats and locale.

e To concatenate text in different columns use the Concat Cols transform.

e To compare 2 columns use the Compare Cols transform.

For logical operations use the If transform.

For operations on whole rows or columns use the Stats transform.

For more complex calculations, including number/date, use the Javascript transform.

To modify the numerical precision of the results use the Num Format transform.

e To add a new column of values use the New Col transform.

See also:
e Video: How to convert a Unix timestamp

2.3.3 Case

Description
Changes the case of text in one or more columns.

Example
Set names to title case:
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First Last

1 john smith

2 JANE SMITH

Case d} @ E:
® Change the case in the selected column(s).
El Q Filter columns

First
v

Last
v

2 of 2 columns selected |

Change case to: Title case v
First Last
1 John Smith
2 Jane Smith
Inputs
One.
Options

e Check the column(s) you wish to transform.
¢ Set Change case to according to the case you want:
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Case Description Example output for *
WORD word Word !

Lower case Converts all letters to lower =~ word word — word !
case.

Upper case Converts all letters to upper ~ WORD WORD  WORD !
case.

Title case Converts the first letter of Word Word — Word !

each word to upper case
and all other letters to lower
case.

Sentence case Converts the first letter to Word word word !
upper case and all other
letters to lower case.

Lower camel case Converts the first letter for wordWordWord!

the second and subsequent
words to upper case and all
other letters to lower case.
Removes whitespace.

Upper camel case Converts the first letter of WordWordWord!

each word to upper case
and all other letters to lower
case. Removes whitespace.

Kebab case Replaces multiple -WORD-word-Word-!
consecutive whitespace
characters with a single -
(dash) character.

Snake case Replaces multiple _WORD word Word !
consecutive whitespace
characters with a single _
(underscore) character.

Inverted case Convert lower case letters to ~ word WORD ~ wORD !

upper case and upper case
letters to lower case.
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See also

e Whitespace
234 Chop

Description
Remove characters from the start or end in one or more columns.

Example
Remove leading zeros:
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ID
1 0000001

2 0000002

3 0000003

Y

R A

Chop Cf} ¥ N
@ Remove a number of characters from the start o... |
E Q Filter columns

.JID

1 of 1 columns selected

Length: 6 .
From: Start v
1D
1 1
2 2
3 3
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract
235 Clone

Description
Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.6 Cluster

Description
Classify rows with similar text into clusters

Examples
Clustering products by type:
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product unit cost stock
1 French red wine 23.95 9
2 BULGARIAN RED WN 11.95 13
3 Red Label Whisky 38.45 1
4 Gordon's Gin 25 T
5 German White Wine 14.95 6
6 Larios Gin 19.90 50
7 Black Label Whisky 45.50 8
8 Wine, White, Dessert 30.00 1
9/Cocoa Cola 1.95 200
Cluster CP E SC
@ Classify rows with similar text into clusters.
Column:  product v
Clustering: Manual v
GIN
RED WINE
WHITE WINE
Closeness: 20% :
case sensitive

product unit cost |stock |Cluster Closeness
1 French red wine 23.95 9 RED WINE 53
2 BULGARIAN RED WN 11.95 13 RED WINE 25
3 Red Label Whisky 38.45 1 WHISEY 37
4 Gordon's Gin 25 7 GIN 23)
5 German White Wine 14.95 6 WHITE WINE 58
Easy Data Trq yx Digital Ltd
6 Larios Gin 19.90 50 GIN 30
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Correcting the state in an address:
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Street City State
1589 Timbercrest Road Haines Alaska
2/1289 Jerry Toth Drive ALASKA

3 3597 Blackwell Street Anchorage Alaksa

4/344 George Avenue Mobile Alabam
52555 Lonely Oak Drive Mobile ALABAMA
62816 Barrington Court Pine Bluff arknsas
Cluster & EZ

® Classify rows with similar text into clusters.

Column:  State hd
Clustering: Manual v
Terms: AMERICAN SAMOA =
ALABAMA
ALASKA
ARIZONA
ARKANSAS
CALIFORNIA N
Closeness: 50% =
case sensitive
Street City State Cluster Closeness
1589 Timbercrest Road Haines Alaska ALASKA 100
21289 Jerry Toth Drive ALASEA ALASKA 100
3 3597 Blackwell Street Anchorage Alaksa ALASKA 66
4/344 George Avenue Mobile Alabam ALABRAMA 85
52555 Lonely Oak Driwve Mobile ALABAMA ALABAMA 100
6/2816 Barrington Court Pine Bluff arknsas ARKANSAS 87
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Inputs
One.

Options
¢ Select the Column whose values you wish to use for clustering.
¢ Select Clustering as:
o Manual to cluster by Terms you provide (one per line).
o Guided to find clustering terms automatically, starting with the Terms you provide (one
per line).
o Automatic to find clustering terms automatically.
¢ Set the minimum Closeness percentage for a value to a term to be clustered with a term.
¢ Set Max clusters to the maximum number of clustering terms (Guided and Automatic
only).
¢ Set Max time to the maximum amount of time allowed for trying to improve the terms
(Guided and Automatic only).
e Uncheck case sensitive to ignore case.

Notes

e Fuzzy matching is used to classify each row value according to which of the user supplied
Terms it is closest to.

¢ Additional Cluster and Closeness columns are added. The Cluster column shows the
closest matching of the Terms (or the one highest one in the Terms list if 2 or more
match equally). The Closeness column shows the fuzzy match score between 0 (no
match) and 100 (exact match).

e Row values that do not meet the minimum Closeness score for any term are set to
<None>.

¢ Set the minimum Closeness score to 0% to force all values to be assigned.

e You can use a Filter to list all the rows with <None> in the Cluster column to guide you
on any additional Terms you might want to add in Manual mode.

See also:

° Ngram
e Video: How to cluster text

2.3.7 Compare Cols

Description
Creates a new column with a comparison of two other columns.

Examples
Compare 2 numerical columns:

Easy Data Transform © 2023 Oryx Digital Ltd


https://www.screencast.com/t/T1kundjgM0iw

Reference

Valuel Value2
1 183.34 926.7

2 7 7
3 -345 -8934
Compare Cols CP E ﬂ
@ Compare the values of two columns.
Column 1:  Value1l v
Comparison: > Greater than ¥
Column 2:  Value2 v

v case sensitive

'

Valuel Value2 Valuel:>Value2

1 183.34 926.7 false

2 7 7 false

3 -345 -893.4 true

Compare 2 date columns:
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Datel Date?
1 7/1/2021  01/01/2021

2 1/1/2021 01/01/2021

3 31/12/2020 01/01/2021

V

Compare Cols tf} L EG
@ Compare the values of two columns.
Column 1:  Datel v
Comparison: >= Greater than equal b4
Column 2:  Date2 v
V' case sensitive

'

Datel Date2 Datel>=Date2

1 7/1/2021  01/01/2021 true

2 1/1/2021 01/01/2021 true

3 31/12/2020 01/01/2021 false

Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2 and the
Comparison operator.

e Check case sensitive to use case sensitive matching for text.
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Notes

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will be compared
as text. So you might want to replace empty values with 0 or remove those rows with
Filter, before comparing them.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e See here for more details on Regular expressions (regex).

See also

e Split Cols
2.3.8 Concat Cols

Description
Creates a new column by concatenating text from existing columns.

Example
Concatenate 'First' and 'Last' columns with a comma between:
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First Last
1 John Smith

2/Jane Smith

K A

Concat Cols d} ECC

@ Concatenate selected columns into a single new...
E Q Filter columns

First
v

Last
v

2 of 2 columns selected

Delimiter: ,

keep empty

First Last First+Last

1 John Smith John,Smith

2 Jane Smith Jane,Smith

Inputs
One.

Options
e Check the columns you wish to concatenate.

e Supply the Delimiter you wish to place between concatenated text (optional). For
example ",".
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e Check keep empty if you wish to keep the delimiter for empty columns.

Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the original columns. You can change the
column order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.9 Concat Rows

Description
Concatenate multiple consecutive rows into a single row.

Examples
Concatenate every 2 rows to 1:
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sensor datetime wvalue

1 sensor1 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

y

Concat Rows (_‘P = E‘;
@ Concatenate multiple consecutive rows into a si...
Mode: Fixed v !
Create 1 row from every: 2 = .

‘

sensor datetime value sensor datetime value

1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764

2 sensorl 1/1/18 0:10 541 sensor2 1/1/18 0:10 702

Concatenate values until empty:
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l‘JDhn Smith
2‘1 The Street

I
I
I "
| Townsville

! 4Wiltshire

|
|
i 5

£
Concat Rows o dll==: IV

(?) Concatenate multiple consecutive rows into a si... |
Mode: Variable v .
Concatenate:  Until v |
Matches: = Equal to v |
Value:

V' case sensitive :
New row value: Omit v

1 2 3 B

1|John Smith 1 The Street Townsville Wiltshire




Reference

Concatenate values while not starting with 'ID":
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1
1 |[ID387423

2 Blue widget

3 100.00
4 123 .45
5 |IDe30300

& Green widget
7 78.90

8 ID835644

9 |Red widget

10 12.34

11 111.11

12 T.77

Concat Rows d‘" [ E:

@ Concatenate multiple consecutive rows into a si...
Mode: Variable v
Concatenate: While -
Matches: I~ Doesn't start with v
Value: 1D

v case sensitive
New row value: Add to row start v
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Concatenate consecutive rows with the same Orderld:

OrderId Item Price
1 1| 238533| 3432.89
2 2 526252 12.73
=) 2. 012322. 231.98

Concat Rows o3 B
@ Concatenate multiple consecutive rows into a si...

-

Mode: By key .

v

Key column: Orderld

v repeat key column

v/ case sensitive

\

o ——r

OrderId Item Price OrderId Item Price
1 1 238933 3432.89

2 21 526252 12.73 2 012322 231.98
3 3| 323002| 1]
Inputs
One.
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Options
¢ Set Mode to:
o Fixed to concatenate a fixed number of rows from the current dataset to make each
new row.
o Variable to concatenate values while or until a match to make each new row.
o By key to concatenate consecutive rows with the same value in a key column to make
each new row.
¢ Set Create 1 row from every to N, to concatenate every N rows into 1 row (Mode=Fixed
only).
e Set Concatenate to Until or While to keep concatenating until/while a match is found for
Matches and Value (Mode=Variable only).
e Check case sensitive to use case sensitive matching for text (Mode=Variable or By Key
only).
e Set New row value depending on what you want to do with the value that denotes a
new row (Mode=Variable only).
e Uncheck repeat key column to keep only the first key column (Mode=By Key only).

Notes

Use Sort before this transform if you need to change the row order.

Use New Col if you need to add additional columns before concatenating rows.
Use Filter if you need to remove rows before concatenating row.

Use Rename Cols if you need to change column names after concatenating rows.
The opposite of Concat Rows is Split Rows.

See also

e Spread
e Unique
e Concat Cols

2.3.10 Copy Cols

Description
Creates one or more copies of the selected column(s).

Example
Copy 2 columns, once each:
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First Last
1 John Smith
2 Jane Smith
Copy Cols Q{} EQ
@ Copy selected columns.
E] Q Filter columns
First
q | !
Last
VA
2 of 2 columns selected
Copies: 1 .

First Last First Last

1 John Smith John Smith

2 Jane Smith Jane Smith

Inputs
One.

Options

e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.
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Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col
2.3.11 Count

Description
Counts the number of occurrences of each item of text in the selected column.

Example
Count unique values in the 'Response’ column:
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Response

1 YES
2 NO
3 NO

4 NO

Count tf} E Q

@ Count the occurences of text in the selected col...

v

Column: Response
Sort by: Count b4
Order. Ascending v

v case sensitive

Response Count Response

1 YES 1
2 NO 3
Inputs
One.
Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or Descending.
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e Uncheck case sensitive to convert everything to lower case before counting.
e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this value in the upstream data.

Notes

e Date and number values are treated as text.

e Use Rename Cols to change the new column name.
e Use Scale to convert the results to percentages.

See also

e Ngram
e Unique
e Total
e Pivot
o Stats

e Summary
2.3.12 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product’ or 'cross join'.

Example
Cross 2 small datasets:
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letter
- letter number
1A y
CI ipboard 1A 1
-\ 1 col x 3 rows 2 A 2
3/C L
3A 3

Cross 4B 1

R/ S
2 cols x 9 rows 5B 2
number 6B 3
'3 7¢ 1
Clipboard

2 ——-r\w/

8C 2
N 1 col x 3 rows
33 9C 3
Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e It can create a very large number of rows!

See also

2.3.13 DateTime Format

Description
Changes the date and/or time format in one or more columns.

Examples
Change day/month/year to month-day-year:
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Date

131/12/2020

21/1/2021

3|2!1!2021 ‘

R

DateTime Format tf} Fee Di

@ Change the date and/or time format in the sele... :

E Q Filter columns :

J Da.te

1 of 1 columns selected

Format from: d/M/yyyy

T WY T YT Y W OWT T v ur

Formatto: MM-dd-yyyy

\

Date

112-31-2020

2‘01—01-2021

3‘01-02—2021

Change 24 hour time to AM/PM time:
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Time

1/9:07:11

2‘13:14:15

3‘23:12: 10

B

DateTime Format d:l E i

@ Change the date and/or time format in the sele...
IE' Q Filter columns

Time

v

1 of 1 columns selected

Format from: h:mm:ss

Format to:  hh:mm:ss AP

\

Time

109:07:11 AM

201:14:15 PM

311:12:10 PM

Change datetime to ISO format:
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DateTime

131/12/2020 9:07:11 AM

21/1/2021 1:14:15 PM

32/1/2021 11:12:10 PM

DateTime Format tf' E 3

® Change the date and/or time format in the sele...
E’ Q Filter columns

DateTime

v

4 3
1 of 1 columns selected

Format from: d/M/yyyy h:mm:ss AP

Format to:  yyyy-MM-dd'T'"HH:mm:ss ]

DateTime
12020-12-31T09:07:11

22021-01-01T13:14:15

| 3‘2021—01-02T23 :12:10

Example formats for 21 May 2001 14:13:09.120 with |ocale set to English/United States:
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Format to
dd.MM.vyyyy
yyyy-d-M

ddd MMMM d yy
hh:mm:ss.zzz
hh:mm:ss.z
hhmmss

h:m:s ap

Output
21.05.2001
2001-21-5

Mon May 21 01
14:13:09.120
14:13:09.12
141309

2:13:9 pm

YYyy-MM-dd'T'HH:mm:ss.zzz 2001-05-21T14:13:09.120

HH:mm:ss 'in yyyy-MM-dd HH:mm:ss 14:13:09 in HH:mm:ss format
format'

Inputs
One.

Options

e Check the columns you wish to transform.

e Supply the existing date and/or time format in Format from (see below).

e Supply the new date and/or time format in Format to (see below).

¢ Use Non-date to set what to do for values that don't match Format from.

e Use With value for values that don't match Format from when Non-date is set to
Change to user defined.

¢ The following date and/or time formats are supported for input and output:
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Relates to Format

Date Years Yy

YYYY

Months M

MM

MMM

MMMM

Days d
dd

ddd

Easy e __

Meaning

The year as a two
digit number (00 to
99).

The year as a four
digit number. If the
year is negative, a
minus sign is
prepended in
addition.

The month as
number without a
leading zero (1 to
12).

The month as
number with a
leading zero (01 to
12)

The abbreviated
localized month
name (e.g. 'Jan' to
'‘Dec’). Uses the
locale to localize the
name.

The long localized
month name (e.g.
‘January' to
‘December’). Uses
the locale to localize
the name.

The day as number
without a leading
zero (1 to 31).

The day as number
with a leading zero
(01 to 31).

The abbreviated
localized day name

© 2023 Or!
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If not set, the default values are:

Value Default
Year 1900
Month 1

Day 1

Hour 0
Minute 0
Second 0
Milliseconds 0

Notes

e An exact match is expected for the input date. E.g. Format from is yyyy-MM-dd then
2020-12-17 will be converted, but 2020-12-17T14:58 won't. You can extract just the
date or time part here using Split Col with T as the delimiter.

e Use the correct case for the format text (e.g. yyyy-MM-dd, not YYYY-mm-DD).

e The |ocale is used to decide how the date is represented (e.g. names of months and days).

e Any non-empty sequence of characters enclosed in single quotes will be included
verbatim in the output string (stripped of the quotes), even if it contains formatting
characters. Two consecutive single quotes (' ') are replaced by a single quote in the
output. All other characters in the format string are included verbatim in the output string.

e Formats without separators (e.g. ddMM) are supported but must be used with care, as the
resulting strings aren't always reliably readable (e.g. if dM produces 212 it could mean
either the 2nd of December or the 21st of February).

¢ You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919. You can
avoid that issue by explicitly setting the century, e.g.:

Format from: MM/dd/yy
Format to:  MM/dd/20yy

Or you can use Replace. For example to replace 01/15/18 with 01/15/2018:
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Match Type Replace With
1|Regex ¥ (\d\d)/(\d\d)/(\d\d) \1A2/20M3

e Some datetimes do not exist, so cannot be converted. For example, if your Locale is
Spanish / Chile then 03-09-2023 0:00:00 may not be converted with Format from
dd-MM-yyyy H:mm:ss, as in Chile the clock is changed at 24 : 00 first Saturday of
September, so 0: 00 of next Sunday doesn't exist. This can also depend on the time zone
set in your operating system.

e Warnings are shown in the Warnings tab for values that don't match Format from.

¢ You can also do date and time format conversion using the Javascript transform.

See also
e Num Format

2.3.14 Decode

Description
Convert to/from Base64 encoding, URL encoding, escaped HTML or escaped XML.

Example
Convert <'Hello World!'> to base64 encoding:
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1
1 <'Hello World!"' >

Decode Cf.'-‘ @ :;
@ Convert to/from baseb4, URL, HTML or XML enc...
IE' Q Filter columns

v 1

1 of 1 columns selected

Change: To base64 encoding v

1
1 PCAIZWxsbyBXb3JsZCEnPg==

Type Plaintext Encoded

Based64 encoding <'Hello World!'> PCdIZWxsbyBXb3JsZCEn
Pg==

URL encoding <'Hello World!'> %3C%27Hello%20Worlds
21%27%3E

World!'&gt;

XML escaping <'Hello World!'> &lt; &apos;Hello
World! &apos; &gt;

Inputs
One.
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Options
e Check the column(s) you wish to transform.
¢ Set Change according to how you want to decode/encode the selected columns.

Notes
e This is distinct from text encoding (e.g. UTF-8 vs UTF-16) which is handled on input and
output.

e Use Copy Cols to copy columns before you transform them.
e Data input from XML files and output to HTML and XML files is unescaped/escaped
automatically.

2.3.15 Dedupe

Description
Remove duplicate rows.

Example
Keep the first row for each unique 'Customer Id":
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Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020
2 Bob Brown c018917 89456 10.55 01/10/2020 |
3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO017783 38746 25.00 03/10/2020

v

Dedupe r:F‘L E== Ez
® Remove duplicate rows by matching values in al...
Explore Duplicates...

IEl Q Filter columns
Name =
Customer Id
v .
Product Id
. -
1 of 5 columns selected
Matching: Exact v
v case sensitive
Mode; Remove duplicates v
Name Customer Id Product ld Cost Date

1 Alice Anderson C018930 13574 2995 01/10/2020
B Y TR T ~AdoaqT AOACE 40 CC A4 40 MS090
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Inputs
One.

Options
e Click Explore Duplicates... to explore which rows are duplicates.
e Check the column(s) you wish to look for duplicate values in.
¢ Set Matching to Exact to use exact matching to find duplicates and Fuzzy to match with
some differences. Fuzzy matching is much slower.
¢ Set Closeness to how close a fuzzy match has to be to be considered a match. E.g. set it
to 80% to make 2 values that are 80% the same a match. For Fuzzy matching only.
e Check case sensitive to use case sensitive matching.
e Check ignore whitespace to ignore whitespace characters when matching.
e Check ignore punctuation to ignore punctuation characters when matching.
¢ Set Mode according to what you want to do with duplicates.
o Remove duplicates removes all duplicate rows.
o Keep only duplicates keeps only the duplicate rows (the inverse of Remove
duplicates).
o Add duplicate information adds extra columns with information about duplicate rows
at the end. Reorders rows, but does not remove them. The additional columns are:
= Group: Each row and its duplicates are given a unique group number, starting at 1.
» Row: The number of the row in the input dataset.
» Closeness: How close a match the duplicate is as a percentage. 100% = exact match.
» Duplicate: Set to true if the row is a duplicate and false if not.
» Duplicates: Set to the number of duplicates a non-duplicate has.
e Check drilldown to allow double-clicking a row in the data table to drilldown to this row
and it's duplicates in the upstream data. This is only available when Matching is set to
Exact and Mode is set to Remove duplicates.

Notes

e Rows are considered duplicates if they match in all the checked columns.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before deduping and Replace to get of other unwanted characters (e.g. whitespace inside
the text).

e When several rows are duplicates, only the top one is retained. So you may want to Sort
your dataset first.

e The Unique transform is a more powerful (but more complex and slower) alternative to
Dedupe.

See also
e Dedupe a dataset
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2.3.16 Extract

Description
Extract text in one or more columns.

Examples
Extract the first 2 digits from the 'Product Id" column:
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Product Id
1.C13574
2 AB9456
"3 A96352
A
Extract CP "] |
@ Extract text in the selected column(s).
E| Q Filter columns
Product Id
v o
1 of 1 columns selected
Using: Text v
Length: 2 =
From: Start v
Offset: 0 -
Product Id
1C1
2 A8
3 A9
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Extract the last group of digits from an IP address:

IP
1 82.69.52.10

2 66.249.66.92

3 86.28.107.100

.

Extract ‘o 4lll == (D3¢
@ Extract text in the selected column(s).
|E| Q Filter columns |

JIP

1 of 1 columns selected
Using: Regex
Matching: \d*‘\.\d*\.\d*\-{\d*ﬂ

v case sensitive

¥

IP
1 10
2 92
2 100

Extract titles from a name:
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Name

1 Mr John Black
2 Mr. Ben Brown
3 Ms Jill Green

4 Mrs. Jenny White

5 Bill Grey

'

Extract 0‘:’ E EQ
@ Extract text in the selected column(s). r
EI Q Filter columns l

Mame

v

TR - T W EmY T ¥

1 of 1 columns selected
Using: Regex
Matching: ~(Mr|Mrs|Ms|Miss)\.?\s

case sensitive

V

- w ——

Name
1 Mr
2 Mr
3 Ms
4 Mrs
:
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Using depending on whether you want to extract a fixed length of text or with a
regular expression.

¢ Set Length to the length you want values in selected columns shortened to. Text match
only.

¢ Set From to Start or End depending on whether you want to take from the start or end.
Text match only.

¢ If From is Start then Offset is the offset of the first character from the start (O to start
with the first character). If From is End then Offset is the offset of the last character from
the end (0 to start with the last character). Text match only.

¢ Set Matching to a regular expression. Regex match only. If the expression contains
capture parentheses the first capture will be extracted. Otherwise it will try to capture the
whole regular expression. For example:

Value Regular expression Extracted
12.34.567.89 (\d*) \.\d*\.\d*\.\d* 12
12.34.567.89 \Nd*\ . \d*\ o \Nd*\ L (\d*) 89
12.34.567.89 \d*\.\d* 12.34

ip 12.34.567.89 Nd*x\ o A\d*\ L \dx\ L \d* 12.34.567.89
ip 12.34.567.89 Ad*F\ L AdFN L \dF\ L \d* S

e Check case sensitive to use case sensitive matching. Regex match only.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

e Use Replace If you want to extract multiple captures from a value using a regular
expression.

See also
e Chop
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2.3.17 Fill

Description
Fill empty cells in selected columns with the adjacent non-empty values.

Example
Fill down:
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Country Area City
1 Country 1 Area 1‘Cityr 1
2 City 2
3 City 3
4 Area 2‘City 1
5 City 2
Fill } & B 27

@ Fill empty cells in selected columns from adjace...
E] Q Filter columns

J Ct::unfr:.-.r.

Area
v

v

3 of 3 columns selected
Direction: Down v

V

Country Area City

1 Country 1/Area 1 City 1

2 Country 1 H City 2

3 Country 1[{Area 1 City 3

4 Country 1 /Area 2 City 1

5 Country 1 /Area 2 City 2
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Inputs
One.

Options
e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill to.

Notes
¢ Cells containing whitespace are not considered empty.
e To fill empty values with something else use the Replace transform.

See also
e Unfill
e Slide

e Whitespace
e Impute
2.3.18 Filter

Description
Removes rows based on number, date and text values in selected columns.

Examples
Keep rows with at least 1 non-empty value.

Filter % e

@ Filter rows by text, date or numeric values in selected columns.
@ ® Bl&] X Keep ¥ | Matching any

Column Op. Value

1 <Any> ik ¥

Keep only rows where the 'Tax' value is greater than 0 and the 'Country’ value is 'US".
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Filter o3 Zis
@ Filter rows by text, date or numeric values in sel...

® X E & X Keep ¥ Matchingall ¥

Column Op. Value
1 Tax ¥Yi|> ¥|0
2 Country ¥l= ¥ |US

Remove rows where the 'Transaction’ value is greater than the 'Threshold' value (using a
column variable).

: R A
Filter = O{} N

@ Filter rows by text, date or numeric values in selected col...

@ ® E‘_% @r% X Keep ¥ | Matching any

Column Op. Value
1 Transaction ¥ > ¥ §(Threshold)

Inputs
One.

Options

e Click the @ button to add a new filter criteria.

e Click the ® button to delete the selected filter criteria.

e Click the B button to copy terms to the clipboard.

e Click the & button to paste terms from the clipboard.

e Click the X button to clear all terms.

o Select Keep if you want to keep matching rows and Remove to remove matching rows.

¢ Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare. You can use a column variable.

e Check case sensitive to use case sensitive matching for text.

e Check disable filtering to turn off filtering. If sampling is disabled, the transform does
nothing.
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Notes
e A text summary of the filters is shown:

® ® B & X Keep ¥ Matchingall ~

Column Op. Value
1 Country ¥l= ¥ |UK
2/ Units Sold Y |>=Y|5
3 Unit Cost ¥ >=¥ 10

Keep (Country = 'UK") AND (Units Sold >="5") AND (Unit Cost >= "'10')

e A filter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will be compared
as text. So you might want to replace empty values with O or remove those rows with
Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn’t match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

¢ Y can use Subtract to see rows removed by filtering if there is unique key column.
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Subtract

14 cols x 585 rows

]

orders.csv rows removed
by filtering

/]

9

14 cols x 830 rows

o Filter

14 @ls x 245 rows

e If you are pasting in filter terms, the format expected is comma delimited text with 3
columns.
o The first column is the 0-based index of the Column drop-down list.
o The second column is the 0-based index of the Op. drop-down list.
o The third column is the Value.
For example, pasting in:

0,0,YES

Will add:

Column Op. Value
1 <Any> ¥ Ilc ¥ |YES [

You can also try copying terms to the clipboard and pasting into a text file to see the
format. If you only paste in 1 column of text, it will be assumed to be a list of Value. You
can, of course, use Easy Data Transform to create the appropriate filter terms and paste
them into memory.

See also

e Compare Cols
e Slice
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2.3.19 Gather

Description
Gather multiple columns into new key and value columns. Also called unpivot, long pivot or
group by.

Example
Gather 'Q1', 'Q2', 'Q3" and 'Q4' columns into 1 column.
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2 Bob East 45 79 8 33

v

Gather 05 @ Eg

@ Gather selected columns into key and value col...
E] Q Filter columns
salesman

drea

v
v ¥

.

7

4 of 6 columns selected

Key column name: Quarter

Value column name: Amount

v

salesman area Quarter Amount

1 Alice North'Q1 11.3
2 Alice NUHE
3 Alice North/Q3 443




Reference

Inputs
One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

e Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also
e Video: How to unpivot Excel

e Split Rows
2.3.20 Hash

Description
Perform one-way hashing on selected columns.

Example
Compute the MD5 hash of <'Hello World!'>:
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1
1 <'Hello World!">

‘

R Al

Hash g ¢ N i'

() perform a one-way hashing.
E| Q Filter columns

vr‘l

1 of 1 columns selected

Algorithm: MD5 v
1

1 f0d946347af462d489af835d3737fe70
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Type Plaintext Secret Hashed

SHA1 <'Hello 4a2700d8555aae49
World!'> 7cch4d32f6£3d74
78200a5dea

SHA-256 <'Hello 2c6139a5d874b96
World!'> 26e3ae2443fa85c
dfelfcl8£f148034
8267f8bf71a783f
738a

SHA-512 <'Hello 23728b865af0f17
World!'> bb9bfaafl064f711
bf00626c07e5389
dcbbl18365acel9c
2394d7a00066¢c0b
6a7112dab528e62
106a855ddebc4ld
0c262fb72e9f4d7e
10fl1652c

SHA3-256 <'Hello 0701263723cdbdf
World!'> 11el1£7118e62d7d
29d61£01£8490ef
775e4991558634b
d719

SHA3-512 <'Hello olcbfoflle864af
World!'> 592626d9430271a
5ad6£f39%9edf7e097
19a97¢c57b5c3222
cdf24bd70£f1£692
Tb7b41eb948bbdd
felad4ae965688a4
a6882df7be36492
ado653ab0

Keccak-256 <'Hello 1a45dd8df9de650
World!'> 49692d9192509b3
0560b69c1£fdB881c
57b2cf4607e85b3
569f

Keccak-512 <'Hello 2741b7ddfe0d4c4
World!"'> 726d476cc719fdb
b3b7db88febdfla
1df00723547c546
496ac49bd82e940
09f4572d3a31fe0
fc50bcelee3c76d
983f8ddc480b7da
9cdled02

MD5 <'Hello £0d946347af462d
World!'> 489a£835d3737fe

70
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Algorithm to the hashing algorithm you wish to use

e Set Secret to the secret key you wish to use (HMAC-MD?5 only). The default value is
randomly generated.

Notes

e There is no known way to reverse these hashes.

¢ As the chance of 2 different inputs generating the same hash value by chance (a
‘collision’) is infinitesimally small, hashing can be used to anonymize data or to help find
duplicates of long data values.

e The MD5 algorithm is now considered weak as a cryptographic hash. But remains suitable
for other non-cryptographic purposes.

e Use Copy Cols to copy columns before you transform them.

2.3.21 Header

Description
Move rows from the top of the dataset into the header.

Example
Append the first row to the header:
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Sample Sample Sample

1 1 2 3
2 22334 2389 1935

3 82.2 5059 934.51

Header d} Ei
@ Move rows to the header.
Top rows to move: 1 :
Existing header:  Append v
Delimiter: -
Sample-1 Sample-2 Sample-3
1 22334 23.89 19.35
2 82.2 5059  934.51
Inputs
One.
Options

e Set Top rows to move to the number of rows you want to move from the top dataset
into the header. Setting it to 0 means the transform does nothing.

¢ Set Existing header to Overwrite to ignore the existing header values and Append to
add to the existing header values.

o Set Delimiter to any text you want to put between column elements. It can be left empty.
Ignored if Existing header set to Overwrite and Top rows to move set to 1.
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Notes

e Empty cells are ignored.

e You can Sort and Filter your dataset to change the top rows.

e You can add the header from one dataset to another dataset using Stack.

See also
e Headers
23.22 |f

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Examples
Add a new column based conditionally on ‘Payment’ and 'Currency' columns:
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Payment Currency

1 462697 USD
2 64754 USD

3 6353.12 GBP

y

’ FEL

@ Create a new column with values conditional on value...

New column name: Convert

@ESEIF @DAND T L X

Logic Column Op. Value
11IF Currency ¥ |= ¥ USD
2 THEN= No
3 ELSE IF  Currency ¥ |= ¥ |GBP
4 AND Payment ¥ >= ¥ 1000
5 THEN= Yes
6 ELSE= No

v case sensitive

\

Payment Currency Convert

1 4626.97 USD No
2 64754 USD No

3 6353.12 GBP Yes

If the 'h1' value is 1 use the value of the 'h2' column, otherwise use the value of 'h3' column
(using column variables).:
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h1 h2 h3
1A A 1
2B B 2
3cC C 3
4d D 4
i * FE]|

@ Create a new column with values conditional on oth...

New column name: If

®EeseiF Danp N L ®

Logic Column Op. Value
1IF h1 v = ¥ §h2
2 THEN= $(h2)
3 ELSE= $(h3)

v case sensitive

V

h1 ha h3 If
1A A 1A
2B B 2B
3c C 3 3
4d D 4 4
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Inputs
One.

Options

¢ Set New column name to the name of the new column you want to create.
e Click the ®ELSE IF button to add a new IF/ELSE IF.THEN condition.

e Click the ®AND'button to add an AND to the selected IF/ELSE IF.. THEN.

e Click the ® button to delete the selected IF/ELSE IF.. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

e Check case sensitive to use case sensitive matching for text.

Notes
e The IF, THEN and ELSE values can use column variables, as in the second example above.
e You can simulate OR with multiple IF statements. For example:

IF x = 1 OR vy = 2
THEN 3

Is equivalent to:

IF x =1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will be compared
as text. So you might want to replace empty values with O or remove those rows with
Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,

Doesn’t start with, Doesn't end with and Doesn’t match regex operations.
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e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also

e Lookup
23.23 Impute

Description
Infer values of missing data from other values in the same column.

Examples
Impute the missing age of Titanic passengers based on the average age of all passengers:
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Pclass
Sex

v Age

Using: Average

Easy Data Tran§l (@] & All rows

@ Infer values of missing data.

o — 1
E] Q Filter columns

1 of 9 columns selected

Pclass Sex Age SibSp Parch |+ E

21 2male 35 0 0 i
2 2 male 34 0 0 i
:

23 3 female 15 0 0 i
24 1 male 28 0 0 '
25 3 female 8 3 1 i
26 3 female 38 1 5 :
27 3 male 0 0 E
28 1 male 19 3 2 i
225 3 female 0 0 It
30 3 male 0 0 i
=l 1l male 40 0 0 ;

impute FE]

yx Digital Ltd
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Impute the missing age of Titanic passengers based on the median age of passengers with
the same passenger class and sex:
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Easy Data Transform

Pclass Sex Age SibSp Parch |+
21 2male 35 0 0
22 2 male 34 0 0
23 3 female 15 0 0
24 1l male 28 0 0
25 3 female 8 3 1
26 3 female 38 1 3
27 3 male 0 0
28 l male 19 3 2
29 3 female 0 0
30 3 male 0 0
=l 1l male 40 0 0

Impute
@ Infer values of missing data.
El Q Filter columns

Pclass
Sex

N, Age

=ile e

1 of 9 columns selected
Using: Median

Of: Rows with matching values for:

e N |

o3l == (034

P e e T T T — RS YT PR S WY W ¥ T S e W T P W TR e T T e
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Inputs
One.

Options

e Check the column(s) which have empty values you wish to impute.

¢ Set Using to impute using the Average (mean), Median or Mode of non-empty data
values in each column.

e Set Of to:

o All rows to fill empty values in each column with the Average, Median or Mode of all
non-empty values in the same column.

o All rows with matching values for to fill empty values in each column with the
Average, Median or Mode of all non-empty values in the same column where values
match in the checked columns below.

¢ Set Matching to Exact match if every field has to match and Best match to use rows that
have the most matching values (or all rows, if no matches). For example, if you are
matching on passenger class and sex then:

o Exact match will only use values from rows where the passenger class and sex both
match.

o Best match will use values from rows where the passenger class and sex both match, if
available. Otherwise it will use values from rows where either the passenger class or sex
match, if available. Otherwise it will use values from all rows.

e Check case sensitive to use case sensitive matching.

Notes

¢ Average and Median only work on numerical data (non-numerical values are ignored).

e Mode treats all non-empty data values as text. Case and whitespace are taken into
account.

¢ If Mode is selected and there are multiple values with the same maximum frequency, one
will be picked at random.

e If you need to convert some values to empty before imputing, you can do this using a
Replace transform.
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Replace Q{} E S

@ Replace multiple text in the selected column(s).
IEl Q Filter columns

gender

v
group
salary

1 of 3 columns selected

@M VX E & X

Match Type Replace With
1 Text ¥ Unknown

e You can use a Filter transform to remove rows with missing values instead of imputing
values.

e Use a Sequence transform to add missing date or integer values in a sequence before
imputing.

See also
e Video: How to impute missing data
o Fill

e Interpolate
2.3.24 Insert

Description
Append/prepend text to one or more columns.

Example
Add 'ID-' to the front of a column of text:
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1D
1230933
2 223441
3 323412
Insert CF E g

@ Append/prepend text in the selected column(s).
|E| Q Filter columns

\;ID

1 of 1 columns selected
Insert: 1D-
At: Start

v

ID
1/ID-230933
2 1D-223441
31D-323412
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.

Notes
¢ You can use Whitespace to remove whitespace before inserting.

See also

e Pad

o Extract
2.3.25 Interpolate

Description

Interpolate values for a dataset based on numerical sample-value pairs in another dataset
and puts the result in a new column.

Example
Interpolate time and temperature datasets for sensors A and B with different sampling
frequencies:

KA
time A temperature A Interpolate ol I
1 0.0 1.134 @ Create a new column in the top dataset by inter...
Top sample column: time A ¥
Bottom sample column: time B v
3 20 2773 Bottom value column:  temperature B v
e sensor-A.csv
4 3_0E0 Interpolation type: Linear v
2 cols x 6 rows
5. 40 3333 /
time A temperature A Interpolate temperature B !
6 2874 Interpolate 1 00 1.134
4 >
B 3 cols x 6 rows 1.0 778
time B temperature B 2 - 3.
1 0.0 0.000 3 20 2713
sensor-B.csv
2 20 4 30 5.039
2 cols x 4 rows
3 40 2,697 5 40 31323
4 60 6 5.0 2.874
Inputs
Two.
Options

Easy Data Transform © 2023 Oryx Digital Ltd




Reference

¢ Place the dataset you want to modify as the top input and the dataset you want to
sample values from as the bottom input.

¢ Select Top sample column for the column whose values you wish to sample.

¢ Select Bottom sample column for the column that matches the top sample column in
the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Interpolation type to the type of interpolation you wish to use.

Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

e If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

e Messages are shown in the Warnings tab for non-numeric values in either dataset.

e Messages are shown in the Info tab for Top sample column outside the range of values
in Bottom sample column .
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See also

e Lookup

e Impute
e Join

2.3.26 Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Example
Keep rows in the top dataset that also have their ids in the bottom dataset:

Id  First Intersect ol X
1 001 Alice ® Keep only rows from the top dataset whose key value... |
oolee > o intersect-1.csv Top key column: 1d v

4 004 Dwayne

Bottom key column: ID v
3| 003 Charlie 2 cols x 4 rows /

Intersect oA
(/) A * 1 001 Alice

2 cols x 2 rows )

1D
intersect-2.csv

2@ 1 col x 2 rows

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Check case sensitive to use case sensitive matching for keys.
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Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract
2.3.27 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle strings, numbers, dates and text.

Examples
Multiply the value in column 'items' by the value in column 'item price":
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items item price
1 1 11.45
2 5 0.95
3 2 9.95
Javascript 'CP = Eg

@ Script your own custom transform in Javascript.

New column name: cost

Type columns as:  Number/Boolean/String v

Javascript:

return $(items) * $(item price);

items item price cost
1 1 1145 11.45
2 5 095 475
3 2 995 199

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' 4+ S$(first);

To calculate the biggest of numeric columns 'v1' and 'v2":
return Math.max ( $(vl), $(v2) );

To find the number of characters in column 'v1":
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return String( $(vl) ).length;

To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+]2[(]?2[0-9]1{3}[)12[-\s\.]?2[0-91{3}[-
\s\.]?2[0-91{4,6}S$/;
if ( validPhoneNum.test( $(phone num) ) )
return "valid";
else
return "invalid";

To replace the last comma in the 'Location’ column with a '} using a regular expression:

return $(Location) .replace(/(.*), ([~ 1*)S$/, '$1;$2");

To calculate the number of years difference between Javascript compatible dates in column
1 and column 2:

return new Date( $(1) ).getFullYear() - new
Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a datetime in the 'datetime’ column and
1st Jan 2000:

return new Date( $(date) ) - new Date( "2000-01-01TO00:00" ) ;

To calculate the number of whole days difference between a date in the 'created’' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) /
( 1000*60*6c0*24 ) );

To use the value of the 'n' column if it is a number and O if it isn't;

if ( isNaN( $S(n) ) )
return O;

else
return $(n);

To reverse the text in the 'key' column:

var a = $(key);
var newString = "";
for (var i = a.length - 1; i >= 0; i--) {
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newString += al[i];
}

return newString;
To convert meters to feet using a function:

function metersToFeet ( x )

{
return 3.28084 * x;

}

return metersToFeet ( $ (meters) );

Inputs
One.

Options
¢ Set New column name to the name of the new column you want to create.
¢ Set Type column as to:
o Number/Boolean/String to pass:
= A column that is numeric values as Javascript Number type.
= A column that is true and false values as Javascript Boolean type.
= Anything else as Javascript String type.
o String to pass data all columns with Javascript String type.
e Enter your script into the Javascript field. The script should be the body of a Javascript
function.
e Select a column from Insert variable to add that column variable into the Javascript field
at the current cursor position.
e Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors (only available if Run>Auto Run is checked).

Notes
¢ If Run>Auto Run is checked, the Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have
been made without the Evaluate button being clicked.
o An item upstream of it changes.
e An empty string is passed as an empty Javascript string variable (""), not null. To test if
the 'v' column has an empty value:

if ( $(v).length === 0 )
{
// empty cell

}
else if ( String( $(v) ).trim().length === )
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// blank cell (whitespace only)

e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale. You can use
the Num Format and Replace transforms to put numeric data in the correct format before
processing a Javascript transform.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
UTcC.

¢ Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd') format,
e.g. '2020-01-31" (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should merge
them first, e.g. using Join.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.

e Javascript running in Easy Data Transform is not 'sandboxed' and has the same privileges
as the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

e Warnings are shown in the Warnings tab for:

o Javascript syntax errors
o Ambiguous column references
e For simple arithmetic operations on numbers and dates use the Calculate transform.

See also
e Find the difference between dates/datetimes

2.3.28 Join

Description

Merge two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs. The bottom dataset (by vertical position) is joined to the right of the
top dataset.

Example
Join two datasets side-by-side using the 'ID' columns:
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Name ID
1/John Black 001

DOB
1966-07-01

2 Paul White
3 Jill Green 003 1977-12-30
4 Ahmed Ali 004 1980-11-05

2 004 Marketing

ID  Department Level

1 001 Engineering 1

4 002 Sales

Inputs

Two.

Options

2

Iy

3| 003 Engineering 2

employees.csv
002 1973-03-11 *9

3 cols x4 rows

details.csv

3 cols x4 rows

\oule
/

Join d} = EC
@ Merge 2 input datasets side by side using com...
Top key column: ID v

include top non-matching row
Bottom key column: ID v

include bottom non-matching

/

Join

5 cols x 4 rows

D DOB

001 1966-07-01 Engineering 1

Name Department Level

1 John Black

2|Paul White 002 1973-03-11 Sales 2

3 Jill Green 003 1977-12-30 Engineering 2

4 Ahmed Ali 004 1980-11-05 Marketing 1

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Click Explore Keys... to compare key values in the 2 datasets.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input

dataset.

e Select include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.

e Check detailed report to show detailed information in the Warnings and Info tabs on
duplicate keys in each dataset, overlap of keys in the 2 datasets and leading and trailing
whitespace in keys. This slows down the join significantly.

e Check case sensitive to use case sensitive matching for keys.
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include top non-matching include bottom non- Also known as:

rows checked matching rows checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

¢ All values are treated as text. You can use Whitespace to remove whitespace before the
join.

o If a key value occurs M times in the first dataset and N times in the second dataset, you
will get M x N rows with this key value. You can use Unique to remove rows with duplicate
key values.

e If you need more than one column for the key, use Concat Cols to create that column.

e Use Row Num to create a unique key column.

e Use Sort to sort the results.

e Use the Cross transform for cross joins.

e Messages are shown in the Warnings tab for keys that occur more than once in either
dataset (duplicates).

e Messages are shown in the Info tab for keys that only occur in 1 of the 2 datasets
(misses).

e Use Subtract to see rows not joined from the top or bottom dataset (the Clone is
necessary to get the correct Y position of the bottom dataset for the Subtract).
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Clone
o
14 cols x 750 rows
N Filter o Subtract Rows not joined
11 cols x 87 rows 11 cols x 9 rows from top dataset
Join
L/

24 wols x 720 rows

Filter Subtract Rows not joined

14 cols x 750 rows 14 cols x 30 rows from bottom dataset

e Cascade multiple joins to join more than 2 datasets.

CLS LM & 5. Cov

(]

11 ools 2 91 mw 3

Join

(]

14 @l x 830w s 28 colls x 2.2k row 5

?“ﬁ'ﬁ xE30rows \
orders.csv Join
/Q

c—rder details... Join

L]

Scols x 2.2k rows 37 colsx 22k row s

@ products.csv Join

10 @l x 77 mws 4Be§|lx23<mwi

o

12 cols x 29 ws sxcolsxzmmu

suppliers.csv \ Join

cabe Qones.csv

4 cols x Brows

See also
¢ Video: How to join Excel files
e Cross

e Lookup

e Interpolate
e Merge datasets
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2.3.29 Lookup

Description
Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.

Examples
Lookup category name in a second dataset using '‘Category ID":

Lookup i db = ;C
® Create a new column in the top dataset using values looke...
Explore Keys...
Top key column: Category ID N
Bottom key column:  Category ID v
Bottom value column: Product Name N
Matching: Exact v
Product ID Product Name Supplier ID Category ID Bottom values used: |y v
3 1 Chai 1 1 If no match: Use no match value i
No match value:
E 2 Chang ! ! . © products.csv v case sensitive
3 3 Aniseed Syrup 1 2 o
4 4 Cajun Seasoning 2 2|
5 5 Gumbo mix 2 2|

., Lookup
5 cols x 5 rows

Category ID Category Name Descript

i 1|Beverages soft drinks categories.csv Product ID Product Name Suppliet; ID Category ID Lookup Category Name
2 2 Condiments. sauces, relishes and seasonings e IREEE 1| 1 Chai 1 1 Beverages
3 3|Confections dessers and candies 2| 2 Chang 1 1 Beverages

3| 3 Aniseed Syrup 1 2 Condiments

4| 4 Cajun Seasoning 2 2 Condiments

5| 5 Gumbo mix 2 2 Condiments

Fuzzy lookup of company stock 'Symbol' by 'Name":
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Name Symbol H
b b 0 0 00000000

3 Amazon.com AMZN ‘
4 Bank of America BAC ,

S SO SN S NP N NP NP S N S P 4"‘H

company U, 4l aa ev Gy JG.

1/Amazon
11 Home Depot (The) HD

2 Bank of America SV W N XY W N W W SNy Ny

3 Home Depot

4 McD 14 1B A, cE Se A o0l 0. Lt 4 M |
cDonalds '

17 McDonald's MCD ‘

5 NVIDAT

X o W S NP S A A A Y LT LV
6 Pepsi

L =L Jda M. L

21 NVIDIA NVDA I

ST P SN W N S S A S Y S N N

24|PepsicCo PEP i'
Lookup & e

@ Create a new column in the top dataset using v...

Explore Keys...

Top key column; Company X
Bottom key column:  Name v
Bottom value column: Symbol v
Matching: Fuzzy v

60% =

Closeness:
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Inputs

Two.

Options
¢ Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.
e Click Explore Keys... to compare key values in the 2 datasets.
¢ Select Top key column for the column whose values you wish to lookup.
¢ Select Bottom key column for the column that matches the lookup in the bottom
dataset.
¢ Select Bottom value column for the column that contains the values.
e Set Matching to Exact to use exact matching to find duplicates and Fuzzy to match with
some differences. Fuzzy matching is much slower.
¢ Set Closeness to how close a fuzzy match has to be to be considered a match. E.g. set it
to 80% to make 2 values that are 80% the same a match. For Fuzzy matching only.
e Set Bottom values used to:
o All if you want to use all matches. Duplicate values are only shown once.
o First if you want use the first match in Bottom lookup column. For Exact matching
only.
o All best if you want to use the best matches. If there are multiple values that are equally
good, use all of them. Duplicate values are only shown once. For Fuzzy matching only.
o First best if you want to use the best match. If there are multiple values that are equally
good, use the first one. For Fuzzy matching only.
¢ Set Delimiter to the delimiter you want to use to separate multiple values returned for
Bottom values used of All or All best.
¢ Set If no match to Use not match value or Leave unchanged, depending on what you
want to do for values in Top lookup column that do not match in Bottom lookup
column.
¢ Set No match value to the value you want to use for values in Top lookup column that
do not match in Bottom lookup column when If no match is set to Use no match
value.
e Check case sensitive to use case sensitive matching for keys.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicate values in the Bottom lookup
column.

e If the top input has a header, this will be used for the output.
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e If you want to see what bottom dataset keys are matched to each top dataset key, you
can set Bottom value column to the same column as Bottom key column.

o All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the lookup.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Warnings are shown in the Warnings tab for:
o Values that cannot be found in the bottom dataset (misses).
o Values that occur more than once in the bottom dataset (duplicates), if Bottom values

used is First.

See also
o If

e Interpolate
e Join

2.3.30 Moving

Description
Add a new column with a moving average/median/sum/min/max of the selected column.

Examples
Calculate a 7 day moving average for the sales column, leaving the first 6 days empty.
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Easy Data Transform

Date

2020-07-01

2020-07-02

2020-07-03

2020-07-04

2020-07-05

2020-07-06

2020-07-07

2020-07-08

2020-07-03

Sales

100

120

90

145

95

15

125

130

95

Moving

Column:

Calculation:
Interval:

Offset:

Date

2020-07-01

2020-07-02

2020=07-=03

Sales

Average

7
0

Incomplete values: Set empty

Sales Moving Average Sales

3
100

120]

90_|

i o all == [PE¢

® Add a new column with a moving average/sum/...

v

v

4 4P

4
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Calculate the sum of the current row and the rows above and below, where available, for
the sales column.
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Date Sales
12020-07-01 100
22020-07-02 120
32020-07-03 90
4 2020-07-04 145
52020-07-05 95

Moving ‘@ d} DZ
@ Add a new column with a moving average/sumy/...
Column: Sales v
Calculation: Sum v |
Interval: 3 -
Offset: 1 :
Incomplete values: Calculie from available v
Date _ Sales Moving Sum Sales

12020-07-01 E
22020-07-02 E
32020-07-03 355

JI
42020-07-04 1

52020-07-05 95 240
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Inputs
One.

Options

¢ Select the Column you wish to calculate a moving
average/median/sum/minimum/maximum for.

¢ Set Calculation to the statistic to be calculated.
o Average shows the arithmetic mean of the values in the interval (Simple Moving

Average).

o Median shows the median of the values in the interval.
o Sum show the sum of the values in the interval.
o Minimum shows the smallest value in the interval.
o Maximum shows the largest value in the interval.

e Set Interval to the number of rows to include in each moving
average/median/sum/minimum/maximum value.

o Set Offset to the number of rows above (if negative) or below (if positive) the current row
to end each interval at.

¢ Set Incomplete values according to what you want to show for rows without a full
interval of data. For example the first 6 rows when Interval is 7 and Offset is 0.

Notes

e Non-numeric values are ignored. E.g. a 7 day moving average that includes 2 non-numeric
values will be shown as an average of the 5 numeric values.

¢ You will be warned of any non-numerical values in the selected column.

See also

¢ Video: How to calculate moving averages
e Offset

e Stats

2.3.31 New Col

Description
Adds a new column, filled with a given value.

Example
Add a new column full of '1' values:
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Reference

price

11145
2 095

3 995

New Col 0::! EG
@ Add a new column filled with a specified value.

New column name: quantity

MNew column value: 1

price quantity
1 1145 1
2| 0.95 1
3 995 1

Inputs

One.

Options

¢ Set New column name to the name of the new column you want to create.
¢ Set New column value to the value for every cell of the new column. You can leave it
empty for an empty column.

Notes
e New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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See also

e Copy Cols
e Remove Cols

2.3.32 New Rows

Description
Add new rows.

Examples
Add an empty row above every row with an invoice number:
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Invoice Lineltem Value

1 00456 1 150.00

2 2 95.00

3 3 50.0

4 00457 1 845,00

5 2 12.50

New Rows CP E Eg

® Add new rows.
Number added: Same for every row v
Number value: 1 :
As: Blank row(s) v
Location: Above each row v
For: Rows where v
Column: Invoice S
Matches: I= Not equal to =

Value:

v case sensitive

.

Invoice Line ltem Value

|
2 00456 1 150.00
3 2 9500




Reference

Copy each row the number of times in the ‘ltems' column:

Orderld Items

1 12345 0

2 12346 1

3 12347 2

New Rows CP EQ

@ Add new rows.
Number added: Set from a column v
Number column: Items x
As: Copied row(s) v
For: Every row s

v

Orderld Items
1 12345 0

2 12346 1

3 12346 1
4 12347 2
4 12347 2
6 12347 2
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Inputs
One.

Options
e Set Number added according how many rows to add for each existing row.
o Set Number value to the number of new rows to create for each existing row (available
when Number added is Same for every row).
o Set Number column to get the number of new rows to create for each existing row
from a column (available when Number added is Set from a column).
e Set As to add either blank rows, copies of existing rows or user defined rows.
¢ Set With value to set the value used for each column of the new row (available when As
is User defined row(s)).
¢ Set Location depending on whether you want new rows added above or below existing
rows (available when As is Blank row(s) or User defined row(s)).
¢ Set For depending on whether you wish to add rows to all rows or only rows that meet
certain conditions.

Notes

e You can use Calculate or Javascript transforms to calculate the number for the Number
column. E.g. to subtract 1 from the final number of copies wanted to give the number of
New rows.

See also
e Offset

e Sequence
2.3.33 Ngram

Description
Counts the number of times each sequence of consecutive words appear in the selected
column.

Examples
Find ngrams of 2 to 3 word length (bigrams and trigrams) in the 'Keywords' column:
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Keywords Impressions

1 EDT 47

2 easy data transform 1598

3 Easy Data Transform 964

4 easy data transformer 345

5 data transformer 19343

6 EASY,DATA, TRANSFORM 23
Ngram d: Bzs| EGE
@ Count sequences of N consecutive words in the sel... i
Column: Keywords ¥ §
Minimum N: 2 -
Maximum N: 3 = :

Sum: Rows v

case sensitive

‘

Keywords Ngrams Words Rows
1 easy data transform 3 3
2 easy data transformer 3 1
3 easy data 2 4
4 data transform 2 3
5 data transformer 2 2
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Sum the impressions associated with each 2 to 3 word ngram:
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Keywords Impressions
1 EDT 47
2 easy data transform 1598
3 Easy Data Transform 964
4 easy data transformer 345
5 data transformer 19343
6 EASY,DATA, TRANSFORM 23
Ngram * Cf“ @ EG'
@ Count sequences of N consecutive words in the sel...
Column: Keywords v i
Minimum N: 2 =
Maximum N: 3 -

I
- I
Sum: Impressions v |
I
I

case sensitive

‘

Keywords Ngrams Words Impressions
1 easy data transform 3 2585
2 easy data transformer 3 345
3 data transformer 2 19688
4 easy data 2 2930
5 data transform 2 2585
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Inputs
One.

Options

e Select the Column you wish to analyze for ngrams.

e Set Minimum N to the minimum number of words in an ngram.

e Set Maximum N to the maximum number of words in an ngram.

e Set Sum to:
o Rows to count the number of rows containing the ngram.
o A column to sum numeric values in that column for all rows containing the ngram.

¢ Uncheck case sensitive to convert everything to lower case before counting ngrams.

e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this row in the upstream data.

Notes

e Words are made up of letters, digits and apostrophes (). All other characters are treated
as word separators.

o All letters are converted to lower case.

e If you have set Sum to a column then only numeric values in that column will be summed.

e The output sorted by number of words in the ngram, then the count and then the ngram.
Use a Sort transform to sort it in a different order.

e Use a Replace transform before the Ngram transform to remove/replace any words or
letters you don't wish to analyze.

See also
e Video: How to find NGrams in data for PPC, SEO and NPL
e Count
e Unique
e Total
e Pivot
o Stats
e Summary
2.3.34 Num Base

Description
Change the number base of integer values, e.g. decimal to hexadecimal.

Examples
Convert from decimal (base 10) to hexadecimal (base 16):
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6

Value

01

10

20

9999999

y

-1

Num Base

Value

v

Base from :

Base to:

1
2
3

Non-integer:

10

16

Leave

Value

1 of 1 columns selected

v

@ Change the number base of integer values, e.g. ...

o . .
IE] Q Filter columns

KN A
= 0{} =2 ¥ N

4 4

0

1

1 © 2023 Oryx Digital Ltd
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Convert from guessed base to decimal (base 10):

Value
1 0100
2 100
3 0x100
Num Base 'S O{} Eg

©) Change the number base of integer values, e.g. ...
E] Q Filter columns

Value

v

1 of 1 columns selected

Base from : Guess

4 )

Base to : 10

Non-integer: Leave

Value
1 64
2 100
3. 256
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Inputs
One.

Options
e Check the column(s) you wish to convert.
e Set Base from to the base of the current values. If you set it to Guess, it will guess the
base for each value using C conventions:
o Numbers starting with Ox (e.g. 0x123) are assumed hexadecimal (base 16).
o Numbers starting with 0 (e.g. 0123) are assumed octal (base 8).
o All other values (e.g. 123) are decimal (base 10).
¢ Set Base to to the base wanted.

Notes

e The values to be converted should be integers (whole values) without group separators
(e.g. no commas or decimal points).

o If Base from and Base to are the same, no change is made.

¢ Negative numbers are represented using unsigned values (e.g. twos complement for
binary) if Base to is anything other than 10.

e Warnings are shown in the Warnings tab for non-integer values.

e Use Copy Cols to copy columns before conversion.

e Use Num Format to change the format of numbers (e.g. remove group separators).

e You can use Insert to add characters to the front of values, e.g. to add '0Ox' to hexadecimal
values.

See also
e Video: How to convert base
e Decode

2.3.35 Num Format

Description
Change the number format in one or more columns.

Examples
Set numeric values to 2 decimal places:
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Reference

Value

1 1.27239
2 23.52035

3 49.7877

y

Num Format fff} EC

® Change the number format in the selected colu...
El Q Filter columns
Value

v

1 of 1 columns selected

Format: f v

4 )

Precision: 2

use group separator

Non-numeric: Leave v

v

Value
1 1.27

2 23.52

3 49.79

Set numeric to shortest accurate number:
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Value

1 1.2720000

223.0035000

3 4.0787770

'

Num Format o d »¥e

@ Change the number format in the selected colu...
E Q Filter columns

v Value

1 of 1 columns selected

Format: 5 b
Precision: 3

use group separator

Non-numeric: Leave s

v

Value

1 1.272
2 23.0035

3 4.078777
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted). For the s format Precision is ignored. The following
number formats are supported:

Format Meaning

€ Format as [-]9.9¢e[+]|-]999.
E.g.1234567.89 isshown as 1.235e+06.

E Format as [-]9.9E[+]-]999.
E.g.1234567.89 isshown as 1.235E+06.

f Format as [-]9.9.
E.g.1234567.89 isshown as 1234567.89.

g Use e or f format, whichever is the most concise.
G Use E or f format, whichever is the most concise.
= The shortest accurate representation for the given

number without exponents.
E.g.1234567.00 isshown as 1234567.

¢ Check use group separators to include the group separators for your locale. E.g. to turn
1234567to 1,234,567 fora UK or US locale.

¢ Set Non-numeric according to what you want to do with non-numeric values in
transformed columns. NaN means Not a Number.

Notes

¢ Numbers should be base 10 (decimal).

e The |ocale is used to decide how the number is represented (e.g. group and decimal
separators).

¢ Non-numerical values are ignored.

¢ You can also use Extract and Pad to change the number of characters.

e Warnings are shown in the Warnings tab for non-numeric values.
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See also
e DateTime Format
2.3.36 Offset

Description
Moves values in selected columns up or down.

Example
Move the 'v2' values down 1:

v v2
1 1 1
2 2 2
3 3 3
4 4 4
5 5 5
Offset & Bl Offset FECT
(@ offset values up or down in selected columns. (3 Offset values up or down in selected columns.
IEl Q Filter columns |E| Q Filter columns
v i vl
v ve v v2 | f
1 of 2 columns selected 1 of 2 columns selected i
Offset: 1 = Offset: 1 =
Direction: Down v Direction: Down v
wraparound V| wraparound .
New value: 0 New value: F
vl ‘\{2 vl *2
1 1 0 1 1 5
2 2 1 2 2 1
3 3 2 3 3 2
4 4 3 4 4 3
5 5 4 5 5 4
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Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Offset to the number of rows you wish to offset values by.

¢ Set Direction to the direction you want to offset in.

e Check wraparound if you want values pushed off the bottom of the table to be added to
the top or values pushed off the top to be added to the bottom.

¢ Set New value to the value you wish to set for any cells newly created by the offset.

Notes
e You can use Copy Cols to create copies of columns before you offset them.

See also
e New Rows
e Slide

2.3.37 Outliers

Description
Find outlier numerical values.

Examples
Set outliers empty based on quartiles and add a column with the outlier score:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Height

1 0.00

2 1l -

< 1.71

4 il 7/l

5 1.73

6 1L 7/

7 1.77

8 1.84

9 1.89

10 1.95

11 2.10

12 5.00

Outliers o Recall[==E ke
@ Find outlier numerical values.
Column: Height v
Score by: Inter Quartile Range v
Threshold: 1.50 :
Action: Set value v
Value:
Non-numeric: Treat as not outlier v
v add score column
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Remove rows with values that are more than 1 Standard Deviation from the mean:
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Weight
1 67
2 69
3 59
4 98
5 103
6 84
7 71
8 75
9 83
10 0
11 300
Outliers o Q{} :: _
@ Find outlier numerical values. I€
Column: Weight v
Score by: Standard Deviation v
Threshold: 1.00 -
Action: Remove outlier rows v
Non-numeric: Treat as not outlier v
add score column

v

Weight

' &7
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Inputs
One.

Options

¢ Select the column you wish to check for outliers.

e Set Score by depending on how you wish to score outliers.

o Inter Quartile Range scores values on how far they are above Q3 or below Q1 as
proportion of the Inter Quartile Range. For example:
= A value 2 IQRs above Q3 scores 2.0.
= Avalue 1IQR below Q1 scores -1.0.
= A value between Q3 and Q1 scores 0.0.

o Standard Deviation scores values on how many deviations they are from the average
(mean). This is also known as a Z-score. For example:
= A value 2 Standard deviations above the average scores 2.0.
= A value 1 Standard deviations below the average scores -1.0.

e Any score that is greater than Threshold or less than -Threshold is considered an outlier.
E.g. if the threshold is 1.5 then values that scores more than 1.5 or less than -1.5 are
considered outliers. The corresponding upper and lower ‘fence’ values are shown in the
Info tab.

¢ Set Action to the action to take for outliers:

o Change to threshold: Value greater than the upper fence value or less than the lower
fence value are set to the nearest fence value. Non-numeric values are not changed, as
it isn't clear which fence value to set them to.

o Remove outlier rows: Rows with outlier values are removed.

o Keep outlier rows: Only rows with outlier values are kept.

o Set value: Outlier values are changed to the value provided in the Value field.

e Set Non-numeric depending on whether you want to treat non-numeric values as
outliers.

e Check add score column if you want to add an extra column with the outlier scoring.

Notes

e Warnings are shown in the Warnings tab for non-numeric values.

e Use Num Format to change the format of numbers (e.g. remove group separators).

e Use Impute to impute any missing values.

e Use Sort to sort by values in the score column.

e You can convert dates into numerical values (e.g milliseconds since 1970 or Julian day)
using Calculate or Javascript.

See also:
Video: How to find outliers in data
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2.3.38 Pad

Description
Pad text to a minimum length in one or more columns.

Example
Pad the 'ld' column to 10 digits using zeros:
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Id Name
1 1 Alice
2 2 Bob
3 3 Charlie
4 4 Dwayne

v

Pad iﬁ} E ;
@ Pad the selected column(s) to a fixed length.

El Q Filter columns

Id

v

MName

1 of 2 columns selected

Minimum length: 10 =

Pad: Left v

Pad with: Zeros v
Id Name

1 0000000001 Alice
2 0000000002 Bob
3 0000000003 Charlie

4 0000000004 Dwayne
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

¢ Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.39 Pivot

Description
Creates a pivot table to summarize values for one or two columns.

Example
Pivot to sum 'Amount’ by 'Area’ and 'Currency":
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Area Currency Amount
1 Europe EUR 13937.00
2 North America 22894.90
3 Africa 12745.55
4 North America 48356.95
5 Europe GBP 1100.00
6 Europe m 5905.80

v

Pivot (‘f — 33!

@ Create a pivot table to summarize the selected ...

Columns: Currency b

Rows: Area v

Values: Amount v

Summarize by: Sum v

Set non-calculated: Zero v

v add totals
Total by: Rows and columns v
Area EUR GBP USD @B Grand Sum

1 Africa 0 0 0 12745.55 12745.55
2 Europe 19842.8 1100 0 0 20942.8
3 North America 0 0 71251.85 0 71251.85
4 Grand Sum 19842.8 1100 71251.85 12745.55 104940.2
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Inputs
One.

Options
e Set Columns to the column values you want to use as columns in your pivot table.
¢ Set Rows to the column values you want to use as rows in your pivot table.
¢ Set Values to the column you wish to summarize.
e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are ignored.
o Minimum shows the smallest value. Non-numeric and empty values are ignored.
o Maximum shows the largest value. Non-numeric and empty values are ignored.
o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.
o Median shows the median of numeric values in the column. Non-numeric and empty
values are ignored.
o Mode shows the mode of numeric values in the column. Non-numeric and empty
values are ignored.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s). Non-numeric and empty values are ignored.
o Count shows the number of non-empty values. A value that contains whitespace or 0 is
not considered empty.
o Count distinct show the number of non-empty values. Duplicates are not counted. A
value that contains whitespace or 0 is not considered empty.
¢ Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.
e Check add totals to add row and/or column totals.
¢ Set Total by depending on whether you want to total by Rows and columns, Rows or
Columns. This is only available if add totals is checked and Columns and Rows are
selected.
e Check drilldown to allow double-clicking a cell in the data table to drilldown to the rows
that contributed to this value in the upstream data.

Notes

e Column and row values are ordered alphabetically. You can change the order using
Reorder Cols (for columns) and Sort (for rows).

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.
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e To add a column of 1 values to Sum (e.g. to find out how many rows a value occurs in)
use a New Col transform.

See also
e Count
e Stats

e Summary
2.3.40 Remove Cols

Description
Removes columns.

Example
Remove the 'Area' column:
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Area Currency Amount

1 Europe EUR 13937.00

2 North America USD 22894.90

3 Africa ZAR 12745.55

KAt

Remove Cols Q{: = vyt

@ Uncheck columns you wish to remove.

o —
E Q Filter columns

:
Area !
c |
urrenc !
v oo E
i
Amount
v i
g
Currency Amount
1 EUR 13937.00
2 UsSD 22894.90
3 ZAR 12745.55
Inputs
One.
Options

e Uncheck the column(s) you wish to remove.
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Notes
e The column will be removed from any dataset ‘downstream’.

See also
e New Col
2.3.41 Rename Cols

Description
Rename column headers.

Example
Rename columns 'first' to 'First' and 'Last' to 'last":

first last
1 John Smith
2 Jane Smith
Rename Cols CF 5 EQ
@ Rename column headers.
a || A ||Aa||58
Old name MNew name
first First
last Last
First Last
1John Smith
2 Jane Smith
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Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names to lower case.

e Click Upper to change all the names to upper case.

e Click Title to change all the names to title case.

¢ Click Replace to replace name text using text, exact text or Regular expression matching.
e Click Prefix/Suffix to add text to the front or back of all the names.

¢ Click Unique to add '-2', '-3' etc to duplicate names, to make them unique.

¢ Click Reset to change all the names back to their original name.

Notes
e The names of column headers do not have to be unique.
e Warnings are shown in the Info tab for duplicate column names (case sensitive).

2.3.42 Reorder Cols

Description
Reorder columns.

Example
Reorder 'Last’, 'First' and 'Title' columns:
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Last First Title
1 Smith John Mr

ZSmiIhMDr

Reorder Cols dj =2 Eg
@ Drag columns to reorder.

T 1™V LUENEC

Title

First
Last

Title |First | Last

1 Mr  John Smith
2 Dr Smith
Options

Drag the columns into the desired order (left-most at the top).

Click the Move first button to move the selected columns to be first.

Click the Move up button to move the selected columns up one place.

Click the Move down button to move the selected columns down one place.
Click the Move last button to move the selected columns to be last.

Click the Sort ascending button to sort the columns in ascending order.
Click the Sort descending button to sort the columns in descending order.
Click the Reset button to restore the original column order.

Inputs
One.

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Notes

e You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.

e Number, date and text values are treated differently for sorting purposes, when sorting
columns.

2.3.43 Replace

Description
Replace text in one or more columns.

Examples
Replace US state initials in the 'Address' column:
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First Last Address
1 Jane  Smith 100 W St, Tucson, AZ

2 Ahmed Ali 17 N St, Anchorage, AK

3 Josh  Jones 123 S St, Fort Smith, AR

‘

Replace OU te

[T

@ Replace multiple text in the selected column(s). ...
E Q Filter columns
Last =

v A_ddress

| 3
1 of 3 columns selected

@MV ®E & X

Match Type Replace With
1 Text v AK Alaska
2 Text ¥ AR Arkansas
3 Text ¥ AZ Arizona

v case sensitive

y

First Last Address

1Jane  Smith 100 W St, Tucson, Arizona
2 Ahmed Ali 17 N St, Anchorage, Alaska

3 Josh  Jones 123 S St, Fort Smith, Arkansas
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Reformat phone numbers using a regular expression:
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Home Business

I
! 10123456789 0123489404
I

2 0139384892 0129347236

3 0153498348 0150923404

B

R Al
Replace o d Ee
@ Replace multiple text in the selected column(s). Can use powerf...
[ =] (@ Filter columns

Home

v

Business

v

2 of 2 columns selected

@ ML ®E S X

Match Type Replace With
1/ Regex ¥ oQd\d\d\d)(\d\d\d\d\d) (+44) \1\2

V

Home Business

1/(+44) 1234 56789 (+44) 1234 89404

v case sensitive

2 (+44) 1393 84892 (+44) 1293 47236

3 (+44) 1534 98348 (+44) 1509 23404

Replace empty values:
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| nt nZ n3

1 123.8 9876.1

2981234 23.3
3 288
Replace OF Eg

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

nt

4

v "

JI"IE

3 of 3 columns selected |
® 1T L ®EE&E X |

Match Type Replace With
1 Empty v 0.0

- I
v case sensitive

y

ni n2 n3

11 123.8 9876.1 0.0

2981234 00 233

3 288 00 00
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Remove symbols:
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Amount
1 $100.0
2 $95.2
3 $45.3
4 $15.6
Replace * ﬁf B Eg

@ Replace multiple text in the selected column(s).
E E Q Filter columns

Amount

v

1 of 1 columns selected

@1V ®BE&E X

Match Type Replace With

1 Symbols v

Amount
1 100.0
2 95.2
3 45.3
4 15.6
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Inputs
One.

Options
e Check the column(s) you wish to transform.
e Click the ® button to add a new filter criteria.
e Click the T button to move the selected terms up.
e Click the "' button to move the selected terms down.
e Click the ® button to delete the selected filter terms.
e Click the B button to copy all terms to the clipboard.
e Click the & button to paste terms from the clipboard.
e Click the X button to clear all terms.
e Add the terms you wish to replace and how you wish to replace them.
o Choose the Match type as:
» Text to replace matches contained in the text.
= Exact text to replace the text only if it matches exactly (whitespace sensitive).
= Regex to match using a Regular expression.
* Empty to match empty cells (cells with whitespace are not empty). The Replace value
is ignored.
= Letters to match letters, e.g. 'a’. The Replace value is ignored.
» Digits to match numeric digits, e.g. '1". The Replace value is ignored.
* Punctuation to match punctuation characters e.g. ',". The Replace value is ignored.
» Symbols to match symbol characters e.g. '$'. The Replace value is ignored.
= Space to match whitespace characters. The Replace value is ignored.
o In Replace put the text you want to replace for Text, Exact text or Regex matching.
You can use a column variable.
o In With put the text you want to replace it with. You can use a column variable.
e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.

e If you are pasting in replacement terms, the format expected is comma delimited text with
3 columns.
o The first column is the 0-based index of the Match Type drop-down list.
o The second column is the text Replace.
o The third column is the text With.

For example, pasting in:
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0,YES, 1
2,7Y$,1
Will add:
Match Type Replace With
1 Text ¥ YES 1
2 Regex v |AYS 1

You can also try copying terms to the clipboard and pasting into a text file to see the
format. If you only paste in 1 column of text, it will be assumed to be a list of Replace. You
can, of course, use Easy Data Transform to create the appropriate filter terms and paste
them into memory.

See also

e Insert
e Substitute

2.3.44 Row Num

Description
Add a new column that contains the row number.

Example
Add a row number starting at 1:
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Product Id
1 AD00001

2 A00002

3 A00003

Row Num ‘%cf*"%x

@ Add a new column with the row number.

New column name: Row Num

Start at: 1 :
Increment: 1 :
Every: 1 -

V

Product Id Row Num
1 A0DOO1 1
2 A00002 2
3 A00003 3
Inputs
One.
Options

¢ Set New column name to the name of the new column you want to create.
o Set Start at to the number you want to use for the first row.
¢ Set Increment to the amount you wish to increment by.
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¢ set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e You can Pad the row number with zeros to turn it into a column of unique Ids with a fixed
length.

e You can use Row Num with a Calculate transform using operation MSecsToDateTime to
create a sequence of dates.

e You can use Row Num with Calculate transform using operation Modulus and an If
transform to create a sequence of repeating text.

2.3.45 Sample

Description
Selects a subset of rows from the input.

Example
Sample 3 rows from 5:
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Timestamp Temperature ( F) Humidity (RH )
1 2020-10-19T20:40 143.5 108
22020-10-23T19:45 119.6 127

5 2020-11-05T07:15 130.8 132

Sample - Vo d E C'
® Sample from all rows. Useful for testing changes to d...
Rows: 3 -
Select: Evenly v
Random seed: 93267 =

disable sampling

'

‘Timestamp Temperature (F) Humidity (RH )
1.2020-10-23T19:45 119.6 127

2020-10-30T16:40

Inputs
One.
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Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

e Check disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you set Select to Randomly (for quality) or Randomly (for speed), rows will be
selected using a pseudo-random number generator, initialized with Random seed.
Changing the seed will change the rows sampled.

¢ With the same Random seed and the same Select value you should get the same
random sampling, even across Windows and Mac versions of Easy Data Transform.

¢ Random (for speed) is significantly faster than Randomly (for quality), but the results
may be less random.

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Slice or Row Num followed by a Filter. For the most complex cases
use Row Num, followed by Javascript, followed by a Filter. E.g. this Javascript function
returns 1 for every 10th row between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10
== 0;

2.3.46 Scale

Description
Scale (normalize) numeric values, e.g. to a percentage or O to 1.

Examples
Scale a single column to a percentage:
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale tf’ E i

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

J Di-s.pgted

1 of 2 columns selected

4)p

Scale to : 100
Using:  Sum v

Of: All values v

v

ltem Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823




Reference

Scale a table with row, column and grand totals to a percentage (scale to 400 as each value
is also added to the row total, column total and grand total):
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Sum Amount EUR GBP usD ZAR Total
1 Africa 0.00 0.00 0.00 12745.55 12745.55

2 Europe 19842 .80 1100.00 0.00 0.00 20942.80

3 North America 0.00  0.00 71251.85 0.00 71251.85

4 Total 19842.80 1100.00 71251.85 12745.55 104940.20

y .

KAl
Scale (f’ v b
® Scale numeric values, e.g. to a percentage or 0 t... |
IE' Q Filter columns

Sum Amount

EUR
v

GBP
v

ush
\'4

v ZAR.

Total
v .

5 of 6 columns selected

1)

Scale to : 400

Using:  Sum v

Of: All values ‘ v

Sum Amount EUR GBP uspD ZAR Total

1 Africa 0 0 0 12.1455362197 12.1455362197
2 Europe 18.9086737018 1.0482160316 0 0 19.9568897334
3 North America 0 0 67.8975740469 0 67.8975740469
4 Total 18.9086737018 1.0482160316 67.8975740469 12.1455362197 100
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Scale heights and weights so that the largest in each column is 1 and the smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
Scale Oa 3 Q I

@ Scale numeric values, e.g. to a percentage or 0 t...

o .
E Q Filter columns

Name

v Hv.elght.{m} | |

v w?.ight (Kg) |

2 of 3 columns selected

Scale to : 1 :
|

Using:  Maximum v |
|

Of: Each column Y

V

Name Height (m) Weight (Kg)
1 Alice 0.8168316832 0.6632653061

2 Bob  0.9851485149 1

3 Charlie 0.9554455446 0.7755102041
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Scale heights and weights so that the largest in each column is 1 and the smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
| scale _‘*““ Pl

@ Scale numeric values, e.g. to a percentage or 0 t...

o — "
IEI Q Filter columns

MName

Height
v E|.g. (m)
v ﬂeight (Kg) |
2 of 3 columns selected
Scale from: 0 -
Scaleto: 1 -
Using: Minimum & Maximum v
Of: Each column v

v

Name Height (m) Weight (Kg)
1 Alice 0 0

2 Bob 0.9189189189 1




Reference

Inputs
One.

Options

¢ Set Columns to the columns whose values you want to scale.

e set Scale from to the value you want to scale the minimum value to. E.g. 0 if you want the
minimum value scaled to 0. This is only available when Using is set to Minimum and
Maximum.

¢ Set Scale to to the value you want to scale the maximum or sum value to. E.g. 100 for a
percentage.

¢ Set Using depending on whether you want to use the Sum, Maximum or Minimum and
Maximum values for scaling.

e Set Of depending on whether you want to scale for Each column, Each row or for All
values.

Notes

e Whether values are interpreted as numbers depends on locale.

e Non-numeric values (including empty values) are ignored.

e To replace empty values with zeros use the Replace transform.

¢ To modify the numerical precision of the results use the Num Format transform.
e To add a '%' at the end of values use the Insert transform.

e To copy columns before using Scale use Copy Cols .

e Warnings are shown in the Warnings tab for non-numeric values.

See also:
e Video: How to normalize data

2.3.47 Sequence

Description
Add missing rows from an integer or date sequence.

Examples
Add missing IDs in the current range, with values copied from above:
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Reference

i ID CODE
1| 1A
2 S B
3 10cC
Sequence ool g

@ Add missing rows from a sequence.

Rows added: Missing integers o
From column: | ID * |
Minimurm: User defined -

Minimum value: 1
Maximum: User defined o

Maximum value: 15

Order: Ascending v
New values: Copy from above * |
ID CODE

1 1A

2 2A

3 3A

4 4 A

5 | 5B

6 | 6 B

7 | 7B

8 | 8B
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Add missing dates in a specified range as 0 sales:
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Date Sales
112/1/2023 100

2‘?!1!2!‘.}23 2000

3|9f1f2023 ‘ 555

Sequence i o4 ‘S
(?) Add missing rows from a sequence.
Rows added: Missing dates ¥ E
From column:  Date - F
Minimum: User defined v E
Minimum value: 2023-1-1
Maximum: User defined v
Maximum value: 2023-1-14 s
Order: Ascending i E
New values: User defined v
With value: 0

Date Sales
1 1/1/2023 0
2 2/1/2023 100
3 3/1/2023 0
4 4/1/2023 0
5 5/1/2023 0
6 [6/1/2023 0
T 1/1/2023 2000
g [8/1/2023 0
y T



Reference

Create an integer sequence from a dataset with no rows:
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Sequence ‘s Oﬂ B E :
@ Add missing rows from a sequence.
Rows added: Missing integers >
From column: N -
Minimum: User defined >

Minimum value: 0
Maximum: User defined A

Maximum value: 9

Order: Descending v
New values: Blank b
N

1,9

2|8

3|7

4 | ©

5| 5

e 4

7 3

8 | 2

9|1

10/ O
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Inputs
One.

Options
¢ Set Rows Added to Missing integers or Missing dates depending on the type of
sequence.
¢ Set From column to the column with the incomplete sequence.
¢ Set Minimum to:
o From data to set the minimum value in the sequence to the minimum value in the
selected column.
o User defined to set the minimum value to a value set by the user. Must be in -M-d
or yyyy-MM-dd format for dates, regardless of the date format in the dataset.
¢ Set Maximum to:
o From data to set the maximum value in the sequence to the maximum value in the
selected column.
o User defined to set the maximum values to a value set by the user. Must be in yyyy-M-
d or yyyy-MM-dd format for dates, regardless of the date format in the dataset.
e Set Order according to whether you want the dataset sorted Ascending or Descending
by the selected column.
¢ Set New values to:
o Blank to set new row values to empty.
o Copy from above to set new row values to the same as the next row sorted above from
the input dataset.
o Copy from below to set new row values to the same as the next row sorted below from
the input dataset.
o User defined to allow the user to choose a value for new row values. Set With value for
the new value to use.

Notes

e Existing sequence values are unchanged.

e You can add leading zeros to integers values created using the Pad transform.

e Dates added will try to follow the format of existing dates, using the date formats listed in
the Dates tab of the Preferences window. If you want ISO dates, make sure yyyy-MM-dd
is above yyyy-M-d.

e You can change the format of dates created using the DateTime format transform.

e If you only want to add some values from a sequence (e.g. odd numbers or weekdays)
then you can do this by using Sequence followed by Filter to remove the unwanted
values. You might need to use Calculate with the Modulus and/or Day of week operation
to create a column to filter on.
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e Use the Cross transform if you want to combine multiple sequences. E.g. to cross hourly
times (00:00, 01:00 ... 23:00 ) with a date sequence.

See also

e Video: How to insert missing dates
e New rows

e Fill

e Impute

e Interpolate
2.3.48 Slice

Description
Keep or remove a continuous section of rows.

Example
Keep only the rows between the 'YEAR' rows:
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Reference

1 2 3 4
1 YEAR JAN FEB MAR

2 1980 256.9 238.5 2754
3 1981 2489 2249 259.1
4 YEAR JAN FEB MAR
5 1982 258.6 230.0 2804

6 1983 2759 2349 2519

¢

Slice I:P = Eg
® Keep or remove a continuous section of rows.
Mode: Keep v
From: First row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'From' row

To: Last row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'To' row

v case sensitive

'

1 2 3 4




Reference

Inputs
One.

Options

¢ Set Mode depending on whether you want to keep or remove the slice.

¢ Set From according to how you want to choose the first row of the slice.

¢ Set Column, Matches and Value to match the first row. You can use a column variable for
either Value.

e Uncheck Include 'From’ row if you don't want to include the first row in the slice.

¢ Set To according to how you want to choose the last row of the slice.

e Set Column, Matches and Value to match the last row.

e Uncheck Include 'To’ row if you don't want to include the last row in the slice.

e Check case sensitive to use case sensitive matching for text.

Notes

e If there is no match for the From or To row:

o Mode=Keep will remove all rows

o Mode=Remove will keep all rows

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will be compared
as text. So you might want to replace empty values with 0 or remove those rows with
Filter, before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

¢ See here for more details on Regular expressions (regex).

e If you want to keep or remove a selection of rows by row number, use a Row Num
transform followed by a Filter transform.

2.3.49 Sslide

Description
Move non-empty values in selected columns to adjacent non-empty cells.

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Example
Move all non-empty values to the top:
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Alice Bob Charlie
ltask 1
2 task 3
3 task 4
4.task 6 task 7
Slide S e alll === (¢

® Move non-empty values in selected columns int...
IE‘ Q Filter columns

N, Alice

v Bob

v Charlie

3 of 3 columns selected

Direction: Up v

v

Data Characters  Warnings

3 cols x 4 rows

BB HIZE Y K < = -

LAlice Bob Charlie

1task 1 [task 2 task 3

2 task 4 task 7

3 task 6
A
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Inputs
One.

Options
e Check the column(s) you wish to move values in.
¢ Select Direction depending on the direction you wish to move values.

Notes
e Cells containing whitespace are not considered empty.
¢ You can delete rows left empty using Filter. and column left empty using Remove Cols.

See also
o Offset
e Fill

e Whitespace
2.3.50 Sort

Description
Sorts rows by one or more columns.

Examples
Sort by 'Last' and then First' columns:
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Title First Last

1Mr John Smith

2 Dr |Jane ‘Smith

3 Mr |Alberl:‘5m'rl:h

4 Mr  John Doe

v

R A
Sort ‘= QE} =)0
@ Sort rows by text, numeric and date values in th...

@/ 1L [ %

Column Order
1/ Last ¥ Descending ~
2 First ¥ Descending ¥

V

Title _First _Last
1Mr John Doe

add rank

3Dr Jane Smith

4 Mr John Smith

Sort by 'Category' and then 'Score' columns. Rank for each distinct ‘Category’ value:
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Name Category Score
1 Andy Novice 122
Joint veteran | 120
3 Charles Novice | 123

v

Sort & ff = E:
@ Sort rows by text, numeric and date values in th...
@MV ® X
Column Order
1|Category ¥ Descending ¥
2|Sccre ¥ Descending ¥
v add rank
Rank type: Minimum v
Rank by: Category ‘ bt
Name Category Score Rank

!IIIIIHEHHH%HHHII
Erharlaes Motwrice 1232 1
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Inputs
One.

Options
e Click the @ button to add a new sort level.
e Click the T button to move the selected sort levels up.
e Click the ' button to move the selected sort levels down.
e Click the ® button to delete the selected sort level(s).
e Click the X button to clear all sort levels.
¢ Set Column to the column you want to sort by.
¢ Set Order depending on whether you want to sort this column Ascending or
Descending.
e Check add rank to add a ranking column
o Set Rank type according to how you wish to do the ranking:
* Minimum: Uses the minimum rank of each group.
» Average: Uses the average rank of each group.
»* Maximum: Uses the maximum rank of each group.
» Dense: Each successive rank is only incremented by 1. There are no gaps.
» Cumulative: Shows the proportion of rows (0 to 1) with the same or lower numbered

rank.
For example:
Sorted score
1 131
% R
3 123
4 123
5 120
6 120

Gives the following rankings, depending on Rank type:
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Rank type

Sorted score Minimum Average Maximum Dense Cumulative
131 1 1 1 1 0.167

123 2 3 4 2 0.667

123 2 3 4 2 0.667

123 2 3 4 2 0.667

120 5 5.5 6 3 1

120 5 5.5 6 3 1

o Set Rank by to rank separately for each distinct value in this column. Leave as <None
selected> if you only want a single ranking for all rows.

Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for sorting purposes.

e Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before sorting.

e If you want to rank rows without losing the original order, use Row Num to add a row
number before the Sort, and then use another Sort on the Row Num column to return
to the original order.

e Unsorted columns can be sorted into any order and this may vary between different
released of Easy Data Transform and Windows and Mac versions.

See also:
e Video: How to rank data

2.3.51 split Col

Description
Split a column into multiple new columns or rows.
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Examples
Split the 'Courses' column into multiple columns or rows:

Name Courses

1 Alice C001,H005
2 Bob  [PO02

3 Charlie|C001,P003

4 Denzil |E007,€001,H005

split Col %l o B8 e 3 split Col A fedl= b
@ Split a column into multiple new columns or rows. @ Split a column into multiple new columns or rows.
Column: Courses N Column: Courses A
Using: Text delimiter n Using: Text delimiter v
Delimiter: Delimiter:

Into: Columns = Into: Rows ~
Ordering:  Current » Ordering:  Current “
keep empty keep empty

Min. values: 0

Max. values: 100

Name Courses

Split the 'URL' column into multiple columns using colon, slash, question mark or

ampersand:

Easy Data Transform

)

v

Courses1 Courses2 Courses3

1 Alice  C001,H005 C001 HO05
2 Bob  P002 P002
3 Charlie C001,P003 Co01 ‘POOB

4 Denzil EOOT,COOLHOOS\EOO'I JEOO‘I HO005

Min. values: 0

Max. values: 100

'

Name Courses

1 Alice €001

2 Alice H005

3 Bob  P0O0O2

5 Charlie P0O03

6 Denzil EOO7

7 Denzil C001

8 Denzil HO05

4
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URL
1 https://www.easydatatransform.com/index.html?utm=adwords&token=xxx

2 https://www.perfecttableplan.com/download.html

3 https://www.hyperplan.com/buy.html?utm=twitter

v

split Col CIPe gl ==z nEe
@ Split a column into multiple new columns or rows.
Column: Courses v

Using: Regex delimiter b4

Delimiter:  [/?&]

Into: Columns b
Ordering:  Current v
keep empty
Min. values: 0 -
Max. values: 100 :
URL URL1 URL2 * URL3 URL4 URLS5
1 https://www.easydatatransf... https www.easydatatransform.co... index.html utm=adwords  token=xxx

2 https://www.perfecttablepl... |https www.perfecttableplan.com download.html

3 https://www.hyperplan.co... [https |www.hyperplan.com Jbuy.html

utm=twitter

Split characters 4 to 13 and 15 onward into new columns:
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ID

1 XXXID34582347-423434
2|XXXID349583441-7347877

3 XXKID34973883-07434

V

split Col S ECT
® Split a column into multiple new columns.

Column: |ID v

Using:  Lengths v
Lengths: -3,10,-1*

Into: Columns v

Ordering: Current v

ID ID1 ID2
1 XXXTD34982347-423434 ID34982347 423434 "

2 XXXTID34983441-7347877 ID34983441 7347877

3 XXXID34973883-07434 ID34973883 07434 .

Inputs
One.

Options

e Select the Column you wish to split.
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¢ Set Using depending on whether you wish to split using a Text delimiter (usually a single
character), a Regex delimiter or Lengths of each column.

¢ Set the Delimiter for splitting the column. E.g., (comma). For Text delimiter or Regex
delimiter only.

¢ Set Lengths as a comma separated list of the number of characters in each new column.
Put - in front of a value to ignore it. Use * as a wildcard to mean 'the rest of the value'.
Only 1 * can be used. For Lengths only. For example:
o 3,5, 4 will create 3 columns with characters 1-3, 4-8 and 8-11
o-3,5,-4,* will create 2 columns with characters 4-8 and 12 onward
o -*, 3 will create 1 column with the last 3 characters
o 2,-*,2 will create 2 columns with the first 2 and last 2 characters

¢ Set Into to:
o Columns to create a new column for each split value.
o Rows to create a new row for each split value (the original row is removed).

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to keep empty values (e.g. honor delimiters with nothing
in between). For Text delimiter or Regex delimiter only.

¢ set Min. values to the minimum number of columns/rows you wish to split each value
into. For Text delimiter or Regex delimiter only.

e set Max. values to the maximum number of columns/rows you wish to split each value
into (ignored if less than minimum). For Text delimiter or Regex delimiter only.

Notes

¢ Set Min. values to the same as Max. values to always create the same number of
columns.

e To split a column by carriage returns or tabs set Using to Regex delimiter and set
Delimiter to \n or \ t, respectively.

e If Into is Columns, new columns are added at the right end. You can change the column
order with Reorder Cols.

e If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

¢ The opposite of Split Col with Into as Columns is Concat Cols.

e The opposite of Split Col with Into as Rows is Unigue.

See also
e Split Rows

2.3.52 Split Rows

Description
Split each row into multiple rows.
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Examples
Split rows before each column containing 'title":

Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 er ‘John Smith Dr Jane Smith
E‘Mr Bill Brown Mrs Andrea Brown
Split Rows d’ e E;

@ Split each row into multiple rows.
Split each row:
® before each column where name ¢ ¥ title

1time % before <None ¥ then every 1 columi

automatically using repeated column names

'

v case sensitive

Guest title Guest first name Guest last
1{Mr John Smith
2
3 Mr Bill Brown
4 Mrs Andrea Brown

Split rows using repeated column names:
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Ql Q2 Q3 04 Q1 Q2 03 Q4 Q1 Q2

' |
1/ 232 123 34 5678 2345 23 234 89 341 93i

Split Rows tf} E Q
® Split each row into multiple rows.

Split each row:

before each column where name =
2 times|  starting be Q2 then every 4 colun
® automatically using repeated column names

v case sensitive

Q1 Q2 Q3 04
1 232 123 34 5678

2| 2345 23| 234 89

3 341 93

Inputs
One.

Options
¢ Split by column name:
o Each row will be split before each column that matches the criteria.

e Split a fixed number of times:
o Define the number of times you want to split each row, starting before which column

and then every N columns.
o The split is added before the designated columns.
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o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
¢ Split automatically:
o Find the first column name that appears more than once and split each row before each
column with that name.
e Check case sensitive to use case sensitive matching for column names.

Notes

e Comparisons of column names are whitespace sensitive.

¢ Use the keyboard Up and Down arrow keys to move the focus between the 'radio’
buttons.

e Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

¢ The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
23.53 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.

Example
Spread 'Quarter' and 'Amount’' columns to multiple columns:
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salesman area Quarter Value

1 Alice North Q1 1.3
2 Alice North 89.3
3 Alice MNorth Q23 44 3
4 Alice North -E
5 Bob East Q1 4.5
6 Bob East 79
7 Bob East Q3 8
8 Bob East 3.3
Spread tf’ EC
@ Spread the selected key and value columns into m...
Key column:  Quarter v
Value column: Value v

Missing value:
Min. new cols: 0

Max. new cols: 100

4)

2 Bob East 45 79 8 33
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Inputs
One.

Options

¢ Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.

¢ set Min. new cols to the minimum number of new columns you wish to add, compared to
the original dataset.

¢ set Max. new cols to the maximum number of new columns you wish to add, compared
to the original dataset. Ignored if less than minimum.

Notes

¢ Set Min. values to the same as Max. values to always create the same number of
columns.

e Use Sort on the key column before this transform if you need to control the order of
columns created.

e If there are rows that are duplicates, apart from the value column, this will cause errors.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

¢ You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

2.3.54 Stack

Description
Merge rows from inputs, one on top of the other.

Examples
Stack 3 employee datasets by header name:

Stack C? = Z i

Name 1D DOB
@ Merge input datasets one on top of another. Or...

employeesl.c...
1/John Black| 001 1956'07'01*9 Align columns by: Header name s

3 cols x 2 rows
2 Paul White 002 1973-03-11 /
ID DOB

Name

Name 1D DOB
. employees2.c...
1003 il Green 1977-12-30 gy @ 7Y L Yo =teck Al 1 John Black 001 1966-07-01
N 3 cols x 2 rows 3 cols x 6 rows

2 004 Ahmed Ali 1980-11-05 2 Paul White 002 1973-03-11
= D Name 30ill Green 003 1977-12-30
11968-12-12 005 Lars Hansen eummeliie @) SpEEEs 4Ahmed Ali 004 1980-11-05
21977-01-05 006 Pierre Martin J o xzows 5 Lars Hansen 005 1968-12-12
G‘Pierre Manin‘ oos|1977-o1-05
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Stack 2 employee datasets by column number:

|
RA

Stack ff’ ‘N
Name ID DOB @ Merge input datasets one on top of another. Or...
1John Black 001 1966-07-01 *oemployeesl,c___ Align columns by: Column number v

3 wls x 2 rows

2 Paul White 002 1973-03-11 Name ID DOB

\ 1 John Black 001 1966-07-01
o Stack | gl 2 Paul White 002 1973-03-11
/ 3 cols x 4 rows

3 Jill Green 003 1977-12-30

4 Ahmed Ali 004 1980-11-05

full name id date of birth
1 Jill Green 003 1977-12-30 *Q R

] 3 wls x 2 rows
2 Ahmed Ali 004 1980-11-05

Stack 2 employee datasets with a separator row:

Stack d} = E;
@ Merge input datasets one on top of another. Or...
Align columns by: Column number »
Name ID DOB v add separator rows
1John Black 001 1966-07-01 *@emp'oyeeﬂ'c-" With value: i
2 Paul White 002 1973-03-11 Sk iows | Name D DOB
! 1 John Black 001 1966-07-01
i ]
= Stack . : 2 Paul White 002 1973-03-11
5 ol x5 rows l 3 #HHE# #i#HE  HHHEH
it Green 003 1977-12-30
full name id  date of birth i|'5/Ahmed Ali 004 1980-11-05

10l Green 003 1977-12:30 g ) employees2.c...

_ 3 wls x 2 rows
2 Ahmed Ali 004 1980-11-05

Inputs

One or more.

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id" column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched in order:
o case and whitespace sensitive (e.g. 'ID' to 'ID"); then
o case insensitive and whitespace sensitive (e.g. 'ld' to 'ID"); then
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o case sensitive and whitespace insensitive (e.g. 'ID' to ' ID ); then
o case and whitespace insensitive (e.g. 'ld" to ' ID )

e Check use only top dataset columns to ignore columns not in the first dataset.

e Check add separator rows to extra rows to separate the inputs. The value entered for
With value is used for each column of the separator rows.

Notes
e The stacking order depends on the vertical (Y-axis) position of the inputs.
e Stack merges datasets one on top of the other (vertically). To merge datasets side-by-side
(horizontally) use Join.
e If you align by Column number the header of the first input is used.
e Messages are shown in the Warnings tab for:
o duplicated column names within an input dataset when Align columns by is set to
Header name
o columns stacked under columns with different names when Align columns by is set to
Column number
o differing numbers of columns between input datasets
e It is sometimes useful to Stack a single dataset, so you can add more inputs later.

See also

e Cross

e Join

e Merge datasets
23.55 Stamp

Description
Adds a stamp with time, date and other information as a new row or a new column.

Examples
Add the current date to the end of each row:
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Generation [kW] Grid [kW]  Solar [kW]
1 1.904804444 0.372133333 1.904804444

2 2.072017778 0.470303333 2.072017778

3 1.980881111 0.426542222 1.980881111

4

Stamp tf} = E:.

® Add a processing date/time stamp.
Format: -- dd/MM/yyyy --

|
Position: Every row v

v

Generation [kW] Grid [kW]  Solar [kW] Stamp
1 1.904804444 0.372133333 1.904804444 -- 07/06/2021 --

2 2.072017778 0.470303333 2.072017778 -- 07/06/2021 --

3 1.980881111 0.426542222 1.980881111 -- 07/06/2021 --

Add the current date and time to the top of a dataset with a comment:
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Stamp d: E

@ Add a stamp with processing date, time and othe
Format: d/M/yyyy HH:mm:ss -- Id/M/yyyy format!!

Position: At start

Data Warnings Info Comment Deta’
1 col x 2 rows @ 1 row ac
(3@ L@ F Y K| < >2T |1

1

1 14/2/2022 17:58:07 -- d/M/yyyy format!!

Inputs
One.

Options

e Supply the stamp format in Format (see below).

Format Meaning

d The day as number without a leading zero
(1to 31)

dd The day as number with a leading zero (01
to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

dddd The long localized day name (e.g. 'Monday'
to 'Sunday’). Uses the locale to localize the
name.

M The month as number without a leading

zero (1 to 12).
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Format Meaning

MM The month as number with a leading zero
(01to 12)

MMM The abbreviated localized month name (e.g.
‘Jan' to 'Dec’). Uses the |ocale to localize the
name.

MMMM The long localized month name (e.g.

‘January' to 'December’). Uses the locale to
localize the name.

vy The year as two digit number (00 to 99).

YYYY The year as four digit number. If the year is
negative, a minus sign is prepended in
addition.

h The hour without a leading zero (0 to 23 or

1 to 12 if AM/PM display).

hh The hour with a leading zero (00 to 23 or 01
to 12 if AM/PM display).

H The hour without a leading zero (0 to 23,
even with AM/PM display).

HH The hour with a leading zero (00 to 23, even
with AM/PM display).

m The minute without a leading zero (0 to 59).

mm The minute with a leading zero (00 to 59).

S The whole second without a leading zero (0
to 59).

22 The whole second with a leading zero

where applicable (00 to 59).

z The fractional part of the second, to go
after a decimal point, without trailing zeroes
(010 999). Thus "s.z" reports the seconds to
full available (millisecond) precision without
trailing zeroes.
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Format Meaning

AP or A The fractional part of the second, to
millisecond precision, including trailing.

ap or a Use am/pm display. a/ap will be replaced by
either "am" or "pm".

t The timezone (for example "CEST").

S (c) The computer name.

S (f) The path of the .transform file, e.g. C:
\Users\andy\Desktop\mytransform
.transform.

S (u) The name of the user (from the USER or

USERNAME environment variable).

Anything after the first ! (exclamation)
character won't be substituted.

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.
e The Format text is case sensitive.

See also
e Meta information
e Stack

2.3.56 Stats

Description
Calculates statistics by column and/or row in one or more selected columns.

Example
Calculate column and row averages:
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Grid [kW]  Solar [kW]
1 0.372133333 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

‘

KA
Stats o 4l ZZE R
@ Calculate sum, min, max, average, median or st...
IE' Q Filter columns

v Grid [kW]

y Solarfwl i

2 of 2 columns selected

Calculation: Average bt

On: Columns and rows v

Grid [kW] Solar [kW] Average
1 0.372133333 1.904804444 1.1384688885

2 0470303333 2.072017778 1.2711605555
3 0426542222 1.980881111 1.2037116665

4 0.4229929627 1.985901111 1.2044470368

Inputs
One.
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Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate:

o Sum show the sum of the values.

o Minimum shows the smallest value.

o Maximum shows the largest value.

o Average shows the arithmetic mean of the values.

o Median shows the median of numeric values in the column.

o Mode shows the mode of numeric values in the column.

o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).

o Variance is the square of the sample standard deviation.

o Q1 is the first quartile (calculated using Method 1 here).

o Q3 is the third quartile (calculated using Method 1 here).

o IQR is the Inter Quartile Range.

o Skew is the alternative Pearson Mode Skewness (3 * (Mean — Median) / Standard
Deviation ).

o Percentile (inclusive) is an interpolated value at which the specified Percentile of
values are below or equal to this value. It is similar to the Excel PERCENTILE. INC ()
function.

o Percentile (exclusive) is an interpolated value at which the specified Percentile of
values are below this value. It is similar to the Excel PERCENTILE.EXC () function.

¢ Percentile is the percentile value to use in Percentile (inclusive) and Percentile

(exclusive) calculation.

¢ Set On depending on whether you wish to calculate the statistics for columns, rows or
both.

o If On is set to Columns an extra row with the results is added to the bottom.

o If On is set to Rows an extra column with the results is added to the right.

o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell contains
the calculation across all values.

Notes

e Non-numerical and empty values are ignored.

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

e If you want to compute the sum, minimum, maximum or average for each distinct value in
1 or more columns you can use Unigue.
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See also

e Count

e Pivot

e Summary
2.3.57 Substitute

Description
Substitute column values into text.

Example
Create an SQL statement to insert 'date’, 'cases’, 'deaths' and 'country’ values into 'mytable":

date cases deaths country

12020-05-03 134 4 Afghanistan
2 2020-05-03 7 0 Albania

32020-05-03 141 6 Algeria

v

Substitute (f“ & Eg

® Substitute column values into text.

New column name: SQL |
Substitution script:

INSERT INTO mytable (country,date,deaths,cases) VALUES ($(country),$(date),$(deaths),$(cases));

date cases deaths country sqQL
12020-05-03 134 4 Afghanistan INSERT INTO mytable (country,date,deaths,cases) VALUES (Afghanistan,2020-05-03,4,134);

2 2020-05-03 7 0 Albania INSERT INTO mytable (country,date,deaths,cases) VALUES (Albania,2020-05-03,0,7); |
3 2020-05-03 141 6 Algeria INSERT INTO mytable (country,date,deaths,cases) VALUES (Algeria,2020-05-03,6,141); !
Inputs
One.
Options

¢ Set New column name to the name of the new column you want to create.

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.
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¢ Click the Evaluate button to evaluate your script over every row and show any errors
(only available if Run>Auto Run is checked).

Notes

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.

e Warnings are shown in the Warnings tab for ambiguous column references.
2.3.58 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Example
Subtract from the top dataset all the rows with ids in the bottom dataset:

Subtract Cf’} e X
@ Remove rows from the top dataset whose key values are ...
Top key column: Id v
Id First Bottom key column: ID N

1 001 Alice

btract-a.csv
2 002 Bob * o>
3 003|Charlie 2 cols x 4 rows

4 004 Dwayne

Id First

© Subtract y . 1| 002/Bob

2 cols x 2 rows
2 004 Dwayne

subtract-b.csv
1 00 el @
Eﬁ 1 col x 2 rows
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Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Check case sensitive to use case sensitive matching for keys.

Notes

e This transform is sometimes called an anti-join.

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the subtract.

e All rows in the top dataset with a given key value are removed if that key value occurs 1 or
more times in the bottom dataset.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

e Use a second Subtract transform to see what was subtracted:

Id |First
° subtract-a.csv > Subtract dh |1 00121ice
2 cols x 4 rows 2 cols x 2 rows 2 003 Charlie

o Subtract

2 cols x 2 rows

subtract-b.csv

1 col x2 rows

See also
e Intersect
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2.3.59 Summary

Description
Summarize the values in the selected columns.

Example
Create a summary, including dates and statistics:
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date cases deaths country

12020-05-03 134 4 Afghanistan

2 2020-05-03 7 0 Albania

3 2020-05-03 141 6 Algeria

y

R A

Summary t? @ Y |

@ Summarise the values of the selected columns.
E IEI Q Filter columns

v date -

Cases

v

v dgaths

4 of 4 columns selected

v include dates

v include statistics

Metric date cases deaths country

(1 |Empty values 0 0 0 0
i 2 Non-empty values 3 3 2 3
3 Numeric values 0 3 3 0
4 Integer values 0 3 3 0
5 Date values 3 0 0 0
6 Text values 0 0 0 3

l 7 Distinct values 1 3 3 3
8 Unique values 0 3 3 3
9 Duplicated values 1 0 0 0
10 Min lenath 10 1 1 ri
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Inputs
One.

Options

¢ Select the Columns you wish to summarize.

¢ Check include dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.

¢ Check include statistics if you wish to add the sum, average, median and standard
deviation for numeric values.

Notes

e Whether values are interpreted as number or dates depends on Supported date formats
and locale.

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Non-empty values is the number of values in the column that are not completely empty.
Values with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

¢ Integer values is the number of numeric of values in the column that can be interpreted
as integers (whole numbers). "1.0" (depending on your locale), "0", "-1" and "1e3" are
considered integers.

¢ Real values is the number of numeric values in the column that can be interpreted as
reals (floating point numbers). "1.2345" (depending on your locale) and "1e-3" are
considered reals.

¢ Boolean values is the number of values in the column that can be interpreted as
booleans (true/false). "TRUE", "True" and "false" are considered booleans.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

o Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

e Distinct values is the number of different values in the column. Date and numeric values
are treated as text (e.g. '7' is treated as different to '7.0' and '1/1/2020" is treated as
different to '01/01/2020"). Comparison between values is sensitive to case and
whitespace.

¢ Unique values is the number of values that only occur once in the column. Date and
numeric values are treated as text. Comparison between values is sensitive to case and
whitespace.
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¢ Duplicated values is the number of values that occur more than once in the column. Date
and numeric values are treated as text. Comparison between values is sensitive to case
and whitespace.

1A
2B

Distinct values 3 G A, B, C
3B

- Unique values | p— A

4C

Duplicated values 2 e B, C
5C
6C

¢ Min length is the minimum number of characters of non-empty values in the column.
Whitespace is counted. Date and numeric values are treated as text.

¢ Max length is the maximum number of characters of values in the column. Whitespace is
counted. Date and numeric values are treated as text.

¢ Average length is the arithmetic mean of the number of characters of non-empty values
in the column. Whitespace is counted. Date and numeric values are treated as text.

¢ Min numeric is the minimum numeric value in the column. Non-numeric and empty
values are ignored.

e Max numeric is the maximum numeric value in the column. Non-numeric and empty
values are ignored.

¢ Range numeric is Max numeric - Min numeric.

¢ Negative numeric is the number of negative numeric values in the column. 0 is not
considered negative here.

e Zero numeric is the number of numeric zero values in the column.

¢ Positive numeric is the number of positive numeric values in the column. 0 is not
considered positive here.

e Sum numeric is the sum of numeric values in the column. Non-numeric and empty values
are ignored. Only shown if include statistics is checked.

e Average numeric is the arithmetic mean of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

¢ Median numeric is the median of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

¢ Mode numeric is the mode of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.
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¢ Stddev numeric is the sample standard deviation (equivalent to Excel function stddev.s)
of numeric values in the column. Non-numeric and empty values are ignored. Only shown
if include statistics is checked.

¢ Variance numeric is the square of the sample standard deviation. Only shown if include
statistics is checked.

¢ Q1 numeric is the first quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ Q3 numeric is the third quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ IQR numeric is the Inter Quartile Range. Only shown if include statistics is checked.

¢ Skew numeric is the alternative Pearson Mode Skewness (3 * (Mean — Median) /
Standard Deviation ). Only shown if include statistics is checked.

¢ Min date is the minimum date value in the column. Only shown if include dates is
checked.

¢ Max date is the maximum date value in the column. Only shown if include dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

Notes

e If your dataset is large, you might want to Sample it first.

e Use Num Format to change the precision of numerical results.

e You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table first.

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

See also

2.3.60 Total

Description
Add a new column with a running (cumulative) total of the selected column.

Examples
Total the 'transaction' column:
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area transaction
1 North 100
2 South 200
3 North -50
4 South 320
5 East 200
6 East -50
Total ff EQ
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: <None selected> v

v

area transaction Total transaction
1 North 100 100
2 South 200 300
3 North -50 250
4 South 320 570
5 East 200 770
6 East -50 720
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Total the 'transaction' column separately for each ‘area’ value:

area transaction

1 North 100
2
3 North -50
Total o | = R
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: area v |

'

area transaction Total transaction

1 North 100 100
2
50 50

3 North

4
5
6
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Inputs
One.

Options

¢ Set Column to the column you want to total.

e Set By to a column if you want a separate running total per value in that column. Leave as
<None selected> if you only want a single running total.

Notes

e Non-numerical values are ignored.

e The By column takes account of case and whitespace in values.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Count

e Pivot

e Stats
2.3.61 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Example
Swap rows and columns:
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Grid [kW] Solar [kW]
103721333233 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

Y

@ Swap rows and columns.

v

1 2 3 4
1 Grid [kW] 0.372133333 0.470303333 0.426542222

Q%
il

Transpose

has header

2 Solar [kW] 1.904804444 2.072017778 1.980881111

Inputs
One.

Options

e Check has header to make the new first row into a header.

Notes
e If the input dataset has a header, it will become the new first column. Use Remove Cols to

remove it.
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2.3.62 Unfill

Description
Set adjacent cells with identical values to empty in selected columns.

Example
Unfill down:
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Country Area  City

1 Country 1
2 Country 1 City 2

3 Country1 |Areal City3

4 Country 1 Area2 City1

5Country 1 Area2 City2

y

Unfill o] =2
@ Set adjacent cells with identical values to empty...
E] Q Filter columns

v Cc.-untr},».f

Area

4

J City

3 of 3 columns selected

Direction; Down v

v

Country  Area  City

1 Country 1 Areal City1

2 City 2
3 City 3
4 Area2 City 1
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Inputs
One.

Options
e Check the column(s) you wish to unfill.
¢ Select Direction depending on the direction you wish to unfill to.

See also

e Fill

e Slide
2.3.63 Unique

Description
Remove duplicate rows based on keeping only unique values in selected columns

Example

If you have a dataset of orders and you want to:

¢ keep one row per unique Customer Id

keep the first listed Name for each Customer Id

concatenate Product Ids for each Customer Id, delimited by a comma

sum the Costs for each Customer Id

keep the latest Date for each Customer Id

add a Count column showing how many rows in the input correspond to each row in the
output
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Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020

3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown 98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020]

y

Unique )Cf} E :

@ Remove duplicate rows, keeping only rows with unique values in se...

Column Option
Name Keep first b4
Customer Id Keep unique v
Product Id Concat A
Cost Sum hs
Date Maximum o
Set All ¥ to Keep unique v

‘Keep unique’ for 1 of 5 columns

Concat delimiter: ,

v/ add count column

V

Name Customer Id Productld Cost Date Count
1 Alice Anderson C018930 13574 29.95 01/10/2020 1
2 Bob Brown 89456,98526 20.55 02/10/2020 2

3 Charlie Jones CO17783 96352,38746 44.95 03/10/2020 2
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Inputs
One.

Options

¢ Set an Option for each column:
o Only 1 row is kept where all the Keep unique columns have the same value.
o Keep first keeps first value in the current sort order.
o Keep last keeps the last value in the current sort order.
o Sum sums any numerical values. Empty values are ignored.
o Maximum keeps the maximum numerical or date value.
o Minimum keeps the minimum numerical or date value.
o Average takes the average (mean) of any numerical values. Empty values are ignored.
o Concat to concatenate values. Duplicate values are kept. All values are treated as text.
o Concat unique to concatenate values. Duplicate values are ignored. All values are

treated as text.

e Use the Set button to quickly set the option value for multiple columns.

¢ Set Concat delimiter if you want to add a delimiter between Concat or Concat unique
values

e Check add count column to add a column showing how many rows in the input dataset
created each unique row.

e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this row in the upstream data.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns set
to Keep unique. Comparisons are case and whitespace sensitive. You can use Case and
Whitespace to change case and whitespace before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first or Keep last the sort order is important. You can use Sort to
change the sort order before deduping.

e The Dedupe transform is a less powerful (but simpler and faster) alternative to Unique.

¢ You can use Split Col Into rows to perform the opposite function to Unique.

e The opposite Unique is Split Col with Into as Rows

See also
e Dedupe a dataset
2.3.64 Units

Description
Change units of time, length, temperature etc.
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Example
Convert the 'Temperature’ column from Celsius to Fahrenheit:
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Temperature
1 -20
2 0
3 20
4 40
5 60
6 80
7 100

y

Units

v

From:

To:

@ Change units of time, length, temperature etc.
E |E| Q Filter columns

Temperature

1 of 1 columns selected

Dimension: Temperature

Celsius/Centigrade

Fahrenheit
Temperature
1 -4
2 32

Easy Data Transform
i T |
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Dimension to the dimensions of the units you wish to convert.
¢ Set From to the units you wish to convert from.

¢ Set To to the units you wish to convert to.

Notes
e The |ocale is used to decide how the number is represented (e.g. decimal separators).
¢ Unit disambiguation:
o Years are 365.25 days.
o Calories are thermal/small/gram (not nutritional) Calories.
o Miles are International/Statute Miles.
o Nautical miles are International Nautical Miles.
o Gallons (US) are liquid gallons.
o Pints (US) are liquid pints.
e Warnings are shown in the Warnings tab for non-numeric values.
Non-numerical and empty values are not changed.
Use Copy Cols to copy columns before you transform them.
Use Num Format to change the number format of the results.
Use Extract or Split Col to remove any unit symbols from the value before conversion, e.g.
to change "0.0 Kg" to "0.0".
e If you want to convert units not covered here you can do it using the Javascript transform.

2.3.65 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Example
Tidy tabs, carriage returns and repeated spaces:
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ClB)<« -

Name

1 -Mr---John<Smith
2 Dr-Jane—Smith

3 Mr-Albert<-Smith--

Whitespace r_jf} E C

® Tidy whitespace (spaces, tabs, carriage returns e...

El Q Filter columns

MName

v

L | ]
1 of 1 columns selected

v trim leading and trailing whitespace
replace line feeds with spaces

replace tabs with spaces

replace non-standard spaces with spaces
remove carriage returns

convert consecutive spaces to one space

4SS S S S

remove non-printable characters

\

BEYZ R

Name

1 Mr-John-Smith

2 Dr-Jane-Smith
2 R A A O e i




Reference

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check replace line feeds with spaces to replace LF (\n) characters with spaces.

¢ Check replace tabs with spaces to replace tab (\t) characters with spaces.

e Check replace non-standard spaces with spaces to replace non-standard spaces (such
as non-breaking space, thin space etc) with spaces.

e Check remove carriage returns to remove CR (\r) characters.

e Check convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.

¢ Check remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and
backspace. It does not remove spaces.

Notes

e The operations are carried out in top to bottom order, e.g. Replace line feeds with
spaces is carried out before Convert consecutive spaces to one space.

e Click the eye icon in the Right pane to show whitespace in the data.

Data =~ Warnings @ Info  Comment 4

2 cols x 3 @) Read
>) B TV <=2 2T Bk
2 Press to show whitespace in the dataset as symbols:
1 =1 [Space:
5| o Tab: -
Carriage return: -
3 .3. [|Line feed: o

Non-breaking space: r
Other whitespace: o
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See also
e Case

2.4 Output
24.1  Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

e Excel

* JSON

e HTML

e Markdown

e Plain text

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the Save
as type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.
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output.csv d:' Ei

@ Output to file.

Output to:  Single file v

File: C\Users\andy\Desktop\output.csv

Type: Delimited text >

Delimiter: Comma (,) v

Quoting: As needed v

Line endings: Automatic v

Encoding:  UTF-8 v
v Byte Order Mark

Write mode: Overwrite s
v write header

Alias: output

Set Output to depending on whether you want to output the dataset to a single file or
multiple files.

Set File to the location of the file you want to output (only available when Output to set to
Single file). The location can use file name variables to dynamically change output file
names based on input file names.

Set Files column to the column containing the location of the files you want to output to

(only available when Output to set to Multiple files).

e This column is not output.

e The location can be an absolute location (e.g. c:\users\andy\output.csv)ora
location relative to the .transform file location (e.g. results\output.csv).

e The location can use file name variables to dynamically change output file names based
on input file names.

¢ Folders output to must already exist.

e Empty or invalid locations (e.g. file names with illegal characters) are ignored.

e Check Confirm files if you want to manually confirm before writing to output files
(ignored for command line processing).
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If you are writing to an Excel file the output will be written to a sheet called 'Easy Data
Transform' by default. You can change this by adding the sheet name inside [], e.g.
myfile.xlsx[mysheet].

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Output Extensions tab of the Preferences window.

Set Value types depending on how you want to set JSON types (only available for JSON
files).
¢ Automatic to let Easy Data Transform decide the JSON type depending on the contents
of each column.
e String to set the JSON type for all columns to String
e Manual to choose the JSON type of each column as:
o Automatic (based on column contents).
o Boolean.
o Number.
o String.
If you output a column as Boolean or Number any values not of that type will be output as
null.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Quoting depending how you want to use quoting in the output (only available for

delimited text files, such as CSV and TSV).

¢ As needed to add quotes (") around values that contain the delimiter character, quote
characters or carriage returns.

¢ Always to add " quotes around every value.

¢ Never to never add " quotes around values (delimiters and carriage returns with values
are replaced with spaces).

Set Line endings to the control characters you wish to use to denote line endings (only

available for text files).

¢ Automatic to choose the standard line ending for the current operating system.

¢ Windows (CRLF) to choose the standard Windows line ending, carriage return+line feed
(\r\n).

e Mac\Unix (LF) to choose the standard macOS/Unix line ending, line feed (\n).

¢ Old Mac (CR) to choose the standard classic (pre mac OS X) Mac line ending, carriage
return (\n).

Set Encoding to the text encoding you wish to use (only available for text files).
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Set Formatting depending on how you want to set the Excel cell formatting (only available
for Excel files).
e Automatic to let Easy Data Transform decide cell formatting depending on the contents
of each column.
¢ General to set the cell format for all columns to 'General'.
¢ Manual to choose the cell format of each column as:
o Automatic (based on column contents).
o Boolean (expects true or false, not case sensitive)
o Date (expects a date format in Preferences).
o General.
o Number (expects a real or integer number, e.g. 123 or 123.456)
o Text.
o Formula (expects starting with =).
o Time (expects hh:mm:ss orhh:mm, e.g. 13:59:01 or 13:59).
o Hyperlink (expects a hyperlink, e.g. https://www.easydatatransform.com).

Set Byte Order Mark checked to write a Unicode Byte Order Mark to the file (only available
for UTF encodings and ignored when appending to an existing file).

Set Escape special characters checked to escape HTML special characters (for example <
and >) so they are rendered correctly in the HTML (only available for HTML files). Uncheck it
to write 'raw' HTML. Note that you can also set Change to To escaped HTML to escape
selected columns in the Decode transform.

Check remove empty to recursively remove any nodes that have an empty value and no
children (only available for JSON and XML files). For example:

A AB ABC
1
2 1
C! 1

Is output to XML with remove empty checked as:

<root>
<record>
<A>
<B>1</B>
</RA>
</record>
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<record>
<A>
<B>
<C>1</C>
</B>
</DA>
</record>
</root>

Is output to XML with remove empty unchecked as:

<root>
<record>
<A>
<B>
<C></C>
</B>
</A>
</record>
<record>
<A>
<B value="1">
<C></C>
</B>
</BA>
</record>
<record>
<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

For XML output you can set Root name, Below root and Row name depending on the
name you want to use for the root and row records and any extra information you want to
add below the root.

<?xml version="1.0" encoding="UTF-8"?2>
<!-- File created by Easy Data Transform
j[<root>
<extral>extral</extral>
<extraZ>extra2</extraZ>
<record>
<v>l</v>
</record>
<record>
<v>2</v>
</record>
</root>

Root name: root

<extral>extral</extral>
<extra2>extra2 </extra2>

Below root:

Row name: record
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Use Write mode to determine how existing files are treated:

Write mode for File exists with File exists without File does not exist

Excel files named sheet named sheet

Overwrite / File Overwrite named Add named sheet, Create file with only
sheet, delete all delete all other named sheet
other sheets sheets

Overwrite / Sheet  Overwrite named Add named sheet Create file with only
sheet* named sheet

Append Append to named Add named sheet Create file with only
sheet named sheet

New Do nothing Do nothing Create file with only

named sheet

Disabled Do nothing Do nothing Do nothing

*Overwriting a named sheet is slower than creating a new file and can cause the file size to
increase each time (due to string indexing by Excel). If this becomes a problem, you can
delete the file and re-output it. Because of this you should use Overwrite / File if the file
will only have 1 sheet.

Write mode for non-Excel  File exists File does not exist
files

Overwrite Overwrite file Create file
Append Append to file Create file

New Do nothing Create file
Disabled Do nothing Do nothing

Check write header to write the header (only available for Excel, Delimited text, HTML and
Markdown files). If Write mode is Append you can check if empty to only write the header
if the file (sheet for Excel files) is currently empty or does not exist (and not for subsequent
appends).
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Set File comment to any comment you wish to output to the file (only available for HTML,
Markdown, XML and YAML files). This can include file name variables such as {date}. Leave
it empty to output no comment.

Use Alias to identify the file for batch processing.

2.5 File formats
25.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output
Delimited text (including Yes Yes
CSV and TSV)

Excel XLSX/XLS Yes Yes
Fixed width Yes No
JSON Yes Yes
HTML No Yes
Markdown No Yes
Plain text Yes Yes
vCard Yes Yes
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input Extensions
and Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default file extension

.CSV'.

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.
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CSV is a type of delimited text file format. The column delimiter is usually a comma, but not
always. The row delimiter is line feed, carriage return or carriage return+line feed.

Easy Data Transform supports the following column delimiters:
e Comma (,)

e Semi-colon (;)

e Colon ()

* Pipe (|)

e Caret ()

e Tab (\t) (used for TSV format)

e Space ()

e Custom (choose your own)

For files padded to fixed column widths with space see Fixed width format. For file with no
column delimiters see Plain text format.

To output to a CSV file you should typically set Delimiter to Comma (,) and Quoting to As
needed in the Right pane.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
|33 Confections Candies and sweet breads true

Is output with Delimiter set to Comma (,) and Quoting set to As needed as:

CategorylD, CategoryName, Description, In stock
1,Beverages, "Soft drinks, coffees & teas",true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Note that " quotes have been used to enclose values that contain delimiter characters.
Check ignore repeated delimiters if you want to treat 2 or more consecutive delimiters as a

single delimiter. For example, this might be useful if values are separated by a variable
number of spaces:
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Area Q1 Q2 Q3 Q4
North 34.4 928.3 83.1 98.3
East 42.1 234.9 88.4 4.1

South  784.4 39.@ ©55.3 99.1
West 437.4 83.1 078.4 11.3

Type: Delimited text Type: Delimited text
Delimiter: Space () Delimiter: Space ()
v ignore repeated delimiters ignore repeated delimiters

Area Q1 Q2 Q3 Q4 Area Q1 Q2 Q3 Q4 6 7 8 9
1 North 344 9283 831 983 1 North 344 9283 831 983
2 East 421 2349 884 41 2 East 421 2349 884 41
3/South 7844 390 553 99. 3 South 7844 390 553 991
4 West 4374 831 0784 113 4 West 4374 831 0784 13

Set Quoting to Always if you want to quote every value. Set Quoting to Never if you don't
want to quote values (delimiters and carriage returns within values will be changed to
spaces).

You will be warned when inputting a CSV format file that has a different number of values
per row. This may be a sign that there are problems with the data (e.g. incorrect quoting).

Data g Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

If you want to input a file with a different delimiter to those listed, then:
1. Input it with a delimiter unlikely to be in the text, e.g. caret (*), to input it as a single

column
2. Use the Split Col transform to transform it into multiple columns using the appropriate
delimiter.

Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

See also:

e Video: How to convert CSV to JSON

¢ Video: How to convert CSV to Markdown

¢ Video: How to convert CSV to tab delimited

¢ Video: How to convert CSV to vCard

e Video: How to convert CSV to XML

¢ Video: How to convert Excel to pipe delimited
¢ Video: How to convert fixed column width to CSV or Excel
e Video: How to convert JSON to CSV

¢ Video: How to convert tab delimited to CSV

¢ Video: How to convert XML to CSV

¢ Video: How to split CSV into multiple files

¢ Video: How to change CSV file text encoding
e TSV format

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xIsx" and "xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

You can specify the sheet name when inputting or outputting Excel files using square

brackets, for example:

e MySpreadsheet.xlsx[Sheetl] means the sheet named Sheet1 of file
MySpreadsheet .x1lsx (the sheet name is not case sensitive).

e MySpreadsheet.xlsx[1] means sheet named 1 of file MySpreadsheet.x1sx (if it
exists) or else the first sheet.

e MySpreadsheet.x1sx means the first sheet of file MySpreadsheet.x1sx.

Hyperlinks are read in from Excel in the form anchor |hyperlink.

You can specify how to format columns when outputting to Excel using the Formatting
option.

Please note the following limitations of Excel:

e Excel xIsx files are limited to 1,048,576 rows and 16,384 columns.

e Excel xls files are limited to 65,536 rows and 256 columns.

e Date values are input using ISO date format yyyy-MM-dd, regardless of your locale.
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¢ Datetime values are input using ISO date format yyyy-MM-ddThh:mm:ss, regardless of
your locale.

e The following characters are not allowed in sheet names:\ / * [ ] : ?

e Writing an Excel file is significantly slower than writing a CSV file for the same dataset.

See also:

e Video: How to combine columns in Excel

¢ Video: How to convert Excel to JSON

¢ Video: How to convert Excel to Markdown

e Video: How to convert Excel to pipe delimited
¢ Video: How to convert Excel to XML

e Video: How to convert Excel to YAML

¢ Video: How to convert fixed column width to CSV or Excel
¢ Video: How to join Excel files

¢ Video: How to convert JSON to Excel

¢ Video: How to convert XML to Excel

e Video: How to remove Excel duplicates

¢ Video: How to split a column in Excel

2.5.4 Fixed width format

Easy Data Transform can input from fixed width format files, also known as fixed column
width format. Default file extension ".txt".

Fixed width format is used for exchanging tabular data between programs. It is often
associated with legacy systems, but is also used for large files where performance is an issue
(e.g. bioinformatics).

In fixed width format each column has a fixed width in characters. There is no column
delimiter. Spaces are typically used as padding to make up the column width. The row
delimiter is line feed, carriage return or carriage return+line feed. For example:

ID Name Payment Country Date

8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:
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ID Name Payment Country Date
18904 John Black 12345.67 GB 08/20/2020

2 3999 Jane Brown 23456.78 US 08/20/2020

'3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you set Columns
in the Right pane to Automatic. Or you can choose the column widths by setting Columns
to Manual. Click the '..." button to edit the manual column widths.
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fixed-example.txt @ d;’ EC
File: CA\Users\andy\Desktop\fixed-example.txt
L )
(Columns: Manual vl >
e i
€ Fixed Column Widths O X
Width Starts at Ends at
s
Column 2 |5 o7 11
F
Column 3 |8 v 12 19
Y
Column 4 10 - 20 29
Column 5 |9 T 38
FY
Column 6 {10 - |32 48
[
Merge | Split | Insert Left Insert Right Delete Columns: 6
Preview
DUDUDDG[}Dll].'lJ.lll1J.|2222222222333333333344444444-
123456/75901[23456789/0123456789012345678/901234567!
ID Name Payment Country [Date
8904 | John Black 12345.67 GB 0e/20/2021
3998 | Jane Brown 23456.78 [US 08/20/2021
7489 |Fadiel Green [(34567.89 [DE ne/20/20210
| |
OK Cancel = Help

The current column boundaries are shown on the first few rows in the Preview. The
horizontal offset of each character is shown in gray at the top. The currently selected
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columns are highlighted. Click on a column in the Preview to select it in the table, or vice
versa.

You can change the column widths using the Width column of the table.

Select 2 or more adjacent columns and click Merge to merge them into 1 column. Click
then Shift+click in either the table or the preview to select multiple adjacent columns.

Select 1 column with a Width > 1 and click Split to split into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add a new
column with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected columns.
Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using the Remove
Cols and Filter transforms.

See also:
¢ Video: How to convert fixed column width to CSV or Excel

2.5.5 JSON format

Easy Data Transform can input from and output to JSON format files. Default file extension
"json".

JSON (Javascript Object Notation) format is commonly used for exchanging data between
programs. JSON data is generally expected to be in UTF8 encoding without a Byte Order

Mark (BOM).
For example:
| CategorylD CategoryMNarme Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:
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"CategoryID": 1,

"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": true

"CategoryID": 2,

"CategoryName": "Condiments",

"Description": "Sweet
"In stock": false

"CategoryID": 3,

and savory sauces",

"CategoryName": "Confections",
"Description": "Candies and sweet breads",

"In stock": true

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber

1 Avocado Dip 2 5 0

Is equivalent to:

"name": "Avocado Dip",
"carb": 2,
"cholesterol": 5,
"fiber": O,
"minerals": {
"ca": 0,
"fe": O
b
"protein": 1,
"sodium": 210,
"vitamins": {
ngn. O,
"C": O

minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

0 0 1 210 0 0

Any dots in JSON names are converted to hyphens ('-') on input.
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JSON arrays can be input in either long or wide Format. For example:

[

"name": "l"’

"ValueS": [ "a", "b" ]
by
{

"name": "2",

"values'l: [ "C", "d" ]

Input as Long (more rows):

name values
11 a
2|1 b
32 C
|4 2 d

Input as Wide (more columns):

name values.0 values.1

11 a b

22 c d

If children of the top level object are named, then they are flattened slightly different to
avoid creating thousands or millions of columns. For example:

{

"record 1":{

"value": 1
by
"record 2":{
"value": 2
by
"record 3":{
"value": 3
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}

Is flattened into:

_ObjectName_  value
1 record 1 1
2 record 2 2
3 record 3 3

An input JSON format file is expected to have either:

e a single top-level array or object; or

¢ asingle JSON object on each line (see jsonlines.org).

e a record separator character followed by a single JSON object on each line (see REC7464).

You can specify the JSON type for each columns when outputting to JSON using the Value
types option. Any values that do not match the type selected are output as a JSON null
value.

See also:

¢ Video: How to convert CSV to JSON
¢ Video: How to convert Excel to JSON
e Video: How to convert JSON to CSV
¢ Video: How to convert JSON to Excel

2.5.6 HTML format

Easy Data Transform can output to tables in HTML format files. Default file extension
".html".

HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to

</table> part of the output.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 g Condiments Sweet and savory sauces false
i33 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-
align:left;vertical-align:top;border-spacing:0px;border-
color:gray; font-family:Verdana, sans-serif; }th{background-
color:#EOEOEO; }td, th{padding:5px; }</style>
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees g&amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
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</html>

Usually you will want to 'escape’ special HTML characters in dataset values when output to
HTML format. For example to convert < to &1t ;, so it can be correctly displayed in the
HTML. However, if you wish to write 'raw' HTML, then you can uncheck Escape special
characters in the Right pane. Note that you can also set Change to To escaped HTML to
escape selected columns in the Decode transform.

25.7 Markdown format
Easy Data Transform can output to tables in Markdown format files. Default file extension

".md".

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
I
|3 3 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In
stock |
| == | == | | ===
———|
| 1 | Beverages | Soft drinks, coffees & teas | true
|
| 2 | Condiments | Sweet and savory sauces | false
I
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

See also:
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¢ Video: How to convert CSV to Markdown
e Video: How to convert Excel to Markdown

2.5.8 Plain text format

Easy Data Transform can input from and output to plain text format files. Default file
extension is ".log" for input and ".log" or ".txt" for output.

Plain text format is used for semi-structured data, such as computer generated log files.

When inputting plain text the dataset is read into a single column. The row delimiter is line
feed, carriage return or carriage return+line feed.

For example:

03/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS
03/22 08:51:02 INFO :..reg _process: registering process with the system
03/22 08:51:02 INFO :..reg process: attempt 0S/390 registration

03/22 08:51:02 INFO :..reg_process: return from registration rc=0

Is input in plain text format as:

1
1/03/22 08:51:01 INFO ..settcpimage: Associate with TCP/IP image name = TCPCS

2 03/22 08:51:02 INFO :.reg_process: registering process with the system
303/22 08:51:02 INFO :.reg_process: attempt OS/390 registration

4 03/22 08:51:02 INFO :..reg_process: return from registration rc=0

When outputting plain text:

e Each row ends with a line feed, carriage return or carriage return+line feed, as selected by
the user.

e Typically plain text datasets only have 1 column. But if there is more than one column, the
column values will be concatenated without a delimiter. If you want a delimiter use Concat
Cols and Remove Cols to create a single column that contains the appropriate delimiters,
or output as delimited text.

¢ Values are not escaped.

2.5.9 TSV format

Easy Data Transform can input from and output to TSV format files. Default file extension

svh.
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TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format where values are separated by tab characters and
rows by line feed, carriage return or carriage return+line feed. Tabs and carriage return are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

To input a TSV file you should set Type to Delimited text and Delimiter to Tab (\t) in the
Right pane. You will usually also want to uncheck ignore repeated delimiters and set
Quoting to Automatic (which is the same as Unquoted for tab delimiters).

You will be warned when inputting a TSV format file that has a different number of values
per row. This may be a sign that there are problems with the data.

Data ! 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

To output a TSV file you should set Delimiter to Tab (\t). You will usually also want to set
Quoting to Never in the Right pane. If you have a tab character or carriage return within a
value, then Easy Data Transform will then convert it to a space on output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Tab (\t) and Quoting set to Never as:
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CategoryID CategoryName Description In stock
1 Beverages Soft drinks, coffees & teas true
2 Condiments Sweet and savory sauces false

3 Confections Candies and sweet breads true

See also:
¢ Video: How to convert tab delimited to CSV
e Video: How to convert CSV to tab delimited

2.5.10 vCard format

Easy Data Transform can input from and output to vCard format files. Default file extension
"vcf".

VCard format is commonly used as way of exchanging contact details between programs.
Note that you need to change the column header names to the values expected by vCard

(using the Rename Cols transform). For example vCard expects the full name column to be
named FN.

Choose an appropriate text encoding. You should probably uncheck Byte Order Mark if
you are encoding in a UTF format, such as UTF-8.

For example:
N FN ORG TELTYPE=WORK\VOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest; ;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States
of America

END:VCARD

See also:
e Video: How to convert CSV to vCard
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2.5.11 XML format

Easy Data Transform can input from and output to XML format files. Default file extension

xml'.

XML (Extensible Markup Language) format is commonly used for exchanging data between

programs.
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>

The dot ('.") character is used in the column header to show nesting. For example:
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name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Note that the columns may be input in a different order to the nodes in the XML. You can
use Reorder Cols or Stack transforms to change the ordering. But note that during XML
output nodes with no children are always ordered before nodes with children, regardless of
the column order.

Any dots in XML element names are converted to hyphens ('-') on input.

The underscore ('_") character is used at the start of a column header name to identify it as
an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip"
protein="1" sodium="210">
<minerals>
<ca>0</ca>
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<fe>0</fe>
</minerals>
<vitamins>

<a>0</a>

<c>0</c>
</vitamins>

</record>
</root>

Repeated XML values can be input in either long or wide Format. For example:

<?xml version="1.0" encoding="UTF-8"7?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="b" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):
PARAM. name PARAM. value

1b 2

2a 1

Input as Wide (more columns):

PARAM._ _value PARAM._name PARAM._value.l PARAM._name.l
11 a 2 b

You can set the names for the root and record tags and add extra XML below the root:

<?xml version="1.0" encoding="UTF-8"?2>
<!-- File created by Easy Data Transform
j[<root>
<extral>extral</extral>
<extraZ>extra2</extraZ>
<record>
<v>l</v>
</record>
<record>
<v>2</v>
- </record>
</root>

Root name: root

<extral>extral</extral>
<extra2>extra2 </extra2>

Below root:

Row name: record

Use " if you need nested tags:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

<?xml version="1.0" encoding="UTF-8"72>
<!-- File created by Easy Data Transform
<rootl>
<extralrextral</extral:>
<extraZ>extral</extra2>
<root2>
Root name: rootl.root2 } <recordl>
. <record2>
<extral>extral</extral> } <ysl</v>
<extra?2 >extral</extra2 > _” </record2>
. </recordl>
Row name:  record1.record2 i <recordl>
<record2>
<V>2< />
</record2>
</recordl>
</rooti>
</rootl>

Below root:

Exclamation marks at the start of column names are removed from name tags when output
to XML. This can be useful when you want duplicate tag names with the same parent.

<root>
<family>
<name>Smith</name>
<member>
- <name>John Smith</name>
1Smith John Smith Jane Smith Bob Smith <name>Jane Smith</name>
<name>Bob Smith</name>
</member>
</family>
</root>

name member . name member.name member.name

<root>
<family>
<name>Smith</name>
<member:>
<name>John Smith</name>

</member>
name member.name mnernber .name M' ember.name <member>

q .
1 Smith John Smith Jane Smith Bob Smith <name>Jane Smith</name>

</member>
<member>
<name>Bob Smith</name:>
</member>
</family>
</root>

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).

If you need really fine grained control over the XML output, you can:
e output the XML to a file

e read the file back in as plain text

e apply transforms

e write it back out as plain text
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output.xml o d e .

@ Output to file. I

Output to:  Single file v

File: C:\Users\andy\Desktop\output.xml

Type: Plain text * |
See also:

e Video: How to convert CSV to XML
¢ Video: How to convert Excel to XML
¢ Video: How to convert XML to CSV
¢ Video: How to convert XML to Excel

2.5.12 YAML format

Easy Data Transform can output to YAML format files. Default file extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:
| CategorylD CategoryMName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2
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CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

See also:
e Video: How to convert Excel to YAML

2.6 Processing

You can run processing of your data in one of two modes:
e Automatic mode: Processing is run automatically as soon as you have stopped making
changes for the amount of time specified in the Preferences window.

€ Easy Data Transform v1.33

e Manual mode: You control when processing is run.

€ Easy Data Transform v1.33.1 (licens
File Edit Run View Licensing Hel

DE}E&D >) O

You can switch between modes by toggling Run>Auto Run, or the equivalent tool bar
button.

Typically automatic mode is better for small to medium datasets, but manual mode may be
a better choice for large datasets.

There are 3 options for running processing in manual mode:

¢ Run>Run Unprocessed: Run processing on any items that are not already processed.
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¢ Run>Run Selected: Run processing on one or more selected items, even if they are
already processed. Any upstream or downstream items are also processed.

¢ Run>Run All: Run processing on all items, even if they are already processed. This is
provided for completeness, but you should usually use one of the above 2 options, for
efficiency.

€ Easy Data Transform v1.33.1 (licensed to Oryx Digital Ltd)
 Eile Edit m View Licensing Help

hEm] $x Auto Run :
v I > Run Unprocessed Ctrl+R
(>) Run Selected Ctrl+Shift+R
From
Run All F5
From Cl| _ )
L] Stop Run Ctrl+\

You can also click the Run button in the Right pane, which is equivalent to Run>Run
Selected. Note that Run, for a clipboard input, applies the options to data previously
imported. If you want to re-import from the clipboard in automatic mode, then you have to
click the Import from clipboard button.

Check View>Timing Profile to see where the processing time is being spent. The length of
the colored bar is proportional to the fraction of total processing spent processing that item.

(|

10k.csv
/]
14 cols x 10k rows
0 I | I |
Stack Filter Sort output.csv
0 9 —e P
i4 cols x 1 10k nows 14 cols x81.5k rows 14 cols x 81.5k rows 14 cols x 81.5k rows
I
100k.csv
/]

14 cols x 100k rows

You can stop processing with Run>Stop Run, or the equivalent tool bar button. If you stop
processing in automatic mode it will switch to manual mode.
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When an item is processed, all it's upstream items will be processed first. You can only
change the options for an item in the Right pane if all it's upstream inputs and transforms
are processed.

2.7 Comments

You can manage the complexity of large .transform files adding comment text to:

e The Comment field of Note items. These are added to the center pane by right clicking
and selecting Note from the menu. You can also set an Arrow direction and a Color. If
you right click on an existing item, the Note item will be placed pointing to that item, if
there is space. The comment will be shown as a tooltip when you hover over the Note
item.

Deaths by
date

4 Spread

Vi ol w0

Latest w,'ftﬂ”,h'.',’[;_';','_'r'lﬁ 2 ,Remave Cols , Pivet , sort , Count s Sort | Death
COVID data 2z e 2 ewen 30w o 99 s 2w | frequencies

 Dedupe . Join |  Replace b

6 ,  Filter ,Num Format J&utput.xlsx) Deaths by
| | PSR- l ¢ i w133 e | ¢ i 155 e

country

& estex 209 row

Scale to per
10k

8 cxin m 209 rew
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| output.xlsx '
—v
! ﬁmlsxﬁllEEluws

Select items in the center pane
to view

e The Comment tab of Input, Transform or Output items. Check View>Show Comments
to show these comments in the center pane. The comment will be shown as a tooltip
when you hover over the item.

Data  Warnings Info Comment*

Sum total COVID cases.

Stats

Sum total COVID cases.
11 cols x 14.7k rows

Name: Stats

Size: 11 cols x 14.7k 3
Transform type: Analysis

Result: Sum row a

Comment: Sum total COVID cases.

[

¢ In the Notes window that is displayed when you select File>Notes... from the main
menu.
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You can also visually group related items in the center pane to show that they are related.

2.8 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.

vaccination.csv @ Qﬂ Eg
File: ndy\Desktop\vaccination.csv ...
Type: Delimited text v
Delimiter: Automatic .4
Quoting: Automatic v
Encoding: Automatic v

a

Ignore:  First 0 row(s)

v has header

rnm whnitespace

v simplify whitespace

v ignore empty rows

watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Conr < 0

3 cols x 5,780 rows
C E% f © Show first 10 rows ~

Guntry time bcg_vacD

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

You can move 1 or more dataset rows to the header using the Header transform.
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2.9 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.

transactions.x... | Filter
—n

35cols x 53.3k rows L} 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

e Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.
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/" COVID-19-ge..
‘\/[COVID-lQ-ge...

11 cols x 14.7k rows 11 cols x 14.7k rows

Dedupe

To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

transactions.x...

35 cols x 53.3k rows lick to connect from this item.

e Hover over the end item
e Click the '+' that appears.

transactions.x...

35 cols x 53.3k rows lick to connect to this item.

Press the 'Esc' key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.
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2.10 Text
Whitespace (such as Space and Tab characters) and case are always significant, unless

stated otherwise.

You can remove leading and trailing whitespace by checking trim whitespace in the Input
or using the Whitespace transform.

You can change the case using the Case transform.

You can concatenate and split columns of text using the Concat Cols and Split Col
transforms.

2.11 Dates

Set Supported Date Formats in the Preferences window according to how you want to
interpret values as dates.

Format Meaning

d The day as number without a leading zero
(1to 31)

dd The day as number with a leading zero (01
to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

dddd The long localized day name (e.g. '‘Monday"
to 'Sunday'). Uses the locale to localize the
name.

M The month as number without a leading

zero (1to 12).

MM The month as number with a leading zero
(01to 12)

MMM The abbreviated localized month name (e.g.
'Jan' to 'Dec'). Uses the locale to localize the
name.

MMMM The long localized month name (e.g.

‘January' to 'December’). Uses the locale to
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Format Meaning

localize the name.

Yy The year as two digit number (00 to 99).
YYYY The year as four digit number. If the year is
negative, a minus sign is prepended in
addition.
For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.

Dates with only two year digits, are treated as a date between 1900 and 1999. E.g. "31/1/19"
is interpreted in d-M-yy format as 31st January 1919.

Add today date to a dataset using input file meta information or using the Stamp transform.

Values that are in a recognized date format will be treated as dates in transforms such as:
Calculate, Compare, Filter, If and Sort. Supporting large numbers of date formats will slow
down these transforms.

Change the format of dates using the DateTime Format transform.

Do date calculations, such as calculating the number of days between 2 dates, using the
Calculate or Javascript transform.

Convert between ISO standard datetimes and milliseconds since 1st Jan 1970 using the
Calculate transform.

Convert an ISO standard datetimes (e.g. 2020-10-16T01:51) into separate date and time
columns by using the Split Cols transform on the "T" delimiter.

Add missing dates in a sequence using Sequence.
2.12 Numbers

Set the locale according to how you want to interpret values as numbers. For example, if
locale is set to US or UK then "123.45" is a number and "123,45" isn't, and vice versa if locale
is Germany or France.
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An integer is a whole number. E.g. "1.0" or "1,0" (depending on your locale), "0", "-1" and
"1e3" are considered integers.

Numeric calculations are accurate to approximately 16 digits of precision. This means that
Easy Data Transform may consider 12345678901234567 and 12345678901234568 to be

equal, for example using the = operator in a Filter transform.

"NaN" means 'not a number'. It can be returned by some calculations, for example using
Calculate to raise 1000 to the power 1000 will overflow numerically and return "NaN".

Change the format of numbers using the Num Format transform.
Change the base of integers using the Num Base transform.

Do numeric calculations, such as multiplying 2 columns, using the Calculate or Javascript
transforms.

Add missing integers in a sequence using Sequence.

2.13 Booleans

A boolean value can be true or false.

Canonical value Allowed values Examples

true true (case insensitive) ora true

. TRUE
non-zero numeric value
True

1
1.0
-1
0.1
999

false false (case insensitive) ora false

. FALSE
zero numeric value
False

0
0.0

2.14 Locale

You can set the Locale in the Preferences window.
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Locale: English

¥  United States ¥ | Default

The locale language and country setting affects how some numbers and dates are
interpreted and displayed. Consequently it may have an affect on some transforms, for
example the DateTime format and Num format transforms.

This shows using the DateTime format transform with Format to set to ddd MMMM d

yyyy for different locales:

Locale

English/United States
English/United Kingdom
German/Germany
French/France
Spanish/Spain
ITtalian/Italy
Portuguese/Portugal
Chinese/China

Japanese/Japan

Output

Mon May 21 2001

Mon May 21 2001

Mo. Mai 21 2001

lun. mai 21 2001
lun. mayo 21 2001
lun maggio 21 2001
segunda maio 21 2001
F— &A 21 2001

A s5A 21 2001

You will be warned if you File>Open a .transform file with a different locale to the one you

have set.

2.15 Meta Information

You can add meta information to input data using the Meta info field in the Right pane

when you select an input item.
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10k.csv i (te | = vEe
@ Input from file.
File: DAEDT data\CSWV\10k.csv

Ignore: . .wrow(s)
€ Meta Information X
[ $(FilePath) ${CurrentDateTime]|l Clear

Insert: <select>

OK Cancel = Help

™

Meta info: At start

Alias: 10k

Data Characters Warnings @ Info Comment Details

14 cols x 10,001 rows @) Read
MEBZOHEY | <[>T ][L

Fregien C 4
1 D:\EDT data\CSV\1l0k.csv 2022-12-05T09:30:29 ]

Set it to At start, At end or Every row, depending on where you want the meta information
to appear. Then click on the ... button to edit which information you wish to show. The
following placeholders are substituted by their actual values at the time of input.

Meta Information Description Example

$ (ComputerName) The name of the computer. MyComputer

§$ (CurrentDate) The current date, in ISO 2020-08-18
format.
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Meta Information

S (CurrentDateTime)

S (DataColumns)

$ (DataRows)

S (DataValues)

S (FileCreatedDate)

S(FileCreatedDateTim

e)

S (FileName)

S (FilePath)

S (FileSheetName)

S(FileSizeBytes)

$ (FileUpdatedDate)

S (FileUpdatedDateTim
e)

Description

The current datetime, in ISO
format.

The number of columns in
the dataset (not including
meta data).

The number of row in the
dataset (not including meta
data).

The number of columns x
rows in the dataset (not
including meta data).

The date the file was
created, in ISO format. Only
available for file input.

The datetime the file was
created, in ISO format. Only
available for file input.

The name of the file,
including it's extension. Only
available for file input.

The full path (location) of
the file. Only available for
file input.

The name of the sheet. Only
available for Excel files.

The size of the file in bytes.
Only available for file input.

The date the file was last
updated, in ISO format. Only
available for file input.

The datetime the file was
last updated, in ISO format.
Only available for file input.

Example

2020-08-18T18:00:00

10,000

100,000

2020-08-18

2020-08-18T18:00:00

myfile.csv

Cs
\users\andy\Document
s\myfile.csv

Sheetl

1,234,567

2020-08-18

2020-08-18T18:00:00
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Meta Information Description Example

S (UserName) The name of the user (from Andy
the USER or USERNAME
environment variable).

See also:
e Stamp
2.16 Column variables

Transforms such as If, Filter, Insert, Replace and Substitute allow you to use the values of
columns on the same row using column variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or
e By column index, e.g. $ (1) for the first column.

Notes:

e The column name is case sensitive. E.g. column 'A' is referenced by variable s (a) and
column 'a' is referenced by variable $ (a).

e Whitespace at the start or end of the column name is ignored. E.g. column " A" is
referenced by variable $ ().

e Whitespace within the column variable is important. E.g. column 'AB' is not referenced by
variables $ (A B), $ (AB) $( AB) or$ (AB ).

e If multiple columns have the same name, the first column from the left with that name will
be used.

e Reference by name takes priority over reference by index. For example, if there is a
column named "1" then $ (1) will refer to that rather than the first column.

e Column variables are replaced as text. For example if column 'A' has value 2" and column
'‘B' has value '3', then $ (2) *$ (B) evaluates as '2*3' (not '6").

e Column names can contain $, ( and ) characters. For example:
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If

Mew column name: Value
@ESEIF  Panp ™ 4 ®
Logic Column

1I1F currency
2 THEN= $3(value($))

3 ELSE= £%(value(f))
V' case sensitive
Data Characters Warnings

5 cols x 2 rows

BB eHEY

o

@ Create a new column with values conditional on other columns.

Op. Value
¥ l|= ¥ |USD
Info Comment Details

@) 1 match(es) IF/ELSE IF, 1 match(es) ELSE

<22

KA
[T |

N

transaction currency value($) wvalue(f£) Value
1 2634543 USD 34232.33 $34232.33
2 9233663 GBP £2022.94 £62022.94

2.17 Regular expressions

Easy Data Transform allows the use of regular expressions in the Compare, Extract, Filter, If,
Replace, Slice, Split Col and Split Rows transforms. It is also available as part of the Javascript
language in the Javascript transform.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match Type
1 Regex

With
\2, \1

Replace
¥ Aw+)\s*(w+)

Turns:
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Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:
Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.reqgular-expressions.info and regexr.com.

2.18 Fuzzy matching

Easy Data Transform supports the use of fuzzy matching in various transforms, including the
Cluster, Dedupe, If, Filter and Lookup transforms.

Fuzzy matching allows you to match 2 values that are similar, but not identical. For example
if you set fuzzy match closeness to 80% then 2 values that are 80% the same or better are
considered a match.

For example, doing a fuzzy match to this value:

100 avenue street, townsville, ohio

Gives:

Value Fuzzy closeness
100 avenue street, townsville, 100%

ohio

100 avnue street, townsville, 98%

ohio
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Value Fuzzy closeness
100 avenue street townsville 95%

ohio

100 avenue st., townsville, 89%

ohio

100 avenue st, townsville 72%

100 av. st., citysville, texas 52%
townsville, ohio 46%

742 evergreen terrace, 36%
springfield, oregon

Fuzzy matching treats everything as a string and takes account of whitespace. It can
optionally take account of case.

Fuzzy matching is significantly slower than exact matching. The closeness score is based on
Levenshtein distance.

2.19 Drilldown

If you check allow drilldown for a transform, double-clicking a cell in the Right pane data
table shows the rows in the upstream dataset that this cell/row was derived from. For
example you can double-click a cell in a pivot table to drilldown into the rows it was
calculated from:
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Pivot

Columns: Match type
Rows: Added/Excluded
Values: Clicks
Summarize by: Sum

Set non-calculated: Zero

Vv add totals
Total by: Rows and columns
[ v allow drilldown]
Data Characters ~ Warnings Info  Comment

6 cols x 5 rows

LR elEY

@ Create a pivot table to summarize the selected columns.

Details

R A
KN

& =B

@) Pivot table created
=120 2T LR k) |k

Added/Excluded (Empty) Broad match Exact match Phrase match Grand Sum
1 (Empty) 24913 0 0 0 24913
Zm 0 223 1903 103 2229
3 Excluded 0 / 26 632 0 658

& Drilldown ¥ double-click 0w
50)

Search term Match type Clicks Impr. CTR *

43  |print at home place cards  Broad match Added 5 5100 |}
232 place card Broad match _ 3 89 3.37¢
485 |size of place cards Broad match Added 1 7 14.2¢
544 printable dinner place cards Broad match _ 3 2 150.(v
4 3

The following transforms allow drilldown:

e Count

e Dedupe
e Ngram
e Pivot

e Unique

Easy Data Transform © 2023 Oryx Digital Ltd




Reference

Note that enabling drilldown slows down processing and requires more memory.

See also:
e Video: How to drilldown into data

2.20 Batch processing

To apply the current .transform file to multiple input files/sheets select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.

orders.xIsx
(V) [orders]

14 cols x 830 rows

Alias: output

' 4

Alias: orders

© Join © output.csv

|Alias: customers 24 cols x 830 rows 24 cols x 830 rows

b 1

customers.csv

11 cols x 91 rows

E Batch Process

ut with alias 'customers’
ut with alias ‘customers’
h alias ‘orders’

} is replaced with the file extension of the
e} is replaced with the file stem of the input
is replaced with the file extension of the input

e} and {datetime} are replaced by the processing d
Click 'Hglp' for more details.

time and datetime.

Ad Remove | Clear
Input alias=customers Input alias=orders Output alias=output (Overwrite)
1/C:\Users\andy\batch\customers.csv ... |C\Users\andy\batch\order* xlsx[*] ... -h\out\{orders.fpame}_{orders.sheetl.csv ...
logging Process Stop v make a sodhd on completion
. orders orders
wildcards file name sheet name
V' log results to y\Desktop\batch_log.txt| .. Append ¥ Close Help

Note:

All input and output items must have an alias.

An output item can't have the same alias as another output or input item.
¢ Disconnected input and output items are not shown.

Output items with Write mode=Disabled are not shown.
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Click Add to add a new processing row.
Click Remove to remove the selected processing row(s).
Click Clear to remove all processing rows.

Check clear 'Append’ outputs before first append if you want to clear output files you are
appending to before the first append.

Check log results to if you want to log the results to a text file. Set the file location and set
the write mode to Overwrite or Append. You can use {datetime}, {date} and {time}
in the file location.

In the input column(s) you can use * and ? wildcards for file name stems, file extensions and
Excel sheet names. E.g.:

Input Description

C:\Users\andy\Documents\*.csv All files with extension .csv in the
Documents folder

C:\Users\andy\Documents\d?.csv Al the files with name 'd" plus a single
character in the Documents folder

C: All the sheets in data.xlsx in the Documents
\Users\andy\Documents\data.xlsx folder
[*]
C: All the sheets beginning with 'data’ in all
*
;zf]ers\andy\DocumentS\ -xlsxlda ho yolx files in the Documents folder
Note:

e If there is more than 1 input column on a row that specifies multiple files or sheets, then
an output will be created for each possible permutation of input files/sheets in the row.
E.g. 3 input files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders. Add them as extra rows.

e All the files input to an input item or output from an output item should be the same file
type as the original.
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In the output column(s) you can use the file name variables to dynamically change output
file names based on input file names.

You can write to multiple sheets of an Excel file.

This example shows using a wildcard for the input file name and sheet and file name
variables to set the output file name based on the input file with alias sales:

Input alias=sales Output alias=output (Overwrite)
1/C:\Users\andy\batch\* .xIsx[*] ... C:\Users\andy\batch\output\{sales.fname}.xlsx[{sales.sheet}]

But make sure to set the corresponding output Write mode=Overwrite/Sheet.
Click Process to start processing the rows.
Click Stop to stop processing the rows.

Check make a sound on completion if you want to play a sound when all processing is
finished.

Click Close to close the window.

Note:

e Whether an output file is created, overwritten or appended to depends on the Write
mode of the output item.

e We recommend you output to a different folder than the one the input files are in.

See also:

¢ Video: Batch processing

e Batch processing examples
e Command line arguments

2.21 Command line arguments

Easy Data Transform accepts the following command line arguments:

Argument Description
<file name> The .transform file to open at start-up.
-cli Close the application once any processing on the opened

file is complete.

Easy Data Transform © 2023 Oryx Digital Ltd


https://www.screencast.com/t/P19b5PnWFB

Reference

Argument Description

-log <location> Appends the command line output to the file at
<location>. -cli must also be set.

-file Sets the input or output file with the given alias to the

<alias>=<location> location (path) specified. Input Excel files should include
the sheet name, e.g. file.xlsx[sheet]. Output Excel
files may optionally include a sheet name. The file type
should be the same as the original.

-new_window Don't load the last opened .transform file, even if open
previous file at start-up is checked in Preferences.

-verbose Output additional information to the terminal. Useful for
debugging problems.

This allows you to run Easy Data Transform from the Windows Command Prompt or a .bat
file. For example:

Torun C:\Users\andy\Documents\myfile 1.transform with the output with alias
outputl outputinstead to C: \Users\andy\Documents\datal.csv

"C:\Program Files\EasyDataTransform vl\EasyDataTransform.exe" "C:
\Users\andy\Documents\myfile 1l.transform" -file "outputl=C:
\Users\andy\Documents\datal.csv" -cli -verbose

Torun C:\Users\andy\Documents\myfile2.transform with the input with alias
inputl input instead from sheet sheetl of C:\Users\andy\Documents\data

2.x1lsx:

"C:\Program Files\EasyDataTransform vl\EasyDataTransform.exe" "C:
\Users\andy\Documents\myfile2.transform" -file "inputl=C:
\Users\andy\Documents\data 2.xlsx[sheetl]" -cli -verbose

Use the forfiles command and wildcards to transform multiple files in a folder:

forfiles /p C:\Users\andy\Desktop\cli /m in*.csv /c "cmd /c \"C:
\Program Files\EasyDataTransform vl\EasyDataTransform.exe\" C:
\Users\andy\Desktop\clilcli.transform -file \"cli-in=Q@file\" -
file \"cli-out=out-@fname.csv\" -cli -verbose"

Use the forfiles /s option to recurse into sub-folders.

Use file name variables to dynamically change output file names based on input file names.
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Put quotes (") around any arguments with spaces (as shown in the examples above).

If you are using wildcards, then it is usually a good idea to output to a different folder to the
one that you are inputting from.

Select File>Command Line... to show sample command line text which you can copy and
modify. It will also warn you of potential issues.

To run on a schedule, call the command line interface (or a script file that calls the command
line interface) from a scheduling program, such as Windows Task Scheduler.

See also:
e Batch processing
e Run jobs on a schedule

2.22 File name variables

You can dynamically change the name of an output file based on input file names using file
name variables. For example, if the input file with alias orders has file name
orders dec 2022.csv, then setting the output filename to

output {orders.fname}.csv will write to output orders dec 2022.csv.
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Alias: orders

orders-dec-2...

14 cols x 830 rows

Join output_{orde...
/] — 8
18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2k rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

You can also include dates and times in your output file names.

Output variables Meaning Example

{<input The name of the input file If the input with alias

alias>.fname} being processed with the orders is using file C:
corresponding alias. \Users\andy\Document

s\orders 2020.csv
then {orders. fname} is
replaced with

orders 2020.

{<input alias>.ext}  The extension of the input  If the input with alias
file being processed with the orders is using file C:

corresponding alias. Does \Users\andy\Document
not include the ' s\orders 2020.csv

then {orders.ext} is
replaced with value csv.
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{<input
alias>.sheet}

{<input
alias>.folder}

{<input alias>}

{date}

{time}

{datetime}

Easy Data Transform © 2023 Oryx Digital Ltd

The sheet of the input file
being processed with the
corresponding alias (Excel
only).

The folder (directory) of the
input file being processed
with the corresponding alias.
Does not include the final \.

The name of the input file
(plus an underscore and the
sheet name, if an Excel file)
being processed with the
corresponding alias.

Date processing was carried
out in year_month_day
format.

Time processing was carried
out in
hours_minutes_seconds_milli
seconds format.

Date/Time processing was
carried out in
year_month_day_hours_min

If the input with alias

orders is using file C:
\Users\andy\Document
s\orders 2020.xlsx

with sheet Sheet1 then
{orders.sheet} is
replaced with value Sheet1.

If the input with alias

orders is using file C:
\Users\andy\Document
s\orders 2020.csv

then {orders.folder}

is replaced with C:
\Users\andy\Document

S.

If the input with alias

orders is using file C:
\Users\andy\Document
s\orders 2020.csv

then {orders} is replaced
with value orders 2020.
If the input with alias

orders is using file C:
\Users\andy\Document
s\orders 2020.xlsx

with sheet Sheet1 then
{orders} is replaced with
value
orders 2020 Sheetl.

2020 04 18

15 21 56 599

2020 04 18 15 21 56
599
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utes_seconds_milliseconds
format

{version} The Easy Data Transform vl 390
version number

File name variables can be used for output file names set in the Right pane, in batch
processing or through command line arguments.

2.23 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and
uses Input file MyData.csv in sub-folder MyData (C:
\Users\andy\Documents\Data\MyData.csv).

e mytransform.transformis moved to /Users/Bob/Documents/EDT on a Mac.

e When mytransform. transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e If it can't find that it will look for MyData.csv in sub-folder MyData
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't

recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.
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2.24 Portability

By default Easy Data Transform stores your preferences in the Windows registry. However
you can store your preferences in an easydatatransform.ini file in the same folder as the
Easy Data Transform .exe file. This means you can install Easy Data Transform on a device
without admin access. It also allows you to store everything on a portable device, such as a
USB memory stick. You can even move your portable device between Windows and Mac
computers.

To use Easy Data Transform portably:

e Install Easy Data Transform into an appropriate folder on the portable device. Make sure
you have write permission to the folder. We recommend you install from the zip file
download, rather than the standard Windows installer.

e Start Easy Data Transform.

e Open the Preferences window.

¢ In the General tab set the Store these preferences in field to portable .ini file.

e Click OK.

e You may also wish to copy your .transform files to the portable device.

If you change the folder your portable version is installed in (e.g. you install a new version to
a different folder) you should copy across your easydatatransform.ini file to the new folder.

If you move your portable device from one computer to another (e.g. Windows to Mac) the
path of files may change (e.g. from D: \my usb key\my transform.transform

to /Volumes/my usb_key/my transform.transform). Easy Data Transform will try
to be intelligent about handling these changes of path by:

e storing recent .transform file paths as relative rather than absolute paths

¢ by treating relative .transform paths as relative to the Easy Data Transform .exe file.

It is possible to have Windows and Mac versions of Easy Data Transform on the same device
sharing a single easydatatransform.ini file and common input, output and .transform files.
Just make sure you install the Windows .exe and Mac .app into the same folder. We also
recommend that they are the same version of Easy Data Transform.

For the purposes of licensing, installing to a USB key, or other portable device, counts as
one of your 3 allowed installs.

Note If you install Easy Data Transform Windows .exes or Mac .apps into 2 different folders
and set them to use .ini files, they will each store their preferences in their own .ini file.
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2.25 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data
Transform a lot we suggest you find the time to learn at least some of them. The following
keyboard shortcuts are available for the Windows version of Easy Data Transform:

Key
A

Easy Data Transform © 2023 Oryx Digital Ltd

Shortcut

Ctrl+A

Ctrl+B

Ctrl+C

Ctrl+Shift+C

Ctrl+D

Alt+I
Alt+Shift+I

Ctrl+K

Ctrl+L
Ctrl+N
Ctrl+0O

Ctrl+Shift+0

Alt+0

Ctrl+R
Ctrl+Shift+R
Ctrl+sS

Ctrl+T

Action
Select all in Center pane.

Show the Batch Process
window.

Copy selected data with
header from the Right pane.

Copy selected data without
header from the Right pane.

Duplicate the selected
branch in the Center pane.

Input From File.
Input From Clipboard.

Search transforms by
keyword.

Toggle Log pane.
New .transform file.
Open .transform file.

Show the Open Recent
window.

Output To File.

Run unprocessed items [4].
Run selected items [4].
Save .transform file.

Toggle two screen mode
on/off
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Key Shortcut Action

U Ctrl+U Toggle user interface
between light and dark
themes (if available).

Y Ctrl+Y Redo
7 Ctrl+7Z Undo
Del Del Delete selected item(s) in

Center pane.

Ctrl+, Toggle Timing Profile

on/off.

) Ctrl+, Show Preferences window.

= Ctrl+= Zoom Center pane so all
items fit.

+ Ctril++ Zoom Center pane in.

- Ctrl+- Zoom Center pane out.

\ Ctrl+\ Stop processing.

Left arrow Ctrl+left arrow Move Center pane selection

from item to highest[1] item
that inputs to it.

Alt+Left arrow Move keyboard focus to
Center pane.

Right arrow Ctrl+Right arrow Move Center pane selection
from item to highest[1] item
that it outputs to.

Alt+Right arrow Move keyboard focus to
Right pane.

Up arrow Ctrl+Up arrow Move Center pane selection
from item to highest[1]
sibling[3].

Down arrow Ctrl+Down arrow Move Center pane selection
from item to lowest[2]
sibling[3].
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Key Shortcut Action
1.9 Ctrl+l ... Ctrl+9 Select input item 1 to 9
(based on height in Center
pane).
Ctrl+shift+l ... Select output item 1to 9
Ctrl+Shift+9 (based on height in Center
pane).
F1 Fl Show help.
F5 FS (Re)process all.
F8 F8 Show options and data in
the Right pane.
F9 F9 Show only options in the
Right pane.
F10 F10 Show only data in the Right
pane.
F11 Fll Toggle setting Right pane

item to fullscreen. Only
works if 1 item in Right
pane.

[1] Highest=nearest the top of the Center pane.

[2] Lowest=nearest the bottom of the Center pane.

[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

[4] If Run>Auto Run is unchecked.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that
contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the Space key before you start
typing. You can use the Del or Backspace key to undo letters typed.
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You can quickly change selection in the Center pane using arrow keys with the Ctr1 key.

l Left Arrow l ‘ Up Arrow l

Remove Cols Dedupe

4 cols x 14.7k rows 4 als x 209 rows

Right Arrow

Pivot L/ Sort

2 ls x 210 rows 2 mls x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the shift key and
dragging the canvas.

2.26 Dark mode

Select View>Toggle Ul Theme (or the corresponding status bar button) to swap between
light and dark user interface themes. You can also change the Center color scheme in the
Colors tab of the Preferences window.
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& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - m] x
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3 How do I?

3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add metadata to a dataset

You can add meta data to an input dataset by setting the Meta info field. See meta
information for more information.

10k.csv itz lbEe
@ Input from file.
File: DAEDT data\CSV\10k.csv
— DM / _/— ::...-J

Ignore: . .wrow(s)
€ Meta Information X
[ $(FilePath) ${CurrentDateTime]|l Clear

Insert: <select>

OK Cancel = Help

™

v

Meta info: At start
Alias: 10k

Data Characters Warnings (D Info Comment Details

14 cols x 10,001 rows @) Read
MEZOeHHE Y <[]0 T[]

Fregrierir cC4
1 [ D:\EDT data\Csv\1l0k.csv 2022—12—051’09:30:29]
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3.3 Add missing data values

You can add missing values based on the average (mean), median or mode of non-empty
values in the same column using the Impute transform.

For example you can add missing ages for Titanic passengers based on the average age
supplied for the other passengers:
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Pclass
Sex

v Age

Using: Average

Easy Data Tran§l (@] & All rows

@ Infer values of missing data.

o — 1
E] Q Filter columns

1 of 9 columns selected

Pclass Sex Age SibSp Parch |+ E

21 2male 35 0 0 i
2 2 male 34 0 0 i
:

23 3 female 15 0 0 i
24 1 male 28 0 0 '
25 3 female 8 3 1 i
26 3 female 38 1 5 :
27 3 male 0 0 E
28 1 male 19 3 2 i
225 3 female 0 0 It
30 3 male 0 0 i
=l 1l male 40 0 0 ;

impute FE]

yx Digital Ltd
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See the Impute transform documentation for more details.

See also:

e Video: How to impute missing data
e Replace empty values

¢ Profile a dataset

3.4 Addor remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

vaccination.csv ® E ;
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic h.4
Quoting: Automatic v
Encoding: Automatic v

Ignore:  First O row(s)

v/ has header

rim whitespace
v simplify whitespace

v ignore empty rows

watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Com < |}

3 cols x 5,780 rows
C E% f © Show first 10 rows ¥

Guntr}r time bcg_vacD



https://www.screencast.com/t/7SdpMLNsN1g
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You can also make the first row of your dataset into a header using the Header transform.
3.5 Change a connection

To change a connection see connections.
3.6 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.

vaccination.csv ® E Z
File: ndy\Desktop\vaccination.csv
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encodin v
Ignore:  First O row(s) .

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv ® b
File: \andy\Desktop\output.csv ...
Type: Delimited text v
Delimiter: Comma (,) =
Quoting: As needed v
Line endings: Automatic v
Encoding: v

See also:
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¢ Video: How to change CSV file text encoding

3.7 Clean a dataset

Data is often 'dirty' and needs to be cleaned up before further processing. You can quickly
find unwanted characters by looking in the Characters tab of the Right pane to see what
types of characters occur in which columns.

Data Warnings @Info Comment  Details

Sample: All 29 rows ¥ v/ show bars

SupplierlD CompanyName ContactName ContactTitle Address City Region PostalCode

Uppercase 80 60 61 64 33 95 18
Lowercase 408 293 428 347 185 24

Digit 49 81 124
Dot 9 2 12

Colon

Apostrophe 6 2

Dash 2 1 5 2 2

Forward Slash

Other 3 1

Non-ASClI 2

Space 51 32 32 74 2 7
Leading Space 1

Trailing Space 1

Double Space 1

Note that some of these categories are non-exclusive. For example: a space might be
counted as a space, whitespace and a leading space, and a symbol might also be a non-
ASCII character.

Hover over a cell for more details.
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[} 2
2 Non-ASCII character(s) out of 559 character(s)

sampled from all row(s) in column '‘CompanyName' (0.36% of all).
Examples:

Row 19: New England Seafood Cannery i

You can turn the colored bars off.

Data Characters Warnings @Info i

Sample: All 29 rows ° show bars |

SupplierlD CompanyName

Uppercase 80
Lowercase 408
Digit 49

And you can restrict it to sampling only a subset of rows for improved speed in large
datasets.

Data Characters =~ Warnings (D Info C
Sample: ERUINGITS

v show bars

10,000 rows ountry Item Type
Upperg 100,000 rows 1,252 1,250
All 500,000 rows
Lowercase ) 1,267 7,033

You can use the Characters tab in conjunction with the Replace and Whitespace transforms

to quickly clean your data. Replace can easily remove non-ASCIl, symbols etc by replacing
them with nothing:

Easy Data Transform © 2023 Oryx Digital Ltd



How do I?

Replace d: E Q
® Replace multiple text in the selected column(s).

o — .
IEI Q Filter columns

v Ngme

Customer Id
Product Id

1 of 5 columns selected

® 1T V@ E & X

f—wh Replace With
Text

Exact text
, Regex
Empty
s Warnings Info (|
@) No changes

I 1< < ==AT 1NN

- Punctuation |

Letters

.
a Digits

Symbols Customer Id  Product Id *

I Whitespace C018930 1357

v

4 Currency >

Non-ASCII h

See also:

e Video: How to clean data
¢ Add missing data values
e Profile a dataset
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3.8 Convert to percentages

You can convert to percentages using the Scale transform.
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale tf’ E i

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

J Di-s.pgted

1 of 2 columns selected

4)p

Scale to : 100
Using:  Sum v

Of: All values v

v

ltem Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823




How do I?

3.9 Duplicate a series of transforms

To duplicate multiple items in the center pane (e.g. a sequence of transforms) right click on
the first item and select Duplicate Branch.

solar.xlsx

/7 [data] ./ t‘\.-”

6 cols x 2.8k rows / 7 cols x 2.8k rows 8 cols x 2.8k rows

v " dnta) _I Filter I , Javascript
23 cols x 25.4K rows I 23cols| INPUt ¥
‘—J Transform »

Qutput 3

Javascript Interpolate

Duplicate Branch Ctrl+D

Connect..
Disconnect
Disconnect Upstream
Disconnect Downstream
® Delete Del

}

solar.xlsx
i [data)

6 cols x 2.8k rows

v Javascript Interpolate

M/

ot peier Sur &

7 cols x 2.8k rows 8 cols x 2.8k rows

weather.xlsx
v [data]

23 cols x 25.4k rows

v Filter . v

23 cols x 8.5k rows

script

24 cols x B,

Interpolate

Filter

23 cols x 8.5k rows

Javascript

24 cols x 8.5k rows

3.10 Dedupe a dataset

There are 2 transforms for removing duplicate rows from datasets:
e Dedupe removes duplicate rows, keeping only the first row in each group that it considers
to be duplicates of each other
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e Unique creates a single aggregate row from each group that it considers to be duplicates
of each other

Dedupe is simpler. Unique has more flexibility.
Using Dedupe

To keep only the first row with each Customer Id from this dataset:

Name Customer|ld Productld Cost Date
1 Alice Anderson €C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones |C017?83 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020

To get this dataset:

Name Customer Ild Productld Cost Date
1 Alice Anderson | C018930 13574 29,95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones C017783 96352 19.95 02/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click the Dedupe
transform in the Left pane.
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9dEJ::JupE—E:«:::mn... © Dedupe

5 cols x 5 rows 5 cols x 3 rows

Then check the Customer Id column in the Right pane.

KA
Dedupe o d ¢y

@ Remove duplicate rows by matching values in al...

Explore Duplicates...
IE' Q Filter columns i
'g
Name =
. k
' ':
Customer Id .
v
Product Id .'
Cost ,'
[ TR0 b |'
1 of 5 columns selected :
Matching: Exact v
Vv case sensitive
ignore whitespace

ignore punctuation '

Mode: Remove duplicates v

Only the first row with each Customer Id is kept. Use Sort if you want to change the order
before the Dedupe transform.
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If you only want to remove rows with the same Customer Id and Product Id, check both
the Customer Id and Product Id columns.

If you want to use fuzzy matching to also remove rows that are similar, but not identical, set
Matching to Fuzzy.

To see what rows will be removed and experiment with different options, click the Explore
Duplicates... button.
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€ Explore Duplicates O X
Columns to match: Matching: Exact -
E Q Filter columns .
V' case sensitive
Name =
ignore whitespace
v Customer Id ignore punctuation
Product Id —
4 b
1 of 5 columns selected
> O Found 3 non-duplicates and 2 duplicates in <0.1 seconds
Data Summary
hide unchecked columns hide rows with no duplicates P
Name Customer|ld Productld Cost Date Grou
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Robert Brown C018917 98526 10.00 02/10/2020
4 Charlie Jones C017783 96352 19.95 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020
| >
OK Cancel

Note that Dedupe takes account of whitespace. So you might need a Whitespace transform
before the Dedupe transform.

See also the Dedupe documentation.
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Using Unique

To aggregate all rows with the same Customer Id:

Name Customer |d Productld Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones 017783 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020

To get this dataset with:

e The first Name for that Customer Id

e A comma separated list of Product Ids for that Customer Id
e The total Cost for that Customer Id

e The last Date for that Customer Id

Name Customer Id  Product Id Cost Date
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456,98526 20.55 02/10/2020 |
3 Charlie Jones C017783 96352,28746 44.95 03/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click the Unique
transform in the Left pane (if you can't see Unique, then check show advanced is checked
in the Left pane).
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9

Scols x5 rows 5 cols ¥ 3 rows

dedupe-exam... i
© p Unique

Then set the Unique options as shown below:

Unique Cf} ES

@ Aggregate rows with unique values in selected c...

Column Option
Name Keep first v
Customer Id Keep unique bt
Product Id Concat v
Cost Sum h.4
Date Keep last v
Set All ¥ to Keep uniqgue ~

'Keep unique' for 1 of 5 columns
Concat delimiter: ,

add count column

One aggregated row is created for each Customer Id. Use Sort if you want to change the
order before the Unique transform.

If you only want to create a new aggregate row for rows with the same Customer Id and
Product Id, set both the Customer Id and Product Id columns to Keep unique.

Note that Unique takes account of whitespace. So you might need a Whitespace transform
before the Unique transform.

See also the Unique documentation.
See also:

e Video: How to remove Excel duplicates
¢ Video: How to merge rows in Excel
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3.11 Find the difference between dates/datetimes

You can calculate the number off days difference between two dates using the Calculate
transform. For example:

Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

307/01/2021 8/1/2021

Calculate d} EH Ei
@ Perform calculations on 1 or 2 columns to creat...
Operation: - Subtract v
Value 1: End v
Value 2 type: Column v
Value 2: Start ‘ =

Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

You can convert a datetime into a date using a transform such as Extract.

Alternatively, you can calculate the difference between two dates or datetimes using Date
objects in the Javascript transform.
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There are 4 ways to create a Javascript Date object:

Date format Description

new Date(year, month, day, Specified date and time specified as
hours, minutes, seconds, numeric parameters (January is month 0!).

milliseconds)
new Date (text date) Date and time specified as text.
new Date (milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

e A text date should be in yyyy-MM-dd format.

o A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.

e One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and 'end' columns in hours:

return ( new Date( S(end) ) - new Date( S(start) ) ) / ( 60 * 60
* 1000 );

To calculate how many days ago 'date’ occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) ) / ( 24 ~*
60 * 60 * 1000 ) );

For more information see the Javascript documentation.
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3.12 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with
a different input file each month, via the command line from a script, or as a batch process)
you need to be aware of differences in column name and column order in the input files.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather than disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.qg. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "ID" column in the first
column in input 1 and the last column in input 2) you need to put the input columns into a
standard order before applying other transforms. You can so this using the Stack transform
with Align columns by set to Header name. You can stack your input under a dataset with
just the columns in the correct order (no data rows).
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Stack dj Py

("'}

@ Merge input top of another. Or...
Align columns by: Header name v
ID title first last

Data = Warnings @ Info Comment g
No rows 4 cols x 2 rows @) 2 inputs stacked
‘_ BB F YK =227 1 v

ID title first last

1 001 Mr John Smith
r_ﬁheader-only.csv

2 002 Ms Jane Smith
4 cols x 0 rows ;
Stack
/]

4 wols x 2 rows

input.csv

4 cols x 2 rows

f

. title first last ID
{1Mr John Smith 001

'2Ms Jane Smith 002

Same columns with different names, in a different order

Easy Data Transform can't handle this automatically. But you can create a new .transform
and use Reorder Cols and/or Rename Cols transforms to output to a new file with the
correct column names/ordering. You can then input this to the original .transform.
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3.13 Handle datasets with many columns

Easy Data Transform can help you to easily remove or rename columns in datasets with
large numbers of columns.

Remove multiple empty columns
If your dataset has a large number of empty columns you can remove them by checking
ignore empty columns when you input it.

orders.xlIsx[orders] tf“ E S
@ Input from file.
File: \EDT northwind data\orders.xlsx[orders] ...
Type: Excel XLSX v
A

Ignore: First O row(s)
v has header
v trim whitespace
v simplify whitespace
v ignore empty rows

Q ignore empty columns)

watch file

Remove multiple columns

To quickly remove a large number of columns using the Remove Cols transform, you can do

it by filtering column names. For example, to remove the columns with name that contain

"id™:

e Add a Remove Cols transform.

e Type id into the filter field. All the columns whose names contain "id" should now be
visible (not case sensitive).

e Click the Unselect all button.

e Click the Clear button.

All the columns whose names contain "id" should now be removed by the transform. You

can repeat this process as often as needed.
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3.14
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Remove Cols

OrderID
CustomerlD

EmployeelD

Rename multiple columns

@ Uncheck the column(s) you wish to remove.

ol =z D3¢

To quickly rename a large number of columns using the Rename Cols transform, you can do

it using Replace text:
e Add a Rename Cols transform.
e Click the Replace text button.

e Enter the text you want to Replace and the text you want to replace it With. You can
match as Text, Exact text or Regex, with case sensitive matching optional.

e Click Apply to make the change.
e Click Close.

See also:
e Handle large datasets

Handle large datasets

€ Replace X | Rename Cols o= 03¢
» @ Rename column headers.

Match type: Text ¥ | case sensitive Cu
Replace:  ID Old name New name 3
With- Id rderlD Orderld

CustomerlD Customerld
Preview: Changes applied kEmployeelD Employeel

Close | Apply Ori = Ord e
RequiredDate RequiredDate

Large datasets (e.g. with millions of rows) can slow down processing. If slow processing is a

problem you can:
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e Add a sample transform straight after the input and set Rows to pass through only the
first 100 or so rows. Once you have completed all your transforms you can then Disable
sampling to pass through all rows.

¢ Set Maximum memory usage to a higher value in the Preferences window, to ensure
you don't run out of memory.

¢ Set Optimize processing for to Minimum memory use in the Preferences window, to
reduce memory usage.

e Uncheck Run>Auto Run to give yourself full control over processing.

(<3 Easy Data Transform v1.33.1 (licens
Eile Edit Run View Licensing Hel

DE}E&D >) O

or
e Check Run>Auto Run and:

o Set Right pane processing delay in the Preferences window to a longer time (say 5
seconds) to ensure that changes aren't processed until you have finished making the
changes.

o Set Write mode to Disabled in output files, until you are ready to write them.

You can check View>Timing Profile to see where the processing time is being spent.

|

10k.csv
/]
14 cols x 10k rows
(- ] {— ] " ] |
Stack Filter Sort output.csv
o o T P
14 cols x 110k rows 14 cols x 81.5k rows 14 cols x 81.5k rows 14 cols x 81,5k rows
I
100k.csv
/]
14 cols x 100k rows
See also:

e Handle datasets with many columns
e Processing

3.15 Input a fixed width format file

To input data from a fixed width file see fixed width format.
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3.16 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:

Name 1D DOB
John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Name ID DOB
! Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1£E"|—n Black 001 1966-07-01

2[Paul White 002 1973-03-11

3 wry Green 003 19??—12—_59

4 Jane Brown 004 1980-11-02\

Lol

lil\lTaupe 005 1981—03-[5}

Drag the two dataset files onto the Center pane of Easy Data Transform.
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datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...

3 cols x 2 rows

Select the two datasets using Ctr1+click then click the Stack transform in the Left pane.

datasetl.xlsx[...

3 wlsx Irows

Stack

3 cols x Srows

v

dataset2.xlsx|...

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the vertical positions of the datasets to
change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.
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Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

ID Department Level
651 Engineering 1—\

MName D DOB
lé;m Black 001 1965-(]?&\

=

[t

003 Engineering 2

]

Paul White [802 1973-03-11
3 Barry Green @03 1977-12-30 I 3|004 Marketing 1

Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
Q0 J

ey

1]

IEKJilTaupe 005 1931-[!3:{})

By common ID value to get this dataset:

MName 1D DOB Department Level

1 dg}:n Black GGINIEIEE-D?—G Engineering 1 )

2|Paul White | 002 1973-03-11 Sales 2
3|Barry Green|{ 003 1977-12-3( Engineering 2

4|Jane Brown| 004 1980-11-03 Marketing 1

wTaupe @31981—{13—(}“5&95 3

Drag the two dataset files onto the Center pane of Easy Data Transform.

(¥, ]
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datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...

3 cols x 2 rows

Select the two datasets using Ctr1+click then click the Join transform in the Left pane.

datasetl.xlsx|...

3 cols x5 rows

Join
V4
5 cols x5 rows

dataset2.xlsx|...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.
The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the vertical positions of the datasets to change the order in

which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set include top non-matching rows and include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.
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Note that matching columns takes account of whitespace. So you might need to do
Whitespace transform before the join.

If you are merging numerical datasets you can also use an Interpolate transform.

See also:
¢ Video: How to join Excel files

3.17 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Windows Explorer. You either leave the Input files at the original location or move them
to the same location relative to the .transform file (e.g. if they were in the same folder as the
.transform file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location
relative to the .transform file (e.g. if they were in the same folder as the .transform file

before, move them to the same folder as new .transform file).

See also .transform files.

3.18 Open multiple main windows

To open an additional Easy Data Transform Main window, select File>New Window.
3.19 Output nested JSON or XML

You can use the dot ('.") character in the column header to show nesting. For example:
name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "0O",
"minerals": {

"ca": "0O",

"fe": "O"
b
"protein": "1",
"sodium": "210",
"vitamins": {
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"a": "O",
"C": "O"

And to XML as:

<?xml version="1.0" encoding="UTF-8"7?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:
e JSON format
e XML format

See also:

¢ Video: How to convert CSV to XML
e Video: How to convert CSV to JSON

3.20 Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.
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E Easy Data Transform v1.15.0 (licensed to Cryx Digital Ltd)* - 0O X
Eile Edit View Licensing Help
DBERE v ARG H @  rHowbDol?

- A
Rename Cols (%) Stack (@) - [
Reorder Cols (2 Align columns by: Header name -
7 Merge input datasets one on top of another,
Repl z
prace @ rorders by the vertical positions of the input
Row Num (@ datasets
Sample (@ Data = Wamnings Info  Comm 4 »
Slice @ 3 cols x 10,258 rows
Sort @ BB £ @ showfistiOrows ~
vaccination.csv -
<plit Col @ country time beg vace
Spiit Raws (@) 3 cols x 5.8k rows 1 afg 1982 10
Spread (@ 2 afg 1983 10
Stack C’) Stad( 3 afg 1384 1
Stamp @ 4
o 3 ool x 103k rows 4
I3 5 afg 1986 18
Substitute ()
- 6 afg 1987 27
© vaecination2.csv
Summary (3 7 afg 1988 40
3 mols x 4.5k rows
Total @ g afg 1989 38
Transpose (%) 9 afg 1990 20
Unique @
L 10afg 1991 21
Units &
Whitespace (2 Last 10,248 rows not shown
~  Output

< To File b_

SEmail us questions/feedback

e Select *.xlIsx or *.xls from the file type drop-down list that appears.

File name: | output.csv

Save as type: |CSV file (*.csv)
CSV file (*.csv)

P Excel file* xls)

Note that Excel .xIsx files are typically limited to 1,048,576 rows and 16,384 columns.

See also:

e Write to multiple sheets of an Excel file

Video: How to convert fixed column width to CSV or Excel
Video: How to convert JSON to Excel

Video: How to convert XML to Excel
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3.21 Profile a dataset

In the Right pane you can double click on a column header or click the corresponding
button to show a profile of the data in each column. For example the different data types
(text, numeric etc) and the frequencies of different values. Potential discrepancies (such as
missing values) are highlighted in red.

You can use profiling in conjunction with Filter, Remove Cols and Replace transforms to
remove unwanted rows, columns or values; and with the Impute transform to add missing

values.
Data Characters Warnings @ Info | P
12 cols x 891 rows @ Read
BEVANE [T E ek
€ Column Values O X
Column: Embarked v l&||€ = = sample: All 891 rows
Show: 25 + | Most frequent values ¥ +/ bars v % include dates include statistics
Value Frequency Metric Value -
s 644 [/ 72.28% Empty values 2
C 168 / 18.86% Non-empty values 889
04 Q 77 / 8.64% Numeric values 0
(empty) 2/ 0.22% Integer values 0
Real values 0
Boolean values 0
Text values 889
Distinct wvalues 4
Unigue values 0
Duplicated walues 4
Min length 1
Max length i
Average length 1

For large datasets you might want to set Sample to less than the full dataset for speed. You
can also leave include dates and include statistics unchecked for speed (include dates
checks against every date format listed in Preferences).

See also:
e Video: How to profile data

e Summary
e Add missing data values
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e Clean a dataset
3.22 Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
processing or command line arguments.

Example 1
To convert a folder full of ,json files to .csv files:

1. Select File>New to create a new .transform file.

2. Drag one of the .json files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.

test.json output.csv

V) — 0

6 cols x 155 rows 6 cols x 155 rows

4. Select File>Batch Process.
5. In the Batch Process window change the . json file name to * . json, so that all the
. Json files in that folder will be processed.
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€ Batch Process* P4

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C\Users\andy\Documents\output_{test} {datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias ‘test".

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add Remove | Clear

Input alias=test Output alias=output (Overwrite)
1|C:\Users\andy\Desktop\*Ljson ... \C\Users\andy\Desktop\output_{test}.csv

Process| Stop

Close Help

6. Press the Process button. A . csv file will now be created for each . §son file in the
folder. In the example above the {test} file name variable will be replaced by the file
name of the input file with alias test (if you just output to output.csv then you
would be continually overwriting the same file).

7. Select File>Save to save your .transform for future use.

If you want to process input files from another folder then click Add to add a new row and
change the input folder.

Example 2
To merge multiple .csv files into a single .csv file:

8. Select File>New to create a new .transform file.

9. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

10.Click on the To File button at the bottom of the Left pane and set the location of a
merged. csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.
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© test.csv amerged.csv

14 cols x 10k rows 14 cols x 10k rows

4. In the Right pane set Write Mode to Append and check write header and if empty.
This ensures that only one header will be written, rather than one for every input file.

merged.csv 0& EG

@ Output to file.

File: C:\Users\andy\Desktop\merged.csv

Type: Delimited text v

Delimiter: Comma (,) v

Quoting: As needed M

Line endings: Automatic v

Encoding:  UTF-8 v
v o

Write modg¢: Append v
v write header v if file empty

Alias: merge

5. Select File>Batch Process.

6. In the Batch Process window:

e change the input .csv file name to * . csv, so that all the . csv files in that folder will be
processed.

e Check clear 'Append’ outputs before first append so that any existing data in the
output file is cleared before Easy Data Transform start appending to it.
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€ 5o

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C\Users\andy\Documents\output_{test} {datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias ‘test".

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add = Remove | Clear | ¥ clear 'Append' outputs before first append

Input alias=test Output alias=merged (Append)
1/C:\Users\andy\Desktop\*.csv ... C\Users\andy\Desktop\merged.csv

Process| Stop

Close Help

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other . csv files.
8. Select File>Save to save your .transform for future use.

If the headers are different orders in different .csv files, then you can Stack by header name
in your .transform to get a consistent column order before outputting.
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cols-in-order....

14 cols x 1 row

o Stack emerged.csv

28 cols x 10k rows 28 cols x 10k rows

o test.csv

14 cols x 10k rows

Stack r;f: E C

@ Merge input datasets one on top of another. Or...

Align columns by{ Header name v
See also:

¢ Video: Batch processing

3.23 Replace empty values

You can replace empty values using the Replace transform.
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| nt nZ n3

1 123.8 9876.1

2981234 23.3
3 288
Replace OF Eg

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

nt

4

v "

JI"IE

3 of 3 columns selected |
® 1T L ®EE&E X |

Match Type Replace With
1 Empty v 0.0

- I
v case sensitive

y

ni n2 n3

11 123.8 9876.1 0.0

2981234 00 233

3 288 00 00
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See also:
¢ Add missing data values

3.24 Run jobs on a schedule

Easy Data Transform doesn't currently have it's own scheduler. However you can run jobs
on a schedule (e.g. at 5pm every day) by using pretty much any scheduler to call the Easy
Data Transform command line interface:

1. Create the .transform file that details the transformations you want to carry out.
2. Call Easy Data Transform command line interface (or a script that calls the command line
interface) from your scheduler.

You can use Task Scheduler, which is part of Windows. Or you can use any number of third
party scheduler applications .
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@.
File Action View Help
&= = o:

@ Task Scheduler (Local)
@ Task Scheduler Library

Name Status Triggers

(® Daily transform Ready At 17:00 every day

A - . e R - P r

General Triggers Actions Conditions Settings History (disabled)

When you create a task, you must specify the action that will occur when your task starts.

ion Details
rt a program "C\Program Files\EasyDataTransform_1_37_1\EasyDataTransform_1_37_1.

Edit Action X

You must specify what action this task will perform.,

Action: Start a program v

Settings

Program/script:

"C\Program Files\EasyDataTransform_1_37_1\EasyDataTran Browse...

/ Add arguments (optional): _C:\Users\andy\Desktop\SI
Easy Data Transform command line arguments e.g.:
.exe file location C:\Users\andy\Desktop\scheduleldaily.transform -cli

You can change the input and output file names through the command line interface. Add
-cli to close Easy Data Transform after the job is finished.

Some schedulers will also allow you to call Easy Data Transform on an event, e.g. when a file
is added to or updated in a particular folder.

3.25 Scrape web data

You can scrape data from a web browser by selecting it and dragging into the Center pane
of Easy Data Transform (or copying and clicking From Clipboard).
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o Select data in web a browser

ohnson & Johnso 181.54] -0.99%
208.17]

Mastercard Incorporated 351.18

ICICHEE
#ERAY
;

Chevron Corporatio 160.95)

e Drag onto Easy Data Transform
B Easy Data Transform v1.27.0 (licensed to Oryx Digital Ltd)*

DBRE wo OQARKXAQH ® | *HowDoI?
i Input
From File ®
From Clipboard ®

JNJ
v Visa Inc.
MA Mastercard Incorporated

CVX Chevron Corporation

BAC Bank of America Corporation

e Drop

€ Easy Data Transform v1.27.0 (licensed to Oryx Digital Ltd)*
_ File Edit View Licensing Help

DBERE v OQARQH ® | *HowDol?

¥
! -~

v Input

Easy Data Transform From File @ Digital Ltd
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See also:
e Video: How to scrape web data

3.26 See changes from a transform

The following transforms allow you to highlight changes made by the transform:
o Case

Chop

e DateTime Format

e Decode

Number Format

e Offset

e Pad

e Replace

e Scale
Unfill
Units

e Whitespace

Check the compare changes checkbox below the data table to highlight changes made by
the transform.
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Data = Warnings Info Comment i

3 cols x 4 rows @) 2 changed, 10 unchanged
[ B @Vl &< == T 1L

First Last Gender
1/ Andy M

2 Claire Green F

, detail of
,3 White M selected change

4 Emma Black F

?]compare changes - T ‘john'->'John'

oo U

next/previous change
change color

Click on or hover over a cell to see details of each change.

Click on the up and down arrows to move between changes. Changes hidden by dataset
filtering are skipped.

If you want to see rows that were removed by a transform such as Dedupe, Unique or Filter,
you can do that using Subtract. The dataset needs to have a column of unique key values to
use in the Subtract. If it doesn't have one, then add one first using Row Num.
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~ orders.csv o Row Num & Subtract

14 cols X 913 rows 15 cols x 913 rows \ 15 cols x 83 rows
Dedupe
9

15 cols x 830 rows

Subtract ff} B D C!
@ Remove rows from the top dataset whose key val... |
Top key column: Row Num v
Bottom key column: Row Num )4

v/ case sensitive

3.27 Set output file name from input file

To set an output file name based on the name of one or more input files, see File name
variables.
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Alias: orders

orders-dec-2...

14 cols x 830 rows

Join output_{orde...
(/] —
18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2k rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

3.28 Show whitespace

Click the eye icon in the Right pane to show whitespace in the data.
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Data = Warnings @ Info  Comment < »

2 cols x 3 @) Read
DOJE "Y1 A L |
A

Press to show whitespace in the dataset as symbols:
1 =1 [Space:

5| o Tab: -
Carriage return: -
3 .3. [|Line feed: o

Non-breaking space: r
Other whitespace: o

3.29 Split a dataset into multiple files

Easy Data Transform supports splitting datasets into multiple files in 2 different ways.

Example 1: Simple splitting

To split a dataset according to whether the Gender column contains M or F, use a pair of
Filter transforms.
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= KA
Filter CP B
@ Filter rows by text, date or numeric values in sel...

@ @ Eé} é% X | |Keep ¥ | Matching any

Column Op. Value
1 Gender ¥|= ¥ |M
Filter male_employ...
/] — O
19 cols x 10 rows 19 cols x 10 rows
employees.csv
19 cols x 18 rows
Filter female_empl...
(/] — O
19 cols x 8 rows 19 cols x 8 rows

Filter o il == [0
@ Filter rows by text, date or numeric values in sel...

® X B &l X |Keep ¥  Matching any

Column Op. Value
1 Gender ¥|= Y|F

Example 2: Split according to row values

To split a dataset according to Region column values:

e Use transforms (such as Substitute) to create a column with the file location you want to
output to, based on the Region column. The location can be an absolute path (e.g. c:
\users\andy\output.csv) or a path relative to the .transform file location (e.qg.
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results\output.csv). Folders output to must already exist. Empty or invalid values
are ignored. This column is not output (use the Copy Cols transform if you want it to be).
e Create an output with Output to set to Multiple files and the Files column selected.
¢ Set Confirm files checked to be prompted before writing (recommended).
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Name Region

1John Smith  North

2 Jane Green West

Multiple files FEcl
@ Output to fi
Output to: | Multiple files v
Files columr: Region file S

v
Type: Delimited text v
RN SN WYY YYYS.

Confirm files:

>

e Lo 3

@ Info

Data =~ Warnings Comment < »

3 cols x 5 rows @) Written
CB s O E Ykl = =>IF 1L
Name Region

North

Region file

1 John Smith North_staff.csv

2 Jane Green West West_staff.csv

sales_staff.csv

2 wls x 5 rows

Easy Data Transform

}

Substitute
_’0

3 cols x 5 rows

1

3 Brad White South 3 Brad White South  South_staff.csv
4 Faisal Ali East 4 Faisal Ali East East_staff.csv
5 Jill Black North 5 Jill Black North  North_staff.csv

!

3 cols x 5 rows

RBZ e F Yk <> =TV

Name Region Region file

1John Smith  North  North_staff.csv

2 Jane Green West West_staff.csv

3 Brad White South  South_staff.csv
4 Faisal Ali East East_staff.csv
5 Jill Black North  North_staff.csv

S KA
Substitute FE

® Substitute column values into text.

New column name: Region file

Substitution script:

$(Region)_staff. csv|

Insert variable: <select> ¥  Evaluate
Data ~ Warnings Info ~ Comment | P

3 cols x 5 rows 0 5 evaluated

E? East_staff.csv
P Multiple files — Er: North_staff.csv

E South_staff.csv

E? West_staff.csv
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Example 3: Split by size

To split a dataset into files of 1000 rows each:

Multiple files FELI
@ Output to file.
Output to:  Multiple files

4

4

Files column: File name
Confirm files: V

Row Num Ou E DS

@ Add a new column with the row number.

. Type: Excel XLSX b
Start at: 1 - . =
Formatting: Automatic ~
~ : i split-1.xI
Increment 1 hd Write mode: Overwrite ¥ Sheet v sphit-1.xisx
- 1Y .
Every: 1000 = ] write header [ split-2.xlsx
1Y .
\ & split-3.xlsx
) .
o split-4.xlsx
: i Multiple files 5 oenli
o L10k.csv @ Row Num o Substitute ° p : B split-5.xlsx
14 cols x 10k rows 15 cols x 10k rows 16 cols x 10k rows 16 cols x 10k rows E.t 5p|it-5.X|SX
) .
E split-7.xlsx
) .
E split-8.xlsx
) a )
Substitute FEl B split-9.xlsx
o .
(?) substitute column values into text. E split-10.xlsx
New column name: File name
Substitution script:
outputi\split-$(Row Num).xlsx
See also:

e Video: How to split CSV into multiple files

3.30 Trigger an update when an input changes

Check watch file in the Right pane for an input file if you want to trigger processing
(Run>Auto Run checked) or set it to 'Needs update' (Run>Auto Run unchecked)
whenever the input file changes.
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100k.csv %a| | BB :-i

@ Input from file.
File: D:EDT data\CSV\100k.csv

— R~~~}

ignore empty .. .nns

[ v watch file ]

Note:

e If you are also outputting to this file in the same .transform you are inputting it, it may
cause the .transform to run forever.

e The update may not be triggered if the file is deleted and replaced with a new file with
the same name.

3.31 Use Easy Data Transform from a USB key

See Portability.
3.32 Visualize data

Currently Easy Data Transform does not support charting beyond data profiling. However it
can easily integrate with other tools that do. For example. by outputting a CSV for import
into the visualization tool, or copying and pasting via system clipboard.

For example, you can copy and paste data direct from Easy Data Transform to rawgraphs.io:
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€ cory

Data = Chara Warnings  Info  Comment  Details
2 cols x \
B(®]7 omE Y

countriesAndTerritories deaths per 10k
1 Ecuador 0.18
2 United_ Kingdom 0.09
3 Italy 0.08
4 Spain 0.06
5 Netherlands 0.05
; & C @ O 8 https://app rawgraphs.io

RAWGraphs 2.0 beta

! e Paste
|
I

1. Load your data \

(7] Paste your data

I Upload your data
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2. Choose a chart
o Choose chart type

Show Allcharts -

Correlations, proportions ~ ffreRR Networks Correlations

Alluvial Diagram Arc Diagram { I Bar chart
[ |

Multi-set bar chart
Correlations, proportions

Stacked bar chart

Correlations, proportions

Beeswarm plot
Distributions, time series,

Bar chart sinm "+ proportions
3. Mapping o Choose columns
DIMENSIONS CHART VARIABLES

Aa countriesAndTerritories Bars k Size Color

_ Aa countriesAndTerritories X # deathspe.. Sum ~ X Aa cC.. CSV (unique) - X

# deaths per 10k

4, Customize e Customize
ARTBOARD +
Belgium
CHART - Srazi
Canada
Padding 1 <
Denmark
Bars orientation Horizontally # Dominican_Republic
Ecuador -
Sort bars by Name E
France -
SERIES + Haly
Netherlands —
COLORS -
Panama -
Color scale Ordinal - Peru ]
Portugal -
Color scheme | . -
Romania -
Belgium W #9E0142 Spain -
Brazil B #8E2449 Sweden
Switzerland
Canada B #D84548
United_Kingdom
Denmark W #EB6349 United_States_of America
deaths per 10k [sum]
Dominican_Repub... [l #F68550 000 ote ote ot oz ot ol ot
See also:

¢ Video: How to visualize data with rawgraphs.io

Easy Data Transform © 2023 Oryx Digital Ltd



https://www.screencast.com/t/YSjp8vaMc2

How do I?

3.33 Write to multiple sheets of an Excel file

To write to multiple sheets (tabs) of the same Excel file you need to set the Write mode of
each output item to Overwrite/Sheet (to clear the sheet first) or Append (to add to
existing sheet data).

RA
customer.xlsx[records] ‘@ d} €N

File: »phcustomer.xisx[records] ...

Format as: Number/Bool/Date/Text ¥

@e mode: Overwrite ¥ Shea) v

}

customer.xlsx

-
™,

customers.csv

11 cols x 91 rows

11 cols x 91 rows

44\/ [records]

Yy

[/ customerxlsx

Summary  [summary]

v

12 cols x 9 rows

12 cols x 9 rows

L

customer.xlsx[summary] l@ d"x

File: \customer xlsx[summary] ...

Format as: Number/Bool/Date/Text ~

rite mode: Overwrite ¥ Sheet v

If you set the Write mode to Overwrite/File for an item then the write will remove existing
sheets.
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Expert tips
4.1 Expert tips

Here are some tips to help you be more productive with Easy Data Transform.

1. To add a transform click an existing Center pane item and type the first few letters of the
transform name.

[ COVID-19-geo...
v [COVID-19-ge...

11 cols x :{Ex.?k FrOwWs

2. Check the show advanced checkbox in the Left pane to see all available transforms.

3. Uncheck Run>Auto Run to take full control of when items are processed.

€ Easy Data Transform v1.33.1 (licens
Eile Edit Run View Licensing Hel

DBGBE(e ® o

4. Hold down the shift key and drag on the Center pane to scroll left/right/up/down.
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Y Dedupe

{rows 18 cols x 830 rows

Press SR

v

\\\
\\-_

tax-rates.csv

11 cols x 70 rows

5. Use Note items to remind yourself how a complex .transform works.
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| output.xlsx '
—v
! ﬁmlsxﬁllEEluws

Select items in the center pane
to view

6. Look in the Warnings and Info tabs in the Right pane to troubleshoot potential issues.

Data (L Warnings @ Info Comment Details

Number of values per row vary:
1 input row has 1 value: E.g. input row 1
43 input rows have 5 values: E.g. input row 27

7. To select multiple items in the Center pane, left click with the mouse and drag a box over
the items you want to select.

8. Try to avoid disconnecting transforms, as this can reset column related options
downstream. Add a transform to an existing connection instead. You can also delete a
transform without deleting it's connections.

9. Add a Sample transform straight after the input of a large dataset and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can
then Disable sampling to pass through all rows.

10. Check View>Timing Profile to see where the processing time is being spent.
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|

10k.csv
(/]
14 cols x 10k rows
[ — o ] ] |
Stack Filter Sort output.csv
/] — 8 —8 —0 P
14 cols x 110k mows 14 cols x 81,5k rows 14 cols X 81.5k rows 14 cols x 81.5k rows
[
100k.csv
(/]

14 cols x 100k rows

11. Click the eye icon in the Right pane to show whitespace in the data.

Data = Warnings @ Info  Comment < »

2 cols x 3 @) Read
BJE Y= | =22 T
A

Press to show whitespace in the dataset as symbols:
1 =1 [Space:

ol o Tab: -
Carriage return: -
3 .3. [|Line feed: o

Non-breaking space: +
Other whitespace: o

12. Check compare changes in the Right pane to see changes from a transform (selected
transforms only).
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Data = Warnings Info Comment i

3 cols x 4 rows @) 2 changed, 10 unchanged
[ B @Vl &< == T 1L

First Last Gender
1/ Andy M

2 Claire Green F

, detail of
3 White M selected change

4 Emma Black F

?]compare changes - T ‘john'->'John'

oo U

next/previous change
change color

13. Select a column and click the bars icon in the Right pane to show the frequency of
values. Potential issues are shown in red.
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Data Characters =~ Warnings @ Info 4 ¥
12 cols x 891 rows @ Read
HBZOHHEY K <« 22T 1 VL
€ Column Values O X
Column: Embarked v k& = | sample: All 891 rows
Show: 25 5 Most frequent values ¥ +/ bars v % include dates include statistics
Value Frequency Metric Value =
S 644 [/ |72.28% Empty values 2
c 168 / 18.86% MNon-empty values 889
0¢ Q 77 / 8.64% Numeric values 0
(empty) 2/ 0.22% Integer values 0
Real values 0
Boolean values 0
Text values 889
Distinct values 4
Unique values 0
Duplicated walues 4
Min length 1
Max length i
| 1
Average length 1

14. Enable drilldown to double-click on a cell and see how the information was derived.

15. Filter data in the Right pane.
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Data Warnings
11 cols x 14,658 rows

=7l A

dateRep
1 2020-05-03

2 2020-05-02
3 2020-05-01
4 2020-04-30

5 2020-04-29

Info Comment

Details

0 Reac

<= &[> 120 TN

day month year

3 5
2 [:} 5
1 5
30 4
29 4

2020

2020

2020

2020

2020

cases dea™

134

164

222

122

124

16. If you need several similar branches of transforms you can create one branch and

duplicate it.

17. If you have 2 or more monitors connected to your computer try View>Two Screen
Mode to show the Right pane on your second monitor.

18. Use batch processing with wildcards (e.g. *.csv) to process a folder full of input files in

one operation.

19. Use command line arguments to run .transform files from a batch or script file.

20. Use file name variables to set the name of an output file based on the name of an input

file, date created etc.
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s |

/

guest-list.xlsx

@ [wedding_sa... 0{t_IJ'-IE‘.S’l:Iist}_c;_,,

9 cols x 68 rows 9 cols x 68 rows
{guestlist} output.csv (f} = E;
@ Output to file.
Output to:  Single file v
File: C:\Users\andy\Desktoph\{guestlist}| output.csv

21. Use column variables when you want to use values from columns in transforms such as |f
and Filter.

. KA
Filter = Cf = N
@ Filter rows by text, date or numeric values in selected col...

@ ® E_'.{%) @r% X Keep ¥~ Matching any

Column Op. Value
1 Transaction ¥ > ¥ §(Threshold)

22. Learn keyboard shortcuts. For example, you can quickly change selection in the Center
pane using arrow keys with the Ctr1 key.
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Left Arrow Up Arrow

Remove Cols Dedupe

_..v.‘

4 —
Right Arrow

4 ols x 14.7k rows 4 ls x 209 rows

Pivot L/ Sort

2 ls x 210 rows 2 @ls x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

23. Change focus between the Center and Right panes using A1t+Left and A1t+Right.

24. Check the gray Left pane buttons when not available checkbox in the General tab of
the Preferences window for Left pane buttons to be disabled until the appropriate items in
the Center pane are selected.

25. Double-click on an item in the Center pane to show it fullscreen.
26. Check watch file in the Right pane for an input file if you want to trigger processing
(Run>Auto Run checked) or set it to 'Needs update' (Run>Auto Run unchecked)

whenever it changes.

27. Check View>Show Row/Col Changes to show changes in the number of rows and
columns in the Center pane.
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no change to

row(s) column(s) column(s) rows or
added added removed columns
g New Rows g Calculate 7 g Count < o Case
12 cols x 1.8k rows 13 ools x 1.8k rows 2 cols x 89 ows 2 cols x 89 rows
row(s)
removed

28. Deploy Easy Data Transform as a portable application so you can run it from a USB key
or install it on computers where you have limited access rights.

29. Change the Center pane color scheme in the Colors tab of the Preferences window.

30. Experiment with changing Optimize processing for from Minimum memory use to
Maximum speed to see if that improves performance. It may be slower or it may use up all
your memory.

31. Select View>Toggle Ul Theme to swap between light and dark user interface themes.
& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - m] 'Y

Oe

Input

Transforr

Date Format  {

Easy Data Transform © 2023 Oryx Digital Ltd



Expert tips

32. Select File>New Window to open a new Main window.
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5 Support
5.1 Forum

There is a discussion forum online at forum.easydatatransform.com. You can use this to ask
questions, share what you are doing and keep up to date with news.

5.2 Contact support

If you have any questions or suggestions, please post a question on
forum.easydatatransform.com or email us at support@easydatatransform.com.

5.3 Report a bug

Please report any bugs you find to support@easydatatransform.com Please include:

e your operating system (e.g. Windows 11)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e your .transform file and input data files (where appropriate)

e a screen capture or video can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.

We treat all data sent to us as confidential, unless you tell us otherwise. If your data is
particularly sensitive, it might be enough to send us just the first few rows with sensitive
values changed. Keep the same column structure though.

5.4 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please post a feature suggestion on our forum.easydatatransform.com or email
us at support@easydatatransform.com.

Easy Data Transform © 2023 Oryx Digital Ltd


https://forum.easydatatransform.com/
https://forum.easydatatransform.com/
mailto:support@easydatatransform.com
mailto:support@easydatatransform.com
https://forum.easydatatransform.com/
mailto:support@easydatatransform.com

.transform file 285

-A-

abs 29

add 29
aggregate 225
and 29,93

Automatic and manual processing. 260

-B-

base (numeric) 132
base64 decode/encode 69
batch processing 278
binary 132

boolean 269

-C-

calculate 29
case 37

Center pane 23
chop 40
classify 42
cleaning data 298
clone 42
cluster 42
column variables 273
command line arguments 280
comments 262
comparecols 46
concatcols 49
concatrows 51
connections 265
copy 303

copy cols 57
count 59

cross 61
crosstab 200
CSV format 239

-D-

dark mode 290

date format 62
dates 267

day of week/month/year
decode 69

dedupe 71

divide 29

drilldown 276
duplicate 303

-E-

Excel format 242
expert tips 348
extensions 25
extract 74

-F-

file extensions 25

file formats 239

file splitter 338
filename variables 282
fill 80

filter 82

Fixed width format 243
forum 360

fuzzy matching 275

-G -

gather 86
group by 86

-H-

hashing 88

header 91, 264
hexadecimal 132
HTML 249

HTML escape/unescape

29

69

Easy Data Transform © 2023 Oryx Digital Ltd



if 93

impute 97
input 26

insert 102
interpolate 104

intersect

107

Introduction 8

-] -

Javascript 108
join 112

JSON format 246
-L-

Left pane 23
locale 269

Log pane 23
logarithm 29
long pivot 86
lookup 116

-M -

Main window 22

Markdown format
meta information
month 29
moving 119
moving average

multiply

-N -

new col

new rows
ngram 1
num base

29

123
125

28
136

num format 136

numbers

268

251
270

119

-0 -

octal 132
offset 140
or 29,93
outliers 141
output 233

-P-

pad 146

paste 303

percent 301
percentile 208
pivot 148

pivot longer 86

pivot wider 200
Plain text format 252
portability 286
power 29
preferences 23
Preferences window 23
processing 260
profiling data 324
profiling time 260

-Q-

Quick start guide 8

-R -

rank 189

regular expressions 274
remove cols 151
rename cols 153
reorder cols 154
replace 156

Right pane 23
rolling average 119
row num 165

run processing 260
running average 119
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-S-

sample 167

scale 169
scheduling 280, 331
scrape web data 332
scripting 108
sequence 177
slice 184

slide 186

sort 189

splitcol 193

split file 338
splitrows 197
spread 200

stack 202

stamp 204
standard deviation 208
stats 208
substitute 211
subtract 29,212
summary 214
system requirements 8

-T-

text 267
time format 62
total 218
transpose 221
TSV format 252

-U-

unfill 223

unique 225

units 227

Unix timestamp 29
unpivot 86

URL encode/decode 69
USB key use 286

-V -

vCard format 254
vcf format 254

visualization

-W -

web scraping 332

whitespace
wide pivot

-X -

XML escape/unescape

XML format

Xor

29

Y-

YAML format

year

29

343

230, 337
200

255

259

69
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